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Preface to AcqKnowledge Software Guide 
Welcome 

Welcome to the AcqKnowledge Software Guide. The MP System (MP160, MP150 or MP36R) is a 

complete data acquisition system that includes both hardware and software for the acquisition and 

analysis of life science data. The MP System is used for data acquisition, analysis, storage, and retrieval. 

In addition to the MP Systems, AcqKnowledge also supports BIOPAC
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Where do I find help? 

The Introductory sections are intended to provide enough information to get up and running with the MP System, 

and become familiarized with some basic AcqKnowledge functions. For detailed in-depth information, the following 

resources are available. 

Ø Help menu 

The online Help menu includes basic information about standard AcqKnowledge functions and links to the 

tutorial, software guide and hardware guide for online searchable Help while running AcqKnowledge, plus 
links to the BIOPAC web site. 

You may also visit BIOPAC
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Human Anatomy & Physiology Society Position Statement on Animal Use 

(Adopted July 28, 1995, Modified January 2001, Approved April 29, 2012) 

It is the position of the Human Anatomy and Physiology Society (HAPS) that dissection and the manipulation of 

animal tissues and organs are important elements in scientific investigation that introduce students to the excitement 

and challenge of their future careers. HAPS supports the use of biological specimens as part of a program of study, 
provided their use is in strict compliance with federal legislation and the guidelines of the National Institutes of 

Health and the United States Department of Agriculture, and that such use fulfills clearly defined educational 

objectives. 

The mission of the Human Anatomy and Physiology Society (HAPS) is to promote excellence in the teaching of 
anatomy and physiology.  A fundamental tenet of science is the ordered process of inquiry requiring careful and 

thoughtful observation by the investigator. As subdivisions of biology, both anatomy and physiology share a long 

history of careful and detailed examination, exploration and critical inquiry into the structure and function of the 

human and animal body.  

Consistent with the origins and nature of scientific inquiry, HAPS endorses the use of animals as part of the 

laboratory experiences in both human anatomy and human physiology. 

Historically, an important tool of investigation in human and animal anatomy has been dissection. A complete 

anatomy learning experience that includes dissection goes beyond naming structures and leads the student to 

conclusions and insights about the nature and relatedness of living organisms that are not otherwise possible. To 
succeed in their future careers, students must become thoroughly familiar with anatomical structures, their design 

features and their relationships to one another. Dissection is based on observational and kinesthetic learning that 

instills a recognition and appreciation for the three-dimensional structure of the animal body, the interconnections 
between organs and organ systems, and the uniqueness of biological material. Dissection conveys the inherent 

variability of living organisms not otherwise observable in simulations and models. Physiology experiments 

involving humans and live animals provide an excellent opportunity to learn the basic elements specific to scientific 

investigation and experimentation. It is here that students pose questions, propose hypotheses, develop technical 

skills, collect data, analyze results and develop and improve critical thinking and problem solving skills 

Since effective teaching requires a diversity of strategies and approaches, HAPS endorses the use of computer atlases 

and simulations, modeling, and video programs to meet educational objectives and the needs of students. Science 

educators choosing not to use animals or biological specimens should choose alternatives that are able to convey 

equivalent anatomical and physiological intricacies to meet their educational objectives. 

Science educators have in common a respect and reverence for the natural world and therefore have a responsibility 

to share this with their students. They must communicate the importance of a serious approach to the study of 

anatomy and physiology. HAPS also encourages educators to be responsive to student concerns regarding use of 

animals and to provide students who object to animal use with alternative learning materials. 

HAPS contends that science educators should retain responsibility for making decisions regarding the educational 
uses of animals and other strategies and techniques for the betterment of their student
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MP36R support 

The MP36R is a four-channel data acquisition unit designed to work with AcqKnowledge 4.1 and above for the 
research market. AcqKnowledge support for the MP36R unit includes:  

§ Standard data acquisition and data acquisition features (triggering, multiple channels, variable sampling rate, 
input values)  

§ Output control functionality for controlling stimulators, digital channel, and channel redirection to output.  

§ Standard analog presets for all SS series transducers 

§ Electrode Check support  

§ Multiple-MP device support. Similar to multiple MP160/150 support, each graph may acquire from a 

maximum of one unique MP device.  

§ Control channel support for changing digital output lines based on calculation channel analysis  

 

MP36R Notes  The computer sleep mode should be disabled
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 MP System with AcqKnowledge Features 

The MP System (MP160, MP150 or MP36R) with AcqKnowledge software is a complete system for acquiring 

almost any form of continuous physiological data, whether digital or analog. The MP System can perform a range of 

recording tasks, from high-speed to long duration acquisitions. For physiological applications, the MP System is 
limited only by the computer speed and available memory or disk space. Features of the MP System include: 

Easy to use The MP System with AcqKnowledge offers power and convenience. In terms of hardware setup 
the MP System (MP160, MP150 or MP36R) uses simple plug-in connectors and standard 
interface cables. 

Flexible AcqKnowledge can be configured for a wide variety of applications, from single channel 
applications to multiple-device measurements (up to 16 analog and 16 digital, or multiple 
MP160s or MP150s). Control the length of acquisition, the rate at which data is collected, how 
data is stored, and more. Whether measuring alpha waves or collecting zoological data, the MP 
System with AcqKnowledge can meet your needs. 

Menu flexibility Easily customize menu displays to show only necessary functions, thereby reducing the risk of 
error or confusion in the lab. This is useful for teaching applications, giving instructors the 
option to hide unnecessary menu items. See Appendix D
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Application Features 

Use your MP System with AcqKnowledge software for a wide array of applications, such as:  

 
Active Electrodes 

Allergies 
Amplitude Histogram 

Anaerobic Threshold 

Animal studies 

Auditory Evoked Response 

(AER) 

Automate Acquisition Protocols 

Automated Data Analysis 

Automatic Data Reduction 

Autonomic Nervous System 

Studies 

Biomechanics Measurements 
Blood Flow / Blood Pressure 

/Blood Volume 

Body Composition Analysis 

Breath-By-Breath Respiratory 

Gas Analysis 

Cardiac Output 

Cardiology Research 

Cell Transport 

Cerebral Blood Flow 

Chaos Plots 

Common Interface Connections 

Connect to MP System (MP160, 
MP150 or MP36R)s 

Control Pumps and Valves 

Cross- and Auto-correlation 

Current Clamping 

Defibrillation & Electrocautery 

Dividing EEG into Specific 

Epochs 

ECG Analysis 

ECG Recordings, 12-Lead 

ECG Recordings, 6-Lead 

EEG Spectral Analysis 
Einthoven



 

 

Application Notes 

BIOPAC has prepared a wide variety of application notes as a useful source of information concerning certain 
operations and procedures. The notes are static pages that provide detailed technical information about either 

a product or application. A partial list of Application Notes follows. You can view or print application notes 

directly from the Support section of the BIOPAC website Hwww.biopac.com/application-note/ H. 

APP NOTE Application 

#AH101  Transducer Calibration and Signal Re-Scaling 
#AH102  Biopotential Amplifier Testing w/ CBLCAL 
#AH103  Remote Monitoring System (TEL100C) 
#AS105 Auditory Brainstem Response (ABR) Testing 
#AS105b/c ABR Testing for Jewett Sequence 
#AS108 Data Reduction of Large Files 
#AS109 3-, 6-, and 12-Lead ECG 
#AH110  Amplifier Baseline (Offset) Adjustment 
#AS111 Nerve Conduction Velocity 
#AH114  TSD107A* Pneumotach Transducer 
#AH114b  TSD107B* Pneumotach Transducer 
#AS115 Hemodynamic Measurements
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Chapter 2  AcqKnowledge Overview 
Overview 

 

AcqKnowledge software performs two basic functions: acquisition and analysis. The acquisition settings 
determine the basic nature of the data to be collected, such as the amount of time data will be collected for 

and at what rate data will be collected. All acquisition parameters can be found under the hardware (or MP) 

menu. The other menu commands pertain to analysis functions such as viewing, editing, and transforming 

data. 

Note:  Minor differences exist between the Windows and Mac OS  screen displays and keystroke/mouse 
functionality. These differences are noted throughout this section. 

Menu Functionality See Page 

File New, Open, Open Recent, Open for Playback, SMI BeGaze Import, Close, Save, 
Save As, Save Selection As, Save Journal Text As, Send Email as Attachment, Page 
Setup, Print, Quit 

245 

Edit Undo, Cut, Copy, Paste, Clear/Clear All, Remove Last Appended Segment, Insert 
Waveform, Duplicate Waveform, Select All, Remove Waveform, Create Data 
Snapshot, Merge Graphs, Clipboard (Copy Measurement, Copy Wave Data, Copy 
Graph, Copy Acquisition Settings, Copy Data Modification History for All Channels, 
Copy Data Modification History for Graph, Copy Focus Area Summary, Copy Event 
Summary), Journal (Paste Measurements, Paste Wave Data, Paste Acquisition 
Settings, Paste Modification History for All Channels, Paste Modification History for 
Selected Channel, Paste Focus Area Summary, Paste Event Summary, Manage 
PDFs, Show Journal) 

269 

Transform operations that primarily modify the data in the graph 

Recently Used, Digital Filters, Fourier Linear Combiners, Math Functions, Template 
Functions, Integral, Derivative, Integrate, Smoothing, Difference, Resample 
Waveform, Resample Graph, Expression, Delay, Rescale, Waveform Math, Slew Rate 
Limiter 

279 

Analysis operations that derive data & measurements from the graph 

Recently Used, Histogram, Autoregressive Modeling, Nonlinear Modeling, Power 
Spectral Density, Autoregressive Time-Frequency Analysis, FFT/IFFT, DWT Discrete 
Wavelets, Principal Component Analysis/Inverse PCA, Independent Component 
Analysis/Inverse, Find Cycle, Find Rate
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Ø To use AcqKnowledge without a data acquisition unit (depending on the dialog), choose Cancel, 

Analyze Only, No Hardware, or set Preferences > Hardware > General to 
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Basic Analog Channel Information 

  
By default, all channels are deselected on new graph windows. Usually, you will want to check all three boxes 

(Acquire, Plot, and Value) for each channel selected to acquire data. 

Acquire When the Acquire box is checked for a given channel, data will be collected on that channel. 

Plot Determines if data will be plotted in real-time during the acquisition. If the plot box is unchecked, 
data will be recorded, but the associated channel will remain hidden.  

Value Enables a separate Show Input Values window to display the values for each channel in real time, 

numerically and/or graphically.  

Channel This is a dynamic alpha-numeric heading based on the type of channel selected: Analog (or 

continuous), Calculation, or Digital. In the sample above, 
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Starting an Acquisition 

Once the channels and channel characteristics have been specified, the next step is to start the acquisition. If a 

file window is not already open, choose File > New > Graph window. 

Status light 

To the left of the Start button is a circular status light. The status light indicates the communication link 

between the computer and the data acquisition hardware unit. 

§ If the data acquisition hardware unit is properly connected to the computer and is turned on, the circle will 

be solid and green. 

§ If the data acquisition unit is not properly connected or not communicating with the computer, the circle 

will be solid and gray.  

§ Start 

To start an acquisition, position the cursor over the  button and click the mouse button, or select 
Ctrl+ Spacebar. If electrodes or transducers are connected to the data acquisition unit, a small value of 

random signal 
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 X/Y mode continued 

Plotted channels 

• To change the channel being plotted: Click the Channel label once and hold. 

 
X-axis, click above the waveform; Y-axis, click left of the waveform. 

• To flip the axes: Click the button in the upper left. 

 

• To change the channel label for this plot: Click the Channel label. 

 

Toolbar icons 

The center cluster of toolbar items is specific to X/Y mode. The left two buttons in this group are shortcuts 

for the Autoscale vertical and Autoscale horizontal functions. Adjacent to these buttons are two buttons that 

perform the center vertical and center horizontal functions.  

Tools 

Cursor: In X/Y mode, the I-beam tool in the lower right hand corner of the graph window changes into a 

crosshair. When the crosshair is moved into the graph window, the coordinates of the crosshair are displayed 

in the upper left corner of the graph window. The X value refers to the crosshair coordinate in terms of the 
horizontal axis, and the Y value describes the location of the cursor in terms of the vertical scale. By pressing 

the mouse, a crosshair is drawn over the closest data point and the measurement toolbar 
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The selected segment is used for all enabled software functions. This means that autoscaling can easily create 

what looks like a mess if the selected segment is not appropriate for scaling the largest segment. In compound 
action potential graphs in Stacked Plot, the last segment slice will most often be the largest, so if you select 

the last segment before autoscaling you will likely get the expected result. The Transform menu is disabled in 

Stacked Plot mode. 

A commonly used data visualization technique for examining the evolution of waveform morphology is the 

2D waterfall plot or 
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If the table of available slices was being displayed prior to the removal/editing of the last matching slicing 

event, the table will be emptied and the 



Part A 



42 AcqKnowledge 5 Software Guide 

Visit the online support center at www.biopac.com 

Analysis 

For purposes of illustration, you should open an existing file that contains actual data. Sample files were installed 

with the software. Select File > Open and choose a file from the list in the dialog. Sample data files can also be 

selected from the Startup screen by choosing the 
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AcqKnowledge also allows customization of the vertical scaling, or amplitude, of each waveform. Clicking the 

vertical scale area produces a dialog (see page X72 X for details). 

 The vertical scale dialog allows you to change the range of amplitude 

values displayed (scale) and set the value that appears in the center of 

the vertical scale (midpoint).  

You can vary the midpoint and apparent magnitude of each waveform 

by changing the values in each box. By changing the value in the scale 
box, a smaller value has the effect of increasing the apparent amplitude. 

Entering a number about half the current value will cause the amplitude 

of the wave to appear to double. 

• Scale
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Zoom 

Another way to examine data is to use the 
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Events (Markers) 

 

In many instances it is useful to have the software mark an occurrence 
or event during an acquisition so it can be referenced later. For 

instance, you may want to note when a treatment began or when an 

external event occurred so you can examine any possible reaction. 

The software uses 
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Journals 

The Journal is a general-purpose text editor built into AcqKnowledge that works like an 
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Print 

AcqKnowledge allows high-resolution printing of 

hard-copy graph plots much as they appear on-

screen. 

• To print a file, choose Print from the File menu. 

This will print the contents of the screen on the 

selected printer. 

• To print the entire file, choose Autoscale 

Horizontal from the Display menu first.  

• You must print a journal as a separate command 

from print graph file. 

You may instruct AcqKnowledge to print the 

contents of a file across several pages by entering a 

value in the Fit to box. Entering 
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 Toolbars 

Many of the most commonly used features in AcqKnowledge can easily be 
executed with a mouse click. The toolbars contain shortcuts for some of the 

most frequently used AcqKnowledge commands. Click an icon to activate it; 

icons are grayed out when they are not applicable. 

By default, a minimal toolbar configuration is presented when AcqKnowledge 

is first launched. The default toobars will appear as follows: 

 

The default toolbars consist of: 

• Start/Stop button 

• Cursor Toolbar (Arrow, I-beam and Zoom tools) 

• Main Toolbar (Grid, Toolbar Display, Preferences and Customize Toolbar buttons) 

The full range of available toolbars can be displayed by enabling the checkbox options in the Toolbar Display 

shortcut button , or via Display > Show and enabling the desired options. Once the toolbar options have 

been selected, this will be the default toolbar display for all new graphs. All toolbars can be deselected and 

hidden with the exception of the Start/Stop button and the Cursor Toolbar (Arrow, I-beam and Zoom tools). 

Saved graphs created with different toolbar configurations will open with those toolbar options displayed.  

Toolbar position
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Cursor Tools 

The cursor tools are also accessible via the Display menu (Display > Cursor Style) 

 

This is a general-purpose
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Text 
Annotation 

 
continued 

 

 

 

 

 

 

Connector handles 

 

Add a range 

 

Resize a range 

 

Move a connector 

  

Text annotations are short pieces of text that float above channel data and can be used to 

draw visual attention to particular areas of interest in a graph. These text annotations can be 

simple outlined text, can have a connector from the outline boundary to a specific sample 
point on the waveform, or have a range indicator of a specific width. Each text annotation is 

tied to a sample of data in a channel; when the data is moved by coping, pasting, or other 

waveform editing operations, text annotations remain fixed to their corresponding sample 

positions, similar to channel events. 

Although text annotations are tied to horizontal locations like events/markers, they are 
displayed in a relative fashion. The relative pixel distance between the text annotation outline 

boundary and the sample of data remains the same under zoom and autoscaling operations. 

• For example, an annotation that is 20 pixels above a T-Wave peak position will 

continue to be drawn 20 pixels above regardless of zoom. This allows for flexible 

data viewing while maintaining text annotation visibility. 

Text annotation controls 

With the tool active, click in the graph to define a new annotation. 

Select Click an annotation once to select it. 
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Channel Button Toolbar 

Toggles the display of channel number and label region.  

  

Event Toolbar 

 

Select an event to enable the toolbar. (Events and Event bar must first 
be enabled via Display > Show Events and Event bar). Use the arrows 

to move forward or backward through all event marker types. (If 

events are placed in the waveform, the arrow navigation will locate 
events in the selected channel only.) 

Click the event palette icon to generate the event palette.  

Focus Area Toolbar 

 
Use the Focus Area feature to isolate portions of data that are of 

particular interest within a graph. Focus Areas can be defined, added, 

labeled and deleted within any portion of the graph. For more details 

on creating and using Focus Areas, see page 87. 

Measurements Toolbar 

     

Click the down arrow for quick access to measurement preset 
functions, including pre-loaded options for organizing 
measurement rows and columns. Or create and save custom 

measurement display presets by choosing New Preset, entering a 

name for the preset and clicking OK. 

Right-click in the measurement bar for quick access to options for 

copying measurement and using linear interpolation.  

Custom Toolbars for Transformations and Analysis 
AcqKnowledge 4.1 and above allows users to construct new 

toolbars for triggering transformations and analysis. An arbitrary 

number of toolbars may be created and populated with buttons 
that can trigger any menu item in the Transform and Analysis 

menus. The contents of the text-only buttons match the menu 

item title. These toolbars will persist for each user and their 
positions and visibility within the graph window will be retained. 

 Transformation toolbars may be accessed via the 

"Customize Toolbars" button. 
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Button Transparency 

Scaling, calibration, transformation history, and grid lock buttons may be made semi-transparent to allow 
units, axis values, and other information underneath the buttons to remain visible. The Preferences > Graph 

panel includes an 
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Menu Option Windows OS Mac OS  

Integrate   

Smoothing   

Difference   

Resample Waveform   

Resample Graph   

Expression   

Delay   

Rescale   

Waveform Math   

Slew Rate Limiter   

Analysis menu   

Find Cycle Ctrl + F  F 

Find Next Cycle Ctrl + E  E 

Find All Cycles Ctrl + R  R 

Display menu   

  Tile Waveforms   

Autoscale Single Waveform Ctrl + Shift + Y  Shift  Y 

  Autoscale Waveforms Ctrl + Y  Y 

  Overlap Waveforms   

  Autoscale Horizontal Ctrl + H  H 

Show All Data Ctrl + Shift + D Shift  D 

Show Default Scales   

Zoom Back Ctrl + - (minus key)  - 

Zoom Forward Ctrl + = (equal key)  + 

Reset Chart Display   

Reset Grid   

Adjust Grid Spacing   

Set Wave Positions   

Wave Color   

Horizontal Axis   

Show > Selection Palette 

 > Location Palette 

Ctrl + Shift + = 

Ctrl + Shift + L 

 + Shift + = 

 + Shift + L 

Customize Toolbars   

Channel Info   

Preferences   

Size Window   

Cursor Style > Arrow 

             > Selection 

            > Zoom 

Ctrl + B 

Ctrl + I 

Ctrl + G 

 B 

 I 

 G 

Create Data View   



Part A 



66 AcqKnowledge 5 Software Guide 

Visit the online support center at www.biopac.com 

Menu Option Windows OS Mac OS  

Open Hardware Guide 

About AcqKnowledge 

Cursors 

I-beam 

Arrow (pointer) 

Zoom 

Grid 

Event 

Jump to  

Annotation 

 

Ctrl + I 

Ctrl + B 

Ctrl + G 

 

 I 

 B 

 G 

Horizontal Scroll Location 

 

 

In chart, scope, or stacked plot mode (i.e., all but X/Y) 
these keyboard shortcuts can be used to scroll to various 

parts of the graph. 

Home 

 

Jumps to t = 0 (i.e., places first sample of data flush with 

left of graph window) 

End 

 

Jumps to the end of the currently selected waveform (i.e., 
places last sample of data of the selected waveform flush 

with right of graph window) 

Page Up 

 

Scrolls backward in time one full screen (i.e., places 
leftmost sample of previous visible area at the right of the 

new visible area). 

Page Down Scrolls forward in time one full screen (i.e., places 
rightmost sample of previous visible area at the left of the 

new visible area). 

Tooltips 

Tooltips is an online assistance feature to help novice users learn how to use AcqKnowledge. Text is 
generated to describe the software functionality of the item under the mouse. Unavailable items/controls will 

indicate why they are unavailable. Tooltip visibility can be controlled by selecting or deselecting the 
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Cancelling Transformations and Transformation Progress Bar 
Transformation cancel support offers Cancel buttons for in-progress dialogs that indicate the completion 
status of threaded transformations. Progress dialogs have also been enhanced so the textual message 

includes a graphical progress bar with the percentage that is completed. If the progress message does not 

contain a percentage, an indeterminate progress bar will be displayed.  

AcqKnowledge 4.1 and higher extends the analysis package to display dialogs while analysis routines are 
in progress. This progress dialog contains a cancel button which may be used to terminate the analysis 

before it is complete.  

The event tool allows events to be inserted on a graph with the mouse. When performing event editing, 
three new context menu shortcuts have been added to help make the process quicker:  

  
§ Assign Current Event Type: Right-click an area with no data to set the type of event that will be 

inserted on the next left-click of the mouse. 

§ Event Palette: Toggles event palette displays. 

§ Edit event: Right-click a specific event to open the event palette to Selected Event controls for the 
event that was right-clicked. 

Typed Event Label Drawing Improvements 
The Event system has been enhanced to allow different drawing options 
for channel-specific events when they are drawn in the data plotting area. 

These drawing options are applied to event labels, event amplitude 

markings, and event time location text. The following drawing options 

may be customized:  
 

§ Font (including family, size, italic/bold, and other options)  

§ Rotation angle of text baseline  

§ Text alignment (left, center, right)  

Choose MP160 and MP150 Help Button 
A Help button is available in the 
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Chapter 4  Editing and Analysis Features 
Overview 

This section provides a brief overview of some of the most frequently used AcqKnowledge features and 

functions. For more detailed information about specific features, turn to Chapters 9 through 13.  

If you are not currently running AcqKnowledge, double click the AcqKnowledge icon to start it. Choose Open 

from the File menu and select the file called 
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Vertical (Amplitude) axis 

   

Clicking the mouse in the vertical scale area (where the amplitude of each channel is displayed) generates 

the Set Screen Vertical Axis dialog, where values can be entered for units per division and vertical scale 

offset. 

Scale  

Determines the limits of the viewable vertical axis scale (usually Volts). AcqKnowledge divides each 

channel into four vertical divisions. When data is displayed in chart mode, each 
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Textual value display in spot measurement mode 

Textual value display can be customized for font, color and style, and positioned at the top or bottom 

of any selected channel. These options can be configured independently per channel or applied to all 

channels. 

• In chart and stacked chart modes, the value display will appear for all enabled channels. 

• In scope mode, the value display will appear only if the selected channel has the value display option 

enabled. 

• Textual value display is not supported in XY mode. 

To enable textual value display: 

Click on the vertical axis area to open the setup dialog and enable the 
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Grid Scaling 

When the grid is locked, the scaling factors controlling how much data is visible on the screen (the distance 

between consecutive major lines of the grid and a fixed location for one of the lines of the grid) are specified 

differently. When the grid is unlocked, these scaling factors do not affect the grid. 

 The Grid Spacing option specifies the scaling factors and whether or not to 
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§ Based on lock status, the dialog will allow you to adjust Horizontal, Vertical or combined settings. 

§ The values displayed in the dialog correspond to the grid ranges that were just drawn out on the screen 

with the grid tool if a mouse drag occurred. 

§ If the mouse was simply clicked, the current grid settings are displayed. 

§ This dialog allows the grid drawn out with the grid tool to be made more precise. 

Grid Reset 

To return to the original grid, choose 
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Journal Details 

To create a journal, choose File > New > Graph-Specific Journal or Independent Journal or choose 

Display > Show >Journal or Edit > Journal > Show Journal.  

Once a Journal is open, text and data can be entered. To enter text, just begin typing when the journal is open. 

AcqKnowledge will automatically 
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Bulleting  Toggles text bulleting on and off 

 
Increase indent Increases indent in a bulleted or numbered list* 

 
Decrease indent  Decreases indent in a bulleted or numbered list 

 
Insert link Adds hyperlink to Journal 

 
Table Inserts a table into the Journal 

 
Table row  Adds a row to the table ** 

 
Table column  Adds a column to the table  

 
Delete table row  Removes selected row from the table 

 

Delete table 
column  

Removes selected column from the table 

 
Merge cells  Merges selected cells within the table 

 
Split cells  Splits selected cells within the table 

*Active only when cursor is positioned within a bulleted or numbered list. 

**Additional table tools are active only when a table is present. 

NOTE: If the AcqKnowledge graph or Journal windows are decreased in size, the Journal toolbar will 

become truncated and some buttons may no longer be in view. Buttons no longer visible on the toolbar can be 

found in drop-down menus indicated by arrows. (See below) 

 

Journal Numerical Table Tools 

The Numerical Table Tools function allows easy insertion of measurements and numerical data into a Journal 

table, which can then be computed and evaluated via basic mathematical operations and expressions. This 
eliminates the need to export data to a spreadsheet application in order to validate statistics gathered during 

the course of an experiment.  

Numerical Tools operations permitted within a Journal table: 

§ Insert a single measurement value 
§ Insert all measurement values 

§ Insert all measurement values with header row 

§ Sum, Mean and Standard Deviation statistics for table rows and columns 
§ Expression evaluation 
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Example of Evaluate Expression 

This feature works very much like Excel
®. 

Simply enter the cell identifiers into an empty cell, then right-click 

and choose 
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Select a waveform / channel 

Although multiple waveforms can be displayed, only 
one waveform at a time is considered 
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The new focus area and label will appear in the graph. 

 

Multiple and overlapping focus areas can be created by selecting additional data and using the 
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Measurement Area 

It is important to remember that AcqKnowledge is always selecting either a single point or an area spanning 

multiple sample points. If an area is defined and a single point measurement (such as Time) is selected, the 

measurement will reflect the last selected point. 

 

§ Single-point measurements 

When a single point is selected, the cursor will 
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Measurements and Measurement Presets  

Measurements are commonly used in conjunction with the cycle detector and other analysis protocols to 

perform data reduction. In complex data analysis using the cycle detector, often multiple different sets of 

measurements may be used to perform multiple extraction passes on the data. The measurement presets 
feature allows users to create multiple predefined measurement configurations and apply them to the graph to 

change between different configurations. All aspects of the measurement configuration are stored, including 

measurement functions, any parameters for the measurement, source channel, and number of measurement 
rows. For more details on this function, see MeasurementsToobar section on page 60. 

Measurement Validation 

You can validate measurements with the ValidateMeasurements.acq sample file included with the software. 

Pay attention to the 
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Measurement Area Explanation  
 
 
 

 
Results: This calculation will always return a positive result. 
Units: Volts - sec. 
Sample data file: “ValidateMeasurements.ACQ” 
 Result: 0.4533 Volts - sec. 

BPM 
(Time domain 
only) 

Minimum area: 
2 samples 
 
Uses: 
Endpoints of 
selected area 

BPM (beats per minute) computes the time difference between the first and last 
points and extrapolates BPM by computing the reciprocal of this difference, 
getting the absolute value of it and multiplying by 60 (60 sec). 
The formula for calculation of BPM is: 

60
1

1

∗










−
=

xx
BPM

n

 

Where:  

nxx ,1 - values of the horizontal axis at the endpoints of selected area. 

Note: As mentioned, this measurement provides essentially the same information 
as the Delta T and Freq measurement. 
Results: Only a positive value. 
Units: BPM. 

Calculate Minimum area: 
2 sources 
 
Uses: 
Results of 
measurements 
used in 
calculation 

Calculate can be used to perform a calculation using the other measurement 
results. For example, you can divide the mean pressure by the mean flow. 
When Calculate is selected, the channel selection box disappears. 

 
The result box will read 
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Measurement Area Explanation  

( )1xf , ( )nxf —values of a curve at the endpoints of selected area. 

 
 
Results: 
If the data value at the starting location is greater than the data value at the 
ending location of the cursor, then a negative delta will result. Otherwise, a 
positive delta will result. 
Units: Volts 
Sample data file: “ValidateMeasurements.ACQ” 
 Result: -2 Volts (for whole wave). This result shows the 

absolute value of change of amplitude (2) and the minus 
sign means a decrease of amplitude. 

Delta S  Minimum area: 
1 sample 
 
Uses: 
Endpoints of 
selected area 

Delta S returns the difference in sample points between the end and beginning of 
the selected area. 
Results: This calculation will always return a positive result. 
Units: Samples 
 

Delta T(time) 
Delta F 
(frequency) 
Delta X (arbitrary 
unit) 

Minimum area: 
2 samples 
 
Uses: 
Endpoints of 
selected area 

The Delta T/F/X measurement shows the relative distance in horizontal units 
between the endpoints of the selected area. Only one of these three units will be 
displayed in the pop-up menu at a given time, as determined by the horizontal 
scale settings. 

Measurement Horizontal Axis 
Delta T Time 
Delta F Frequency (FFT) 
Delta X Arbitrary units (Histogram Bins) 

The formula for Delta T/F/X is: 

Delta T 1xx n −=  

Where: 

nxx ,1 - values of horizontal axis at the endpoints of selected area. 

Results: 
If the data value at the starting location is greater than the data value at the 
ending location of the cursor, then a negative delta will result. Otherwise, a 
positive delta will result. 

For Delta T measurements with the horizontal axis format set to HH:MM:SS. 

ü For values less than 60 seconds, you will get a value in decimal 
seconds. 

ü For values greater than 60 seconds, you will see an HH:MM:SS 
format value 

(See page X71X for details on how to change the horizontal scaling). 
Units:  

Delta T: Seconds (sec.)  Delta X: “arbitrary unit” 
Delta F: Hz 

Sample data file: “ValidateMeasurements.ACQ” 
 Result: 0.12 sec. (for whole wave). 
 

Evt_amp  Extracts the value of the measurement channel at the times where events are 
defined. The measurement result is unitless. Specify Type, Location, and Extract; 
see page X225X for details. 
§ The amplitude is always taken from the measurement channel, which may be 

different from the channel on which events are defined. 
Evt_amp can be useful for extracting information such as the average T wave 
height within the selected interval.  

Evt_count   Evaluates the number of events within the selected area. The measurement 
result is unitless. Specify Type and Location; see page X226X for details. 
 

Evt_loc   Extracts information about the times of events. The measurement result uses the 
units of the horizontal axis. Specify Type, Location, and Extract; see page X226X for 
details. 
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Measurement Area Explanation  
Note: It is important to note that this does not compute the frequency spectra of 
the data. To perform a spectra analysis, use the FFT function (described on page 
X315X). 
Freq (or frequency) is only available in time domain windows. 
Results: This calculation will always return a positive result. 
Units: Hz 
Sample data file: “ValidateMeasurements.ACQ” 
 Result: 8.33 Hz (for whole wave). 

Inf_Dim   Information Dimension; fractal dimension estimate. (See fractals note at 
Cap_Dim.)  

Integral Minimum area: 
2 samples 
 
Uses: 
All points of 
selected area 

Integral computes the integral value of the data samples between the endpoints 
of the selected area. This is essentially a running summation of the data. 
Integral is expressed in terms of (amplitude units multiplied by horizontal units) 
and calculated using the following formula. 

Integral = ( ) ( )[ ]
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Where: 
n—number of samples; 
i—index (i = 1.n-1); 

1, +ii xx  - values of two neighboring points at horizontal axis ( 1x – the first 

point, nx – the last point); 

( ) ( )1, +ii xfxf  - values of two neighboring points of a curve (vertical axis); 
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X
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- horizontal sample interval; 

1xxX n −=∆ - horizontal distance of increase at horizontal axis. 

The following plot graphically represents the Integral calculation. 

 
The area of the shaded portion is the result. 

Results: The Integral calculation can return a negative value if the selected area 
of the waveform extends below zero. 
Units: Volts—sec. 
Sample data file: “ValidateMeasurements.ACQ” 

Result: 0.300 Volts -sec.(for first 6 sample points) and –
0.155 Volts -sec.(for last 6 sample points—the wave below 
zero). 

Kurtosis   Kurtosis indicates the degree of peakedness in a distribution, e.g. the size of the 



Part A 



100 AcqKnowledge 5 Software Guide 

Visit the online support center at www.biopac.com 

Measurement Area Explanation  

( )ixf - values of points of a curve ( vertical axis).
 

Units: Volts 
Sample data file: “ValidateMeasurements.ACQ” 

Result: 1.538462 Volts (for whole wave). 

Median Minimum area: 
2 samples 
 
Uses: 
All points of 
selected area 

Median shows the median value from the selected area. 
Note: The median and calculation is processor-intensive and can take a long 
time, so you should only select this measurement option when you are actually 
ready to calculate. Until then, set the measurement to 
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Measurement Area Explanation  
-166.66667 Volts/sec. (for samples 4-7) and 
-16. 66667 Volts/sec. (for whole wave). 

 

Stddev Minimum area: 
2 samples 
 
Uses: 
All points of 
selected area 

Stddev computes the standard deviation value of the data samples between the 
endpoints of the selected area. Variance estimates can be calculated by squaring 
the standard deviation value. 
The formula used to compute standard deviation is: 

Stddev = ( )∑
=
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Where: 
n—number of samples;  
i—index (i = 1.n); 

ix
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Part B—Acquisition Functions: The Hardware Menu 

Overview 

AcqKnowledge software adds acquisition and control capability to the complete MP160/MP150/MP36R 

Systems and other BIOPAC data acquisition hardware, such as wireless BioHarness, Mobita, or BioNomadix. 
The MP (or Hardware) menu items will vary in appearance depending on the type of data acquisition hardware 

in communication with the software, and the Hardware menu title will reflect the currently connected hardware 

type. (It is also important to note that certain features in the MP160/150 and MP36R hardware menus are not 
supported in all hardware types.) For the purposes of this guide, all supported data acquisition systems will be 

referred to generically as being under the umbrella of the 



104 AcqKnowledge 5 Software Guide 

Visit the online support center at www.biopac.com 

Set Up Data Acquisition > Data Acquisition Settings 

In AcqKnowledge, many key setups are accessed by selecting Hardware menu > Set Up Data Acquisition. This 

option displays the Data Acquisition Settings window, comprised of the following items: 

• Channels 
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Chapter 5  Set Up Channels 

Set Up Channels—The Basics 

Before you collect data, you need to specify how many channels you will be collecting data on, and at what rate 

data is to be collected. Both of these functions are accomplished through menu items and dialogues. To enable 
collection on a given channel, select Set Up Data Acquisition > Channels from the hardware menu. 

AcqKnowledge for MP160 and MP150 offers two methods of analog channel setup: 

Module-based setup View by Channels see page 108 for details 

  

 

If using AcqKnowledge with BioHarness™ or B-Alert
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Using this information, the module setup automatically sets the scaling and initial visual range to match 

the physical input units from the module or transducer. 

“Apply data alignment corrections” option (AcqKnowledge 4.4.2 and higher) 

 

This checkbox option is found at the bottom of the Channels > Add New Module screen and is recommended 
when using the following hardware modules: 

• NIBP100D (via DA100C general purpose amplifier) : adds 50 msec delay. 

• NIBP100D-HD (via HLT100C high level transducer module): adds 50 msec delay 

• When combining BioNomadix wireless signals with wired signals: adds 12.5 msec delay 

Checking this box automatically adds appropriate delays, ensuring all data will be properly aligned when the 
above combination of hardware is used. This avoids the need to use calculation channels to manually align data 

when combining hardware types that apply varying amounts of fixed delay. 

NOTE: If NIBP100D is not being used, or if BioNomadix is being used only with other BioNomadix receivers, 

then checking this option is not necessary. (It is unchecked by default.) 

View by Channels 

Channel Type 

To specify the channel type
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 Calculation Presets 

When you select a Preset, the Setup dialog is updated with the corresponding information. 

§ The Setup dialog reads 
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The Input Volts and Map (Scale) Value boxes reflect the value of the incoming signal and how it will be plotted 

on the screen, respectively. Thus, an incoming signal of +1 Volts would be plotted as 95° F, whereas a signal of 
0 Volts would be plotted as 90° F. AcqKnowledge will perform linear extrapolation for signal levels falling 

outside this range (i.e., -2 Volts will be scaled to 80 ° F), as well as perform similar interpolation for values 

between this range. Enter these numbers in the scaling dialog, type in 
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Adjustable, user defined, digital IIR filters for MP36R 

The MP36R Unit allows up to three user-configurable, sequential, biquadratic (second order) Infinite Impulse 

Response (IIR) filters per MP unit channel. These filters are typically configured by choosing a Preset but can 

be changed manually via the Input Channel Parameters dialog (MP36R > Set Up Data Acquisiton > Channels > 
Setup button). Each of these three filters can be uniquely set up as a low pass, band pass, high pass or notch 

(band reject) filter. 

In the 
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Range + Grids Tab  Explanation 

Apply initial visual range The initial vertical axis range of plotted data will be set as indicated at acquisition start of the first 
data segment. 

Top Indicates the maximum vertical visual range in destination channel units.  
Bottom Indicates the minimum vertical visual range in destination channel units.  

Apply locked vertical 
grid 

Locked vertical grid settings are applied for the channel. For more details on grid setups, see 
Grid Details on page 75. 

First grid line Provides the fixed location of the origin of the vertical grid. 
Grid spacing Sets the spacing interval between major vertical grid divisions.  
Apply locked horizontal 
grid 

A channel-specific independent horizontal grid will be applied when the channel is added to a 
graph. 

First grid line Sets the origin location of the horizontal grids. 
Grid spacing Sets spacing between major horizontal grid lines based on the time domain. 
Apply grid appearance Enables options for setting grid color/appearance of major and minor grid lines. 
Major line color Allows customization of major grid line color. 
Minor line color Allows customization of minor grid line color. 

Show minor grid Shows/hides minor gridlines 
Vertical precision Indicates number of digits displayed on vertical axis. 
Num minor divisions Sets the number of minor grid divisions for the channel. 
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MP36R Transducer SSID Table 

Device Part #  Description SSID  ISID Name 

BSLCBL3A, BSLCBL4B  Recording cable 1  

BSLCBL5 3.5mm phone plug adapter 6  

BSLCBL8, BSLCBL9 High-impedance recording cable 1  

BSLCBL14A 3.5mm phone plug adapter to MP35 Input.   6  

BSLSTMB/A 10 V setting 18  

BSLSTMB/A 100 V setting 19  

BSL-TCI13 Piezo interface cable 1  

BSL-TCI21 pH probe interface 12  

SS1L, SS2L, SS2LA Electrode lead set 1  

SS2LB Electrode lead set N/A SS2LB 

SS3LA EDA (GSR) finger electrodes 2  

SS4LA Pulse Plethysmograph finger transducer 3  

SS5L, SS5LA, SS5LB Respiration Belt (for Chest) 4  

SS6L, SS7L, SS8L Temperature transducer  5  

SS9L, SS9LA BNC Adapter 6  

SS10L Pushbutton switch  7  

SS11LA Airflow transducer 8  

SS11LB Airflow Transducer N/A  

SS12LA Variable range force transducer 9  

SS13L Blood Pressure (Arterial) 10  

SS14L Displacement transducer 11  

SS17L Piezo microphone 14  

SS19L Blood Pressure  cuff (with Gauge) 10  

SS19LA Blood Pressure cuff N/A SS19LA 

SS19LB Blood Pressure Cuff N/A SS19LB 

SS20L, SS21L, SS22L, 
SS23L, SS24L 

Goniometer 16  

SS25L, SS25LA Hand Dynamometer 9  

SS25LB Hand Dynamometer N/A SS25LB 

SS26L, SS26LB, SS27L Accelerometer 17  

SS28L Heel Toe Strike assembly 9  

SS29L Multilead ECG cable 1  

SS30L Stethoscope, electronic 14  

SS31L Non-Invasive Cardiac Output Module 15  

SS32L Dissolved Oxygen probe 20  

SS33L GAS 
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Up to 16 Calculation channels can be acquired, and you may use the output of one Calculation channel as the 

input for another channel, as long as the output channel has a higher channel number than the input channel. In 
other words, it
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AcqUKnowledgeU QUICK STARTS  

Quick Start templates (.gtl graph template files) are installed to the Sample Data folder. Use Quick Start files to 

establish the settings required for a particular application or as a good starting point for customized applications. 
See Open As Graph Template on page X249 X for details.  

Q## Application(s) Feature 

1 EEG 

Sleep Studies 

Real-time EEG Filtering 

Real-time EEG Filtering 

2 EEG Evoked Responses 

3 EEG 

Evoked Response 

Event-related Potentials 

Event-related Potentials 

4 Evoked Response Nerve Conduction Studies 

5 Evoked Response Auditory Evoked response & Jewett Sequence 

6 Evoked Response Visual Evoked Response 

7 Evoked Response Somatosensory Evoked Response 

9 Evoked Response Extra-cellular Spike Recording 

10 Psychophysiology Autonomic Nervous System Studies 

12 Psychophysiology Sexual Arousal Studies 

13 EBI 

Cardiovasc. Hemodynamics 

Exercise Physiology 

Cardiac Output 

Noninvasive Cardiac Output Measurement 

Noninvasive Cardiac Output  

15 EOG Nystagmus Investigation 

16 EOG Saccadic Eye Movements 

17 Plethsymography Indirect Blood Pressure Recordings 

18A Plethsymography Arousal - Female 

18B Plethsymography Arousal - Male 

19 Sleep Studies Multiple-channel Sleep Recording 

20 Sleep Studies 

ECG 

Cardiovasc. Hemodynamics 

Online ECG Analysis 

Online ECG Analysis 

ECG Analysis 

21 Sleep Studies SpO2 Analysis 

22 ECG Einthoven
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Integrate Calculation 

     

The online Integrate Calculation offers three basic options: 

Reset via channel. Perform a real-time integration of input data over a variable number of sample points. 
This option is extremely useful for converting flow signals into volumetric equivalents. The integral of flow 

is volume. For example, when recording airflow with a pneumotach, volume can be precisely calculated as 

the flow varies in a cyclic fashion: 

a)  Real-time conversion of flow signals into volume signals (i.e., Blood flow à Blood volume; Air 

flow à Air volume) 

b)  Any processing involving a need for a cyclic, continuous integral calculated in real time. For 

example: Acceleration à Velocity; Velocity à Distance; Frequency à Number of cycles; Power 
à Energy 

Average over samples. Perform a moving average (mean) and associated processing (Rectify; Root mean 

square) over the specified number of sample points. This option is useful to process EMG signals to: 

a)  Smooth noisy data 

b)  Display the real-time 



Part B 



126 AcqKnowledge 5 Software Guide 

Visit the online support center at www.biopac.com 

§ Threshold crossing on the 
control channel 

For example: Calculation 

channel resetting on positive 

crossings of 0V on CH 1. 

 

 

§ Window expiry when mean 
removal is enabled 

For example: No threshold 
crossing within 
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Ø It is important to note that this rescaling should be performed independent of any rescaling performed 

on analog channels themselves. Even if an analog channel is being rescaled to some other units, the 
input values in the integration scaling should be set to +10 Volts (next to Cal 1) and 
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 Difference Calculation 

The Difference calculation returns the difference between two data samples over a specified number of intervals 
and divides the Difference by the time interval spanned by the data values. The Difference Calculation is useful 

for calculating an approximation of the derivative of a data set in real time. 

To have AcqKnowledge perform a Difference calculation in real time: 

1. Choose Hardware > Set Up Data Acquisition > Channels. 

2. Click the Calculation tab. 

3. Check an Acquire box for the Calculation channel you want to contain the modified data. You may also 

check the Plot and Values boxes as appropriate for each channel. 

4. Click the Preset pull-down menu and select Difference. 

5. Click the Setup button in the Input Channels dialog to generate the Difference dialog. 

(Off-line Difference is available under Transform > Difference.) 

The Difference Calculation dialog allows you to specify the source channel and the number of intervals 

between samples over which the difference is to be taken, and also includes the option of rescaling the channel 
to reflect different units. 

Click the Setup button in the Input Channels dialog to generate the Difference dialog:  

  
Source When the Source channel contains relatively high frequency data, the Difference Calculation 

may result in a very noisy response, so it
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To perform a Rate Calculation in real time: 

1. Choose Hardware > Set Up Data Acquisition > Channels. 

2. Click the Calculation tab. 

3. Check an Acquire box for the Calculation channel you want to contain the modified data. You may also 
check the Plot and Values boxes as appropriate for each channel. 

4. Click the Preset pull-down menu and select Rate. 

5. Click the Setup button in the Input Channels dialog to generate the Rate dialog. 

(Off-line Rate calculation is available under Analysis > Find Rate.) 

Source
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Math Calculation 

The Math Calculation performs standard arithmetic calculations using two waveforms or one waveform and a 

constant. Calculation channels with lower channel numbers may be also used as a waveform. 

1. Choose Hardware > Set Up Data Acquisition > Channels. 

2. Click the Calculation tab. 

3. Check an Acquire box for the Calculation channel you want to contain the modified data. You may also 
check the Plot and Values boxes as appropriate for each channel. 

4. Click the Preset pull-down menu and select Math. 

5. Click the Setup button in the Input Channels dialog to generate the Math dialog. 

(Off-line Math calculation is available under Transform > Waveform Math.) 

Use the pull-down Source menus to select the source channels (Source 1 and Source 2). 

The Sample rate line provides the sample rate for the channel selected as Source; the channel sample rate may 

be different than the acquisition sample rate. 

Use the pull-down Operation menu to select a function. In the example below, analog channel 1 (Source: A1) is 

added to analog channel 2 (Source: A2). To use this summed waveform as an input for another Math 

Calculation channel. One useful application would be to divide this waveform (C0) by K, where K=2, thus 
producing an arithmetic average of source channels A1 and A2. 

   

The 
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Filter IIR Calculation 

The Filter IIR Calculation channel allows you to perform real time digital filtering on analog, digital, or 

calculation channels. To have AcqKnowledge apply a digital Filter IIR Calculation in real time: 

1. Choose Hardware > Set Up Data Acquisition > Channels. 

2. Click the Calculation tab. 

3. Check an Acquire box for the Calculation channel you want to contain the filtered data. You may also 
check the Plot and Values boxes as appropriate for each channel. 

4. Click the Preset pull-down menu and select Filter. 

5. Click the Setup button in the Input Channels dialog to generate the Filter dialog. 

                      

Filter Setup & Output Options 

In the dialog above, the signal on analog channel one (A1) is run through a low-pass filter that attenuates data 

above 50 Hz. The 
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Expression 

 

The online Expression calculation channel is available for performing computations more complex than 

possible in the Math and Function calculations, and is additionally available as an offline transformation and a 
measurement. (Different attributes may apply to each available Expression type.) The Expression calculation 

will symbolically evaluate complex equations involving multiple channels and multiple operations. 

AcqKnowledge can perform conditional evaluation, data extraction, logical operations, expressions requiring a 

range of samples or the results of the previous expression, and evaluation of generic formulas that can be 
expressed in a closed, recursive form. 

Unlike the Math and Function calculations
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Recursive notation Since transformations and calculation channels replace the source data of the channel 

with the result of the expression evaluation in sequence, negative offsets are equivalent to 
returning the final result of the expression that was evaluated a certain number of steps in 

the past. The channel where the expression results are stored can be thought of as a 

storage record of the previous evaluation steps. Negative sample offsets, therefore, can be 

used to compute any formula that can be expressed in closed recursive form. For 
example, the recursive definition of the Fibonacci sequence is: 

Fn = Fn-1 + Fn-2 

To evaluate this as an expression transformation, use the expression: 

SC(-1)+SC(-2) 

Note that to actually get the Fibonacci sequence; the selected channel would need to have 
a constant value of one prior to the transformation. 

Expression Measurements are powerful tools for quick manual analysis and also for advanced 

Measurement  automated analysis when combined with the Cycle/Peak detector. Expression 
measurements extend measurements to evaluate simple formulas or complex data 

reduction. Each Expression measurement has an expression associated with it and the 

measurement result is derived from computing the Expression(s) on the selected data. 

Measurement expression dialog is 

generated the first time a measurement is 
set to Expression or when the 

measurement preset button is clicked. 

Preset menu allows access to pre-loaded 

commonly used expressions and displays 

user-defined custom presets, along with 
a list of recently-used expressions. 

OK invokes a syntax check. If there is an 
error, the user will be prompted to 

correct the error and the error will be 

selected (highlighted) in the Expression 
edit field. 

Cancel discards any changes to the 
Expression measurement and reverts 

back to the previous Expression. 

Clear erases the current contents of the 

expression edit field. 

 

 

 Measurement Channel 

Expression measurements can reference the 
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Source Description 

ACQLENGTH 

 

Calculation only Acquisition length from 
Set Up Acquisition; keeps Appended 
segments the same whereas 
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LOG Computes the natural logarithm of each value 

LOG10 Returns the base 10 logarithm of each value 

 

FUNCTION  RESULT 

MAXIMUM Returns the maximum value of all input arguments. 

MiINIMUM Returns the minimum value of all input arguments. 

NOT(x) Computes a logical negation of its argument. Evaluates to 

1 if x is zero. 

0 if x is non-zero. 

OR(x, y, …)  
 

Evaluates multiple variables; true if any are true. Computes a logical 
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Control Calculation 

 

The Control function is used to output a digital pulse when the value for a specified input channel exceeds a 
certain level, falls inside a given range, or falls outside a given range. This feature is unique in that the output is 

on a digital channel (which ranges from I/O 0 through I/O 15) rather than a Calculation channel. Also, unlike 

other Calculation channels, this Control Calculation can only be performed in real time (i.e., while data is being 
acquired) and cannot be performed in post acquisition mode. 

In addition to outputting a signal on a digital channel, the Control Calculation will also plot an analog version of 
the digital signal on the Calculation channel you specify. For instance, in the example below, Calculation 

channel C0 is used to perform a control function using analog channel 1 (A1) as an input and digital channel 0 

(D0) as an output. In addition to outputting a pulse on D0, the setup below will also produce a plot on channel 
40 (the first Calculation channel) that emulates the signal being output on digital channel 0. Since Calculations 

are analog channels, the Calculation channel does not contain a 
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As another example, the upper threshold value (L2) is set to 85 and the lower threshold (L1) is set to 83, which 

means that the threshold will not reset until the signal from the source channel drops below 83. In the following 
example, the digital line is switched from low to high (from zero to +5 Volts) when the heart rate channel 

exceeds 85, and stays at +5 Volts for several seconds even though the source channel drops below 85 (but 

above 83). The digital line does not switch back to zero until the heart rate channel drops below 83 (toward the 

end of the record). Once this occurs, the threshold is reset and the digital line will switch again the next time the 
source channel exceeds 85 BPM. 

  

Control dialog and graph showing control channel with “wide” threshold 

It is also possible to have the digital line switch when the source channel drops below a certain value. In the 

example below, a simple threshold is used to switch the digital line high each time the source channel drops 

below 50 BPM. Since L2 and L1 are set to the same value, this is not a 
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Fourier Linear Combiners: FLC, WFLC, CWFLC Calculations 

Fourier Linear Combiners are linear combinations of adaptable sinusoidal functions that are particularly well 
suited to processing cyclic data. Sine and cosine are harmonics that are multiples of a base frequency that are 

summed together, and the order is the fixed number of harmonics used in the model. Step size provides mu, the 

gain factor used to adjust the weights of the harmonics at each processing step. Step sizes must be much less 

than 1 for the system to converge. As step sizes decrease, relaxation time lengthens. The FLC model is adjusted 
based on the source data using least means square (LMS) feedback and the bias compensates for DC offset.  

To have AcqKnowledge apply an FLC Calculation in real time: 

1. Choose Hardware > Set Up Data Acquisition > Channels. 

2. Click the Calculation tab. 

3. Check an Acquire box for the Calculation channel you want to contain the filtered data. You may also 

check the Plot and Values boxes as appropriate for each channel. 

4. Click the Preset pull-down menu and select FLC, WFLC, or CWFLC. 

5. Click the Setup button in the Input Channels dialog to generate the appropriate dialog. 

Ü For offline calculation, see FLC Transform options, including Scaled FLC, on page X289 X. 

 
 

 

Basic FLC  

Simple summation of fixed 
numbers of sines and cosines; 
uses harmonics of a fixed 
frequency and adjusts weighting 
coeffiicients of the mixture. 

Weighted-Frequency FLC 

Base frequency of the harmonics 
is variable; adapts the frequency 
in response to the input signal 
using LMS feedback; the 
frequencies are similarly adjusted 
to the amplitudes. 

Coupled WFLC/FLC 

Runs a WFLC on the signal to 
determine the harmonic frequency 
and then runs the result through an 
FLC using the computed harmonic. 

Operates on a single channel at a 
time. 

Operates on a single channel at a 
time. 

The second FLC can be run on the 
same or a different channel. 

Well suited for extracting data of 
a known frequency band from a 
signal with a stable frequency. 

§ Use as an adaptive noise filter 
to remove non-periodic and 
semi-periodic noise 
uncorrelated to the base 
harmonic frequency. 

Well suited for modeling periodic 
signals of an unknown and 
potentially varying frequency 
and/or amplitude. 

§ No cycle boundaries or 
frequencies need to be pre-
determined. 

Well suited for real-time extraction of 
information from one signal based 
upon the frequencies contained in 
another signal. 

§ Use to remove movement noise 
from ECG. 

§ Unique configurations can be 
established with two input signals, 
one for frequency and one for 
amplitude. 
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Rescale Calculation 

 

Rescale applies two-point linear mapping and allows users to change the measurement units (for example, to 
change temperature from Celsius to Fahrenheit). The text corresponding to the new units can be manually 

entered. 
To have AcqKnowledge apply a Rescale Calculation in real time: 

1. Choose Hardware > Set Up Data Acquisition > Channels. 

2. Click the Calculation tab. 

3. Check an Acquire box for the Calculation channel you want to contain the filtered data. You may also 

check the Plot and Values boxes as appropriate for each channel. 

4. Click the Preset pull-down menu and select Rescale. 

5. Click the Setup button in the Input Channels dialog to generate the Rescale dialog. 

(Off-line Rescale is available under Transform > Rescale.) 

• Use the Rescale transformation (after acquisition) to adjust forgotten calibration of analog channels or 

reverse incorrect calibrations.  

• A "Rescale" Automator action has been added to allow rescaling to be performed in workflows. The 

Automator function is accessed from the Workflow menu in the Mac version of AcqKnowledge. (Not 

applicable to Windows.) 

The rescale formula is: 

 
 

Rescale Source Displays the label and number of the selected channel.  

Old Units Displays the values of the current vertical units of the channel 

New Units Allows for manual entry of the new units to be used. The new units will be displayed in the 
vertical units of the channel 

Note  Transform > Rescale: The units cannot be modified when transforming from the 

selected area because it is not possible to display different vertical units for 

different time ranges in the same channel. 
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8. Click OK and run the acquisition. Any artifact that falls outside the boundaries of the 

maximum/minimum allowed change setting will be eliminated from the recorded data. 

 Watch the AcqKnowledge Slew Rate Limiter video tutorial for a detailed demonstration of this feature. 

  

Filter - FIR 

In AcqKnowledge 5, FIR Filters are available as an online calculation channel. Until recently, real-time FIR 

filtering during acquisition wasn
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Each time an acquisition is restarted in 
Append mode, , an append event is inserted 

into the recording. Append events can be 

configured to include user-defined labels and 
time/date stamps via the Segment Labels 

setup (see page 235). Although you can 

pause for any period of time, the Hardware 
will only acquire data for the amount of time 

indicated in the Acquisition Length box. Data 

can be acquired in Append mode while being 

saved to memory, disk, or the MP hardware 
unit (but not in Averaging mode). 

 

Sample data Acquired in “Append” mode. 
Events indicate where Acquisition was paused. 

Appended segments can be stored to disk, memory, or MP160/150. (MP36R, BioHarness, Mobita, or B-
Alert do not support data storage to the hardware unit.) 

Ø Append to Disk: In this mode, it is usually best to record all channels at the same rate. If the user 

stops the acquisition, the length will be the same for all channels
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§ Top waveform: data is sampled relatively slowly; difficult to make out the shape of the waveform. 

§ Bottom waveform: sampled at a relatively high rate; increased resolution of the waveform. Waveform 

components that were obscured at slow sampling rates are now well defined, and measurements taken on 

this waveform would be able to better establish the maximum amplitude, time between different ECG 
complexes, etc. 

 

 

Representation of ECG waveform sampled 
with relatively few samples per second 



Part B 



160 AcqKnowledge 5 Software Guide 

Visit the online support center at www.biopac.com 

 
Signal (top) measured in the presence of noise 
(middle), which results in the bottom waveform 

when measured in standard Acquisition mode 

 
Same signal averaged in the presence of noise 

over 2,000 trials to produce the lower waveform. 

 

Typically, any averaging acquisition consists of three general components: 

(a) the stimulus signal 

(b) the duration of the acquired data, and 

(c) a small amount of processing time (or overhead) that takes place between acquisitions. 

The duration of the stimulus signal and the duration of data to be acquired can be set by the user. The amount of 

overhead required is a function of the acquisition length, the sampling rate, and the number of channels being 
averaged. 

Acquisition length

Stimulus signal

Overhead

Latency
 

Stimulus signal usually some sort of pure tone or pulse; occurs at the beginning or during 
each trial. 

Acquisition length refers to the amount of data to be acquired during each trial. 

Overhead refers to a period of time after data has been acquired that is needed to 
perform the mathematical averaging. 

Latency refers to the total time elapsed between the start of one trial and the start of 
the subsequent trial. 

Important usage notes 

§ The maximum length of a single averaging pass is restricted to 2 seconds; if longer averaging passes 
are required, use regular data acquisition and use the Ensemble Average offline analysis option to 

generate averages in post-processing. 

§ The preferred hardware setup for on-line averaging mode is direct connection to the 

MP160/MP150 via cross-over cable. To improve stability, avoid interruptions during acquisition: 

• Do not access top-level menus (File, Edit, Transform, etc.) or generate popup dialogs (Setup
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External trigger 

To initiate a trial from an External Trigger signal enable the Ext Trigger in the Averaging options dialog as well 

as the Positive or Negative Edge. The trigger can be set up in the Trigger pane of the Data Acquisition Setting 

dialog. See page X170170. 

Artifact rejection 

Occasionally during an acquisition, extreme levels of unwanted signal artifact may be present. Checking artifact 

rejection allows you to determine what signal levels constitute artifact, and have the MP System reject these 
trials. When artifact rejection is enabled, the MP System will ignore any trials that contain signals exceeding the 

artifact rejection thresholds, keep track of how many trials have been rejected, and add that number of trials to 

the total number of trials to be acquired. This allows a user to 
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Repeating 

Use the Repeat mode to acquire data from repeated trials using the same parameters for each trial. Checking the 

Repeat every box at the bottom of the acquisition setup dialog enables two additional popup menus at the 

bottom of the dialog. These allow for control of how many times an acquisition will repeat as well as the 
interval between trials. When this is unchecked, the acquisitions will repeat as soon as possible (usually 

instantaneously, but slightly longer if data must be saved to a file between trials). 

 

Interval The entry to the right of the 
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Starting an acquisition 

After setting up the channels and defining the acquisition parameters, you are ready to start the acquisition. If a 
file window is not already open, choose File > New to generate a graph window. 

In the lower corner of the screen, next to the  button, you should see a button with a circle to the left 

of it. The circle indicates the status of the communication link between your computer and the hardware. If the 
unit is properly connected to the computer and is turned on, the circle should be solid and green. If the unit is 

not properly connected, a solid gray circle will appear.  

Start the acquisition by clicking the  button or by selecting 
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Overview of Timer Settings 

 
 

CONTROL DESCRIPTION 

Timer name: 
 

Field for assigning name to timer. 

Start timer with acquisition: Timer will start and stop with data recording only. 
Independent start Timer is started and stopped manually, independent of acquisition 

status. 
Countdown timer Sets the countdown time duration. 
Sound alarm Selects the audible alarm option and specifies the number of times 

the alarm will sound. 
Blink upon alarm Enables the timer numbers to flash on and off when the countdown 

is complete. 
Display > Font family: > Font size > 
change color 

Selects timer font style, size and color. 

Include fractional seconds Sets option to display 1/100ths of a second in timer display. 

All parameters established in the Timer Settings are retained in saved graphs and graph templates. 
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Chapter 8 Set Up Triggering 
 
During a normal acquisition, the MP hardware will begin collecting data as soon as the Start button is clicked. It 

is also possible to begin an acquisition in a delayed fashion using a trigger. This feature enables an acquisition 

to start 
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Mode  Once the trigger channel and level have been specified, the final parameter is the delay. Delay can 

be measured in terms of samples, milliseconds, seconds, or minutes, and may be set to zero if 
desired. The delay option instructs the hardware to wait a specified period after the trigger level is 

reached before beginning the acquisition. 

Delay When using a trigger, the default setting is for the acquisition to begin immediately after the 

trigger pulse or level occurs. You can modify this default by using the Delay option in the Trigger 

Setup dialog. This feature allows an acquisition to begin a specified period after the trigger level is 
reached. To start an acquisition one second after a switch closes, set the trigger to external and 

enter 1.00 in the box next to Delay. The default scale for Delay is seconds, meaning that the 

acquisition will begin a specified number of seconds after the trigger has been initiated. The scale 

of the delay can be changed from seconds to samples, milliseconds, or minutes.  

 NOTE: Delay option not available in MP36R hardware. 

Pretrigger During normal triggered acquisitions, data is collected only after the trigger has been activated (or 

after some delay). For some applications, it is useful to collect data on events that occur just prior 
to the trigger event. As an example, if an acquisition was set to begin when a device (such as a 

tone generator or flash) sends an output pulse, it might also be important to collect information on 

the subject
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Stimulator Parameters 

The Stimulator parameters are set by using the buttons in the right pane of the setup window. 

Reset Refresh the display; use after the time scale has been adjusted. 

Scaling  Scaling button
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Manual Stimulator Control 

When an MP160/150 unit is being used, the manual stimulator controls at the bottom of the Stimulator 

Setup dialog can be used to start and stop stimulators independently of the acquisition. If changes are made 

to the stimulus wave while a stimulator is running, the stimulator will need to be turned off and then back 
on to apply the changes to the settings. 

The manual stimulator controls cannot be used if the MP160/150 is set to acquire in averaging mode. 

• The stimulator output will start simultaneously with the acquisition. 

• The On/Off buttons will start and stop the stimulator output. 

 If Dual Stimulator settings are active, 
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Manual Control list box: 

 

Stimulator Output pattern (using MP160/150) 

:  

 

For details on Manual Control, see page 230. 

 
 

 

Dual Stimulation 

For independent control of two stimuli (such as sound and electrical output), set stimulator functions for Output 
to A0 and A1 for each MP160/150 unit. Click the tab for each output at the top of the Stimulator Setup dialog 

and complete independent settings. 

 

§ For additional stimulus paradigms, add MP160/150 units (see Multiple Hardware, page X158 X). 
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Tone Stimuli 

 Tone waveforms allow for the creation of pure tone signals of any duration, magnitude, and frequency. 

This option outputs a pure sine wave, which is useful for audiological and stimulus response testing.  

A tone waveform is comprised of two segments, 

with only the second segment being the actual tone 
itself. This allows you to include a pre-signal delay 

(by setting the level for Segment #1 to 0 Volts and 

the duration to a desired value). 

To set the duration of the tone, adjust the length of 

segment #2 (by changing the Seg #2 Width value 
box or by clicking and dragging the segments 

within the window). As shown, there is an 

additional (uneditable) section of the waveform 
after the second section. This segment returns the 

last value from segment two, and continues to 

output that signal level until the acquisition is 
terminated (if the stimulator is set to output once) 

or until another signal is output (if the MP System 

is set to output continuously).  

There are three additional parameters for Tone 

waveforms: frequency; magnitude; and tone phase. 

§ Tone frequency refers to the frequency of the second segment of the waveform. This can be set to any 

value, although the most common settings are between 20 Hz and 20,000 Hz. 

§ Magnitude refers to the peak-to-peak range of the signal, which can range from ± 0 to ± 10 Volts. 

§ Phase of the stimulus signal can be any value equal to or greater than 0 degrees. Phase settings of more 

than 359 degrees will be rescaled to fit the 0°-359° range. In other words, setting the phase to 360° or 

720° has the same effect as setting the phase to zero degrees. 

 

Ramp Waves 

 Ramp waveforms are useful for constructing a 

monotonically increasing or decreasing stimulus 

signal.  

Ramp waves are comprised of three segments and 

the amplitude and duration can be set discretely for 
all three sections.  
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MP160/150 Stimulator Sample Rates 

The MP160 or MP150 is the most common data acquisition device used with AcqKnowledge, and when 
combined with the HLT100C/UIM100C and STM100C modules, capable of outputting various waves at 

different rates, durations and types. As explained ealier in this chapter, there are four basic Stimulator signal 

types: Square, Sine, Triangle and Arbitrary waves. Square, Sine, and Triangle waves are limited to 4096 

samples, which may be outputted once or continuously. 4096 samples also define the upper limit of a short 
burst wave. Arbitrary waves, like the other types, can be outputted once or continuously, but are not subject to 

the 4096 sample upper limit. 

The Stimulator output sample rate is configured in AcqKnowledge by choosing MP160/150 > Data Acquisition 

Set up > Stimulator > Stimulator sample rate. The stimulator sample rate may be the same, lower, or higher than 

the acquisition sample rate.  The output signal can be redirected to an analog input channel. In this case, the 
number of samples displayed in the graph is determined by the acquisition sample rate. If the source wave can 

be uploaded entirely to the MP160/150 memory (
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Chapter 10 Output Control 
Note Output Control chapter refers to MP36R hardware only.  

 For MP160 or MP150, see the previous chapter, 
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CH# to Output 

 

The CH# to Output Output Control redirects an analog input signal to the Analog Out port on the back of the 

MP36R UNIT. The signal from the assigned channel will continue to be record and plot data.  

This Output Control is used commonly when attaching headphones to the MP36R unit to listen to signals 

coming in on an analog input channel; for example listing to the Electromyogram.  

To display this control panel: 

Choose MP 36R > Output Control > CH# to Output to open the control panel. 

MP36R users may use analog input CH1-CH4. Channel 3 is the default setting. If another channel N has been 
designated, the menu will read 
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Digital Outputs Control 

 

The Digital Output Control manages the signal output for each of the eight digital lines via the I/O Port located 
on the back of the MP36R. Digital lines are used to control external devices. 

The digital output uses standard TTL levels which correspond to the control panel setting as follows:  

Control Panel setting   Output Voltage level (Volts) 

0 0 

1 +5 

To display this control panel: 

Choose MP36R > Output Control > Digital Outputs to open the Digital Outputs Control panel 

Click each digital output line to set its digital state to 0 (off) or 1 (on). 

To set Preferences for Digital Outputs, open the 
Preferences dialog by right-clicking the control panel. 

Select from the following two options: 

Set each output immediately (default) allows you to 
toggle the state of each digital output line between 0 and 1, 

and change the state immediately. In this mode, no Set 

button is available in the control panel. Output for each line 
is set upon clicking its toggle button. 

Set all outputs when Set button is pressed allows you to toggle the state of each digital output line, but the 

states will not physically be changed until the Set button is clicked on the control panel. In this mode, a Set 

button is available in the control panel. When the Set button is clicked, all eight digital lines will update 
simultaneously. 
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Use with stimulator electrode HSTM01 for safe, stimulation of human subjects (0 
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 Preferences available in Pulse Sequence tab 

Add: Displays pop-up menu for adding Sequences, Pulse Trains or Delays. 

Output: Displays the configured sequences and sequence elements for the current or saved session. 

Repeat: Editable field for setting the number of times the pulse train or pulse train element is repeated 

Pulse count: Fixed 
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Delay Preferences 
 

About Delay between Pulse Trains: 

The amount of actual Delay between pulse trains will vary from the set value depending upon the pulse 
repetition value that is used. In the example sequence below, a Delay of 100 milliseconds between pulse trains 

has been set up, combined with a pulse repetition rate of 20 milliseconds. Because the pulse repetition rate is 

applied before the Delay occurs, the actual Delay between pulse trains in this case will be 120 milliseconds. If it 
is critical that a Delay reflect an exact value, it is advisable to subtract the selected pulse repetition value when 

setting up the Delay parameters. 

 

 
 Delay between pulse trains 
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Arbitrary Wave Output 

AcqKnowledge with MP36R supports signal output through one analog channel while data is being acquired. 
This is configured by using the Arbitrary Wave Output option. 

Four types of signals can be output: 

Square waveforms
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Duration 

 

 Off: Turn Output OFF (no stimulus signal output). 

 Output once: Output the stimulus signal once. 

Output continuously: Output the stimulus signal for the duration of the acquisition (forever). 

 When Output continuously is selected, a vertical line is generated at the end of the first section of the 

waveform in the stimulator window to indicate where the first output signal ends and the second begins. 
The line can be dragged left or right like a vertical segment in a stimulus waveform to control the duration 

of the waveform as it is continuously output. Maximum continuous waveform output is 20 kHz.  

Stimulator Sample Rate 

 

Use to select the Stimulator sample rate for the generated signal. (The Stimulator sample rate is independent of 
the acquisition sample rate. See page 182 for sample rate details.) 

For more details on all other MP36R Stimulator parameters and functionality, see the previous MP160/150 

Stimulator chapter on page 173. 

  See also: Application Note HAH162H - Using the Stimulation Features of the MP System. 

 
Sound Sequence Output Control 
Sound Sequence Output Control offers users the option of configuring and customizing sounds to be outputted 

for aural stimulus experiments. The control panel and Preferences dialogs used for Sound Sequence closely 

resemble that of Pulse Sequence. The built-in sound resource (a default 
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Pulse Defititions 
The following terms are used in the Output Control panels, Preferences, and guidelines for Pulses, Stimulator 
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OUTPUT CONTROL PANELS 

 

 

Once configured, Preferences may be saved using the Save Settings button at the 

bottom of the Preferences dialog. Save Settings generates a dialog to name and save 
a defined configuration of Stimulator output settings. Saved configurations are 

accessible via the Output Settings pull-down menu in the Output Control panel. 

When a setting is selected from the menu, all current output parameters are updated 
to reflect the saved settings. 

Multiple configurations can be saved as long as each has a unique name; the Save 

button will be inactive if the name you enter is not unique.  

Settings can be saved locally (to a specific file) or globally. The data file or template 
file holds the output parameters as established when the file was saved plus any other 

named configurations of Output Settings. 

 

 
Use the Organize List button at the bottom of the Preferences dialog to order, 

rename or delete saved Preferences settings. The up or down arrows are only 

available if two or more settings have been saved. Select a setting and then click the 
up and down arrows to set the position, or choose rename or delete. Selecting 
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Recording 

 
Start button 
 

 
Stop button 

When 
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ADVANCED TAB (OUTPUT PREFERENCES) 

Advanced Tab 

(Applicable only to 

Pulses, Stimulator - 

BSLSTM, Low 

Voltage Stimulator 
and Human 

Stimulator-

STMHUM) 

 

Pulse Width 

 

Indicates the Pulse Width setting, which determines the maximum Pulse Rate 

frequency. The Pulse Width value is limited by the Preference setting. 

The entry is activated when the value is changed and the Tab or Enter key is pressed; 
it does not require a stimulator restart to take effect. 

The Pulse width entry overrides other entries as required. 

An entry may be automatically changed if any of the following conditions apply, in 
which case the closest possible value will be selected: 

It falls outside the allowable range. 

It is rounded to .01 millisecond increments (MP36R resolution). 

Width has been limited by the Pulse Width: Limit Entry settings of Preferences. 

Allow any entry 
Pulse width is limited to the output capabilities of the BIOPAC MP36R unit. This 

option allows any entry within the allowable range specified below: 

PULSE WIDTH RANGE MP36R hardware    

Range  .050 
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Advanced Tab Limits Pulses BSLSTM  

Pulse width     

 Range (ms): .050 
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For example, if CH1 is set up for ECG data and then selected as the Reference 

Channel, the ECG parameters will be replaced. If another channel is then selected, 
CH1 will be reestablished with the default analog input parameters, and the ECG 

settings would need to be recreated via presets or manual entry. 

The reference Channel label should read: 
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Chapter 11  Set Up Event Marking 
Events (Markers) 

 

 

 

 

Event Toolbar Event Insertion Event Control 

Event (Marker) Overview 

For detailed analysis, it can be useful for waveforms to have extra information associated with them. This 

information might include waveform boundaries from ECG analyzers, spike classifications from a spike sorter, 

heartbeat classifications, or even detailed user notes. AcqKnowledge 4 uses 
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§ Sort Grouped events 

Sorted by time sorted in order by increasing time 

Sorted by label sorted alphabetically by label 

§ Include only events visible on the screen 

Determine if the summary is generated for all of the events that are in a graph, or only for those events 

that are currently visible on the screen. If there are thousands of events in a file, this feature allows the 
list to be pared down to those of interest. 

Event summary options will be saved with the graph if the graph has a graph journal, and can be pasted into the 

journal using 
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Additional Hotkey Setup Controls Function 

Add Adds an editable label field to the list.  

Rename Allows renaming of the existing segment label. 
Delete Deletes a selected custom label. 
Delete All Deletes all custom labels. 
Up Incrementally moves a selected label up the list. 

Down Incrementally moves a label down the list. 
Top Moves a selected label to the top of the list. 
Bottom Moves a selected label to the bottom of the list. 
Include time Adds timestamp to labels when checked 
Include date Adds current date to labels when checked 

Create/Toggle Focus Area Action 

Selecting the 
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§ When disabled, the event list will display all of the events for the entire graph. This can allow for easier 

navigation through graphs with hundreds of events, such as PhysioBank files. 

Selected Event 

 

 

 

Event type options are 

detailed on page X221 X. 

When a single event is selected, the type, channel (or 
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Actions 

 

Actions Button Description 

Find It is easy to create many more events then one can easily scroll through and locate 
in a list. Find controls the automatic location of events based on established search 

criteria. 

Click the Find button to generate the Event search criteria dialog, and then 
combine or restrict information to define desired events: event type, specific 

channel location, or label search. 

Click 
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This opens the 
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normal 

Right bundle branch block Atrial escape 

Bundle branch block Nodal escape 

Atrial premature Supraventricular escape 

Aberrated atrial premature Ventricular escape 

Hemodynamic 

 >  Blood Pressure 

Systole End Systolic pressure 

Diastole End Diastolic pressure 

Hemodynamic 
 >  ECG Complexes 

 

QRS onset, peak, and end U-wave peak 

T-wave onset, peak, and end PQ junction 

P-wave onset, peak, and end J-point 

Q-wave peak ST segment change 

S-wave peak T-wave change 

Hemodynamic 

 >  Impedance 

A-point  O-point 

B-point  X-point 

C-point Y-point 

Hemodynamic 

 >  Monophasic AP 

Plateau Upstroke 

Hemodynamic 
 >  Other 

Start of ventricular flutter Pacemaker artifact 

Ventricular flutter wave Isolated QRS-like artifact 

End of ventricular flutter Non-conducted P wave 

Notes Arrow
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§ Amplitude at last event only
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§ Disabled: prints only the event icon, label, amplitude, and time. No indicator lines will be printed for the 

event display. The vertical divider can be used in place of indicator line drawing. 

 

Events and Waveform Editing 

Waveform editing will adjust event locations for channel-specific events. Waveform editing will never alter the 

time values for Global events (not associated with any specific channel, such as append events). 

Copy  When a portion of a waveform is copied the channel events will also be copied to the clipboard.  

Cut When a portion of a waveform is cut, events within that selected area will be removed and channel 

events to the right of the removed area will be shifted to the left. 

§ If waveform editing event insertion is active, a waveform edit event will be inserted at the location 

of the edit operation indicating a 
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• Channel Numbers will display the channel numbers (A1 for the first analog 

channel, for example). 

• Units will display the units for each channel (as indicated in the main graph 

window).  

• Labels will display the channel labels (ECG 1, Respiration, etc.) along with the 

input values. This feature is especially useful when values from multiple 
channels are being displayed simultaneously. 

• Min/Max will display the range of values associated with the data. This range 
corresponds to the upper and lower display limits for each channel as it appears 

in the graph window. 

• Values will display number values along with the horizontal or vertical bar chart. 

Manual Control (MP160 and MP150 only) 

 

 
STM100 option 

The Manual Control dialog allows you to monitor and/or output pulses through the digital input/output (I/O) 
channels, as well as manually set the magnitude of the signal on either of the analog output channels. The 

digital outputs in Manual Control cannot be used to trigger an online Averaging acquisition. 

Stimulator Usage Note 

Use Manual Control to specify the stimulation output level  

a. If the wide range of waveform output options available in the Stimulator Setup dialog cannot 

match your specifications.  

b. For pre-stimulation and post-stimulation. 

See page X177 X for important Analog Output details. 

The 16 digital channels are sectioned off into two blocks, with the first block consisting of I/O channels 0 

through 7, and the second block consists of I/O 8 through 15. 

• All the channels within a given block are programmed together and can be set as either inputs or 
outputs. 

• The two blocks can be set independently. 

o For example, one block can be set to input data and the other to output data, or one block is 
inactive and the other block reads or outputs data. 

To read incoming values for a given block of digital channels, click the Input button below the row of channels 

for which you wish to have input values displayed. This enables a block of digital channels to receive incoming 
data. To read the values for the entire block simultaneously, click the Read button to the left of the channel 

boxes for that block. Since these are digital channels, the values on the individual channel boxes will toggle 

between 0 and 1. 
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Set Up Linked Acquisitions 

This Hardware menu option allows acquisitions to be configured and recorded simultaneously from multiple 
hardware devices types over separate graphs. (For example, acquisitions can be simultaneously linked to two 

MP160/MP150,  two MP36R units or an MP160/MP150 and a B-Alert unit..) In order for Linked Acquisitions 
to function, each selected graph must be connected to a different hardware unit. (If two or more graphs are 

connected to the same hardware unit, the linked acquisition session will not start.)  

To add or change the hardware device to any open graph, click the 
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Manage Hardware Connections 

 

 

 

 

 The Manage Hardware Connections option 
enables easy connection and disconnection 

of new hardware, and allows switching 
from a particular hardware unit (or 

hardware type) to another. The following 

controls are available: 

Connect New Hardware 

Choosing 
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SOUND FEEDBACK 
CONTROLS 

FUNCTIONS 

Sound enabled Turns sound feedback of data on and off. 

Output Sampling Rate Selects from available sampling rates of the default audio device. 

Source Channel Selects the analog, digital or calculation channel from which the audio will be acquired. 

Reset Adaptive Gain Control Resets gain control to adapt to the current level of the signal. Use after sound feedback 
has started to re-adjust the level after accidental spikes or large artifacts. 

Enable low pass filter Applies a low pass filter at the Nyquist frequency (50% of the acquisition sampling rate). 
This IIR filter can help smooth out transition artifacts due to upsampling of data to the audio 
sampling rate. (Enabled by default) 

Median removal controls 
(Window width, Recomputate) 

Removes baseline offset from the output signal. 

Window width Sets width of median removal window (in seconds). Must be a positive value. 

Recompute every Provides the time duration (in seconds) after which the median of the data is regenerated 
from the raw source data. Must be a positive value. 
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Channel  Provides a pop-up menu for assigning any one of the ENABLED analog or calculation 

channels. 

Background Image  Displays the path and file name of the current background image. The default image is a 

blue blood pressure gauge sized at 451 x 451 pixels.  

Browse  Allows alternative background images in different directories to be used in place of the 

default gauges. The Browse location will default to the file path used by the currently 
selected background image. To change the background image, click the 
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Segment Timer 
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Warn on Overwrite 

Selecting the 
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New > Batch Acquisition 

Use the Batch Acquisition feature to configure advanced experimental setups and acquire data from a 

sequence of templates. Each template in the Batch may have different acquisition settings, channel 

configurations, and stimulator setups. Use a Batch for long duration experiments with hardware setting 
changes across segments, to automate routines, or to run multiple experiments on the same experimental 

setup in succession. 

§ For example, if an experiment has a preparatory period, a stimulus period, and a response period, three 

graph templates could be batched: 

§ A template to acquire for the length of the preparatory period 

§ A second template with a stimulator configured for the stimulus period 

§ A third template to acquire the response period without stimulation 

All three templates could be added in sequence to a single Batch Acquisition, which would then acquire all 
of the data for all three templates with a single start. 

To create a new batch, choose File > New > Batch Acquisition to generate the Batch dialog. 

 

The Templates controls at the top allow you to add, 
remove, or re-order the templates. 

§ Double click a template in the list to open the 

output graph from the most recent acquisition. 

§ Batch acquisition cannot combine acquisitions that 

do not end, so the acquisition storage mode for 

template files cannot be set to 
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Open 

The File > Open command generates the standard file open menu, and allows you to open a variety of different 
file formats from the popup menu at the bottom of the dialog.  

 

Multiple files 

To open multiple files in a single dialog, hold the Control/Command key down and select multiple files. To 

open consecutive multiple files in a single dialog, select the first file, hold the Shift key down and select 

multiple files. AcqKnowledge can only recognize one Journal file at a time, so multiple selection is disabled 
when the file type is set to Journal or Journal Template. 

Graph The default file formats (*.acq) is referred to as 
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When the Files of type: Text option is select, an Options button is activated. Clicking on 

this button generates another dialog that allows you to control the amount and type of 
data to be read in, as well as the time scale for data display. 

 
Wave data starts on line 

 To control how much data is read in, enter a value in the read line box at the top of 
the dialog. This tells AcqKnowledge which row contains the first data point in the 

series. By default, this is set to 1, although you may want to set it to another value 
since some applications (usually spreadsheets) generate a 
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and then click OK to open the file. 

§ If AcqKnowledge can
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Open Recent 

The File > Open Recent command generates a list of recently used files. These files can be opened directly from 

the list or with a Ctrl (PC) or Command (Mac) keystroke combination.  

 

The listed files appear in the order they were opened, with the most recently-opened file appearing at the top. 
Default number of files appearing in the list can be modified in the Preferences. (Display > Preferences > Other 

or Main Toolbar) 

Open for Playback 

The File > Open for Playback command generates a standard file open dialog; see page 40 for Playback details.  

SMI BeGaze Import 

This option allows for import of SensoMotoric 

Instruments BeGaze software
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• Import of either waveforms or parameters 

• Provides choice of animal subects to be imported 

Datquest File Description 

Unlike graph files, Dataquest ART saves data as multiple files in a single directory. Each file may be either a 

continuous recording or consist of multiple segments. 

A recording may contain multiple animals/subjects. Each animal/subject is given an animal ID. This animal ID 

forms the basename of all of the various Dataquest data files. 

Two primary types of data are recording for each animal: waveforms and parameters. Waveforms are the semi-

continuous raw data recorded from transmitters during the segment. For multi-channel recordings, each channel 
may have an independent sampling rate and the sampling rate may vary within an individual channel for an 

individual experiment, but the duration and recording frequency are identical across all channels and animals.  

Parameters are derived measurements such as heart rates, mean pressure, and other values derived from the raw 

data.  The user's protocol may dictate which type of data will be useful in the analysis, but many DSI customers 
perform further data reduction on the parameters instead of working with the raw data. 

Dataquest splits waveforms and parameters up into separate files. Specific ID parameters are stored into a 

sequence of files named 



Part C 



258 AcqKnowledge 5 Software Guide 

Visit the online support center at www.biopac.com 

Save 

  

This menu command will save any changes made to a file. If more than one file is open, this command only 

applies to the active window. For untitled files, you will be prompted to name the file you wish the data to be 

saved in. The file will remain open after you have saved it, allowing you to continue working.  

• The Save menu is dynamic and corresponds to the type of file you are trying to save, i.e. Save Graph, 

Save Journal. 

Files should be less than 2 GB, except AcqKnowledge 3.9 
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TXT Saves graph data in text format. When Save As Text is selected, an Options button is 

generated. Clicking on this button generates a Save Options dialog that allows you to 
control how much data is saved and the format it is saved in.  

 

Include header 

When the first box is checked, a 
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Layout: Packed sequential: All of the data for an individual file is located in a 

single block of the file and multiple channels follow one another. 

 Interleaved: Data is grouped into a single 
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JPG AcqKnowledge also supports formats for saving graphical information. Most drawing, 

page layout, and word processing programs can read .JPG files. This is particularly 
useful for writing reports. A. JPG file can be opened in any standard drawing program 

and can then be embellished or used to highlight any particular phenomena of interest.  
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When data is saved as a graphic, only the data currently on the screen is saved. So, if 
you have a data file that spans eight hours but only two minutes is displayed on the 

screen, only two minutes of data will be converted to a graphic file. Since 

AcqKnowledge uses information about the computer screen in creating the graphic file, 
the default resolution of the file will be the same as the window. Most word processors 

and graphics packages allow for some way to resize and scale graphics. 

Compressed Saves a compressed AcqKnowledge formatted file. The degree of compression varies 

based on data characteristics, but will generally achieve about 60% compression. Saving 
small files (less than 200K) may have little effect. Using a sample file as an example: 

 

Compressed graphs no longer allow data acquisition and will open with no Start button. 

A warning prompt will be 
generated when you try to 

compress a graph in which 

data can be acquired (Start 

button active): 

Excel 

Spread-

sheet 

Excel Spreadsheet Export
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Send Email Attachment 

Use this feature to create an email attachment containing an image of the active AcqKnowledge graph, along 

with the journal contents.  

When using this feature: 

o The default email program will launch, along with a 
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• Print Options 

§ Plots per page



Part C 



270 AcqKnowledge 5 Software Guide 

Visit the online support center at www.biopac.com 

Edit menu functionality during acquisition 

The following Edit menu functions cannot be performed during acquisition: Undo, Cut, Clear, Clear All, Paste, 
Insert Waveform, Duplicate waveform, and Remove Waveform. 

Undo / Can
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Select All 

When Select all is chosen from the Edit menu, the entire selected channel becomes highlighted. For almost all 

commands, when a waveform is selected using Select all, subsequent operations apply to the selected channel 

only. 

§ The exception is when Edit > Clear all is chosen after Edit > Select all. When this occurs, all data from 

all waveforms will be deleted. 

 

Insert waveform 

The Edit > Insert waveform command is useful for copying a waveform (or a section of a waveform) within the 

same or another graph. However, within the same graph, Duplicate waveform is simpler.To do this, first select 

the area to be copied using the cursor and the Edit > Copy command. Next open the graph window to insert the 
waveform into.  

Select the new graph and choose Edit > Insert waveform. A new (empty) channel will then be created and the 

data copied into the empty channel.  

§ Insert waveform cannot be performed during acquisition. 

§ This command cannot be undone directly, although selecting the inserted channel and choosing Remove 
waveform from the Edit menu effectively undoes this operation. 

 

Duplicate waveform 

Choosing Edit > Duplicate waveform will create a new channel in a graph window and copy an entire 

waveform (or a selected area) to the new channel. When a portion of the waveform is selected, only the 
highlighted area will be duplicated. 

Duplicate waveform may move or alter memory and cannot be performed during acquisition. 

§ To duplicate the entire waveform, choose Edit > Select all and then select Duplicate from the Edit menu 
or click the right mouse button and select Duplicate from the pull-down menu.  

 

Remove waveform 

Deletes the entire selected waveform, regardless of what other options are selected. Remove waveform may 

move or alter memory and cannot be performed during acquisition. 

§ The Edit > Undo command does not work for Remove waveform. 

 

Remove last appended segment 

Removes the last appended segment. Equivalent to the  Rewind toolbar icon. 

 

§ Edit > Undo does not work for Remove last appended segment. 

 

Create Data Snapshot 

The Snapshot options store 
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Merging graphs as data segments 

Individual graphs may also be merged into a single channel as appended segments. This can be useful for 

concatenating data types that don
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Ø Copy Focus Area Summary 

Copies the starting and ending position of the focus area in horizontal axis units. Summary includes focus 

area label. 

Ø Copy Event Summary 

Copies events to the clipboard as selected in the Event Summary setup dialog. 

Journal 

  

The Edit > Journal sub-menu options are similar to those found in the Edit > Clipboard menu. The key 

difference is that data (whether measurements or raw data) is pasted directly into the journal rather than copied 

to the clipboard. 

Ø Paste Measurements 

Choosing Paste Measurements from the Edit > Journal menu will cause all visible measurement 

windows to be pasted into the journal. Each time this is selected, the measurements and values are 
pasted into the journal using the precision specified in the Display > Preferences dialog. You can also 

change the total number of measurements displayed by adding more rows of measurements. Use the 

Preferences menu (see page 442) to change the number of measurement rows or the measurement 
precision displayed on the screen. 

Paste Measurement shortcuts: 

 Keyboard: Ctrl + M 

 Mouse: Right-click in the Journal and choose 
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Ø Manage PDFs 

Use this option to select and import (embed) PDF files into the Journal as tabbed windows. Multiple 

PDFs may be imported and each PDF appears under its own tab heading. Choose Edit > Journal > 

Manage PDFs, or right-click in the Journal and choose Manage PDFs. The following dialog will appear: 

 

Control Description 

Embed New Launches a 
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Recently Used Transformations 

The Transform > Recently Used submenu allows quick access to a user
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Whereas the low pass and high pass filters retain data either above or below a given threshold, the next two 

types of filters work with a range, or band, of data. 

Band pass filter 

The band pass filter, allows only the data within the specified range to pass through the filter. A band pass filter 

is useful when you want to retain only specific waves from an EEG record. For instance, to retain alpha waves, 

you can set the filter to only pass data between 8 Hz and 13 Hz. 
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Band stop filter 

The band stop filter allows data to pass above and below the specified range. This type of filter is typically 
applied to remove extraneous 60 Hz or 50 Hz noise from a data record.  

Band
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For every filter except the band pass, the lowest frequency cutoff is equal to the specified cutoff frequency 

for the filter; for the band pass filter, the lowest frequency cutoff is the low frequency cutoff setting. Filters 
that use a small number of coefficients tend to be less accurate than filters that use a large number of 

coefficients. Larger coefficients increase filter accuracy, but also increase the processing time required to 

filter the data.  

To see how changing the number of coefficients affects the way data is filtered, it can be useful to examine 

the filter response patterns. In the example below, data was collected at 500 Hz and the band stop filter was 
designed to remove 60 Hz noise using a low cutoff of 55Hz and a high cutoff of 65Hz. The same data was 

band stop filtered using 39 coefficients (upper waveform) and then 250 coefficients (lower waveform). 

 

Along the horizontal axis, the units are scaled in terms of frequency, with lower frequencies at the left of 

the screen. The values along the vertical axis are scaled in terms of dB/V and indicate the extent to which 
various frequencies have been attenuated. 

In both filter response waveforms, there is a downward-pointing spike that is centered on 60 Hz. The 
baseline of the filter response corresponds to a value of approximately 0 on the vertical axis, indicating that 

the signals significantly above or below 60 Hz were not attenuated to any measurable extent. As you can 

tell, however, the filter does not 
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Adaptive Filtering 

 

 
Ü See the Adaptive Filtering Calculation 

Channel on page 151. 

Adaptive filtering is a signal processing technique that 
processes two different signals in relation to one another 

and can be used for noise estimation, noise reduction, 

general-purpose filtering, and signal separation. Adaptive 

filtering creates efficient high-quality filters with a minimal 
number of terms, which can be very useful in blocking 

mains interferences or other known periodic disturbances. 

§ Useful for noise filtering where it is possible to acquire 

a signal that is correlated to the noise (similar to the 

way noise-cancelling headphones detect and remove 
outside noise). Applications include removing EMG 

from ECG or EOG from EEG. 

The weights within an adaptive filter are modified on a step-by-step basis. AcqKnowledge uses the N-tap FIR 
adaptive filter, with coefficients updated using least means squares (gradient) feedback. 

Source signal 

The source channel will be replaced by the adaptive filter results. 

Noise signal 

The noise channel is the signal that is correlated with the noise to be eliminated from the Source; it is 

not modified by adaptive filtering. 

Source and Noise channels must have the same sampling rate. 

Order 

Specify a positive integer for the number of terms to be used in the internal FIR filter. 

Step size 

Provides mu, the rate of adaptation of the coefficients within the FIR filter. 

 

Comb Band Stop Filter  

Comb Band Stop filters out a fundamental frequency and its overharmonics (integer multiples of the base). 

Resonance, aliasing, and other effects may generate interference at multiples of a base frequency. The Comb 

Band Stop filter combines all the required filters instead of requiring a separate filter for each interfering 
overharmonic.  

    
 Transformation Dialog Calculation Channel Dialog 
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Harmonics Removes the base frequency and integer multiples of the base frequency up to and 
including the multiple contained in the edit field 

• Must be an integer greater than 0 and must not exceed k max  

• The final multiple must be less than the Nyquist frequency. If it is not, the input will 

need to be corrected before the comb filter can be applied. 

OK If the settings are valid, executes the comb filter transformation. Verification of certain 
calculation channel parameters does not occur until the start of acquisition as sampling 

rates may be changed after calculation channels are configured. 

Prior to the start of acquisition, the following will be checked: 

• source channel to ensure it is still being acquired. 

• base frequency of the comb filter to ensure it is less than the Nyquist frequency of 

the channel sampling rate. 

• if the user has manually specified that a fixed number of overharmonics should be 

used, the number of overharmonics to ensure the highest used overharmonic does 

not exceed the Nyquist frequency of the channel sampling rate. 

If any of the parameters are invalid, a prompt will be displayed indicating which settings 
are incorrect and must be fixed for the acquisition to be started. 

Cancel Quits without modifying any data.  

Source All enabled analog, digital, and lower-index calculation channels. 

Label When the calculation type of a channel is changed to comb filter, the title of the channel 
will be replaced with the default label 
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Coupled WFLC/FLC 

Runs a WFLC on the signal to determine the harmonic frequency and 
then runs the result through an FLC using the computed harmonic. 
The second FLC can be run on the same or a different channel. 

The transformation will occur in the channel  designated as 
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Limit (Limit data values) 
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Result of correlation and mean square error functions 

5) Use the zoom tool to inspect the abnormalities more closely. 

 

Remove mean 

A drifting baseline can be problematic when comparing waveforms. The effectiveness of a comparison of a 

template or waveform with a slowly drifting baseline will be increased by applying the Remove mean template 

function. The remove mean option causes the mean amplitude value of the template and the compared section 
of the waveform to be subtracted from each other before the sections are compared. This way, a large baseline 

offset will have very little effect on the comparison. This option is toggled every time it is selected and is 

enabled when a check mark is present. 

For example, the following graph shows the original waveform at the top, the correlated waveform with mean 

removal in the middle, and the same correlation without mean removal at the bottom. Note how the mean 
removal effectively compensates for the drifting baseline in the original waveform. 

 

Correlation with and without mean removal 
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Remove Projection treats the template in memory as a vector. The projection of the selected area onto the 

template is computed as a vector dot product. This projection is then removed from the source data.  
After a remove projection transformation, the remaining data consists of the part of the signal that is the 

most unrelated to the template. 

Remove Projection can be useful for emphasizing signal differences. For example, it may be useful for 

exploring differences in an arrhythmia in comparison to a normal reference beat. It may also be useful as a 
denoising building block by removing the projection of a signal against idealized noise in the template. 

The number of samples in the template should match the number of samples in the selected area of source 

data. 

• Dot product is undefined for vectors of mismatched dimensions. 

• If the template is longer than the selected source data, the template will be shortened (for that single 

transformation; it will be restored afterward) so its length matches the selection width. 

• If the selection is longer than the template, any data occurring after the end of the template will not 

be transformed. 

To create a Remove Projection template: 
1. Highlight the portion of data to be used as the reference signal. 

2. Transform > Template > Set Template. 

3. Highlight the portion of the data to be analyzed. 

4. Transform > Template > Remove Projection. 
 

f) Normalized cross-correlation (NCC) is useful when searching for variations in the signal. Regular cross-
correlation (Transform > Template > Correlation) can exhibit large amplitude spikes when the energy of a 

signal varies greatly or amplitudes change suddenly, causing jumps that are not necessarily indicative of a 

match with the template. Normalized cross-correlation is a statistical method that can help resolve these 
issues by applying normalization to both the template and signal being searched. This reduces the effect of 

amplitude variation in the result, making normalized cross-correlation useful for template matching 

purposes. 

This transformation computes the windowed normalized cross-correlation, and results in a value between -1 

to 1, which indicates the linear fit of the data set. Normalized cross correlation is defined as: 
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where x = template 

y = signal 

L = length 

= mean value of the signal f 

At the end of the transformation, the source data will be replaced with the sliding NCC values. Data outside 
the selected area will be left unmodified. If the selected area is zero width when the transformation is to be 

executed, the entire waveform will be transformed. 

If selection is shorter than the template, the missing data at the right end of the selected area will be filled 

with zero padding until it matches the length of the template. This padding occurs in memory and will not 

affect the source data in the graph. The same zero padding is used when computing NCC at the end of every 
selected area when the template is running off the end of the data. This zero padding should trend the NCC 

to zero at the right edge of the transformed area, in most cases. 
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Output 

Show normalized cross correlation values provides access to the sequence of correlation values that is 
examined by the heuristic for potential matches. Viewing the normalized cross correlation signal can 

provide feedback that is useful for proper threshold selection and for detecting whether the heuristic has 

fallen into one of its degenerate cases (e.g. NCC signal hovering around the threshold for extended 

periods of time). When checked, a new channel will be added into the graph containing the normalized 
cross-correlation values computed by the algorithm. The channel will be labeled 
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Integrate 

 

The Integrate transformation operates 
the same as the Integrate calculation
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Integrate formulas, continued
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Difference  

 

The Difference function measures the difference (in amplitude) of two sample points separated by an arbitrary 

number of intervals. The difference is then divided by the total interval between the first selected sample and 

the last selected sample. 

When the difference transformation is selected, a difference interval dialog will be generated and the number of 

intervals between samples can be entered (default of 1). 

For data with no high frequency components, a 1-interval difference transformation approximates a 

differentiator. 

The formula for the difference transformation is shown below, where 
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Expression 

   
 
See the tables on page 142 for descriptions of sources, operators and functions for the Expression dialog. 

The post-acquisition Expression transformation is available for performing computations more complex than 

available with the Math and Function calculations. The post-acquisition version of the Expression 
transformation includes all the same features as the online version described on page 138 X. The Expression 

transformation will symbolically evaluate complex equations involving multiple channels and multiple 

operations. Unlike the Math and Function calculations, which can only operate on one or two channels at a 
time, the Expression transformation can combine data from analog or digital channels, as well as calculation 

channels with a lower channel number. Also, computations performed by the Expression transformation 

eliminate the need for 
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To add these two waves, select Transform > Waveform Math and set source 1 to channel 14, the operator to 

addition 
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Chapter 16 Analysis Menu Commands 
Overview 

The Analysis menu contains operations that derive data and measurements from the graph
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Nonlinear Modeling 

About nonlinear modeling 

Modeling is used in physiological data to assess how well data conforms to a theoretical model. This is 
used to express a sampled signal in a continuous form and to perform data reduction. The nonlinear 
modeling features in AcqKnowledge support more advanced physiological analysis than is possible with 
the linear regression measurement, which is a rudimentary single order linear model. 

Nonlinear modeling is the process of finding the best fit of a mathematical function to an arbitrary data 
set. Fitting the function
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Power Spectral Density 

 

The Power Spectral Density (PSD) function extracts the 
power present at different frequencies within a signal and is 

useful for EMG analysis. The PSD transformation 

approximates the same result as squaring the linear FFT 

magnitude. PSD is not available when the horizontal units 
of the source graph are set to Frequency. 

AcqKnowledge uses the Welsh periodogram to average 

signal time-sliced portions of the signal and reduce noise 

effect, and generates a two dimensional graph displaying 

the wattage of a particular frequency component in a signal. 
Windowing options are Hanning, Hamming, or Blackman. 

The graph is plotted as horizontal frequency vs. vertical 

(units)^2/Hz, where units are the vertical axis units of the 
source data.  

Use linear detrending for each window
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Show Mod. To view the modified waveform being used as input for the FFT, check the Show modified 

input box. Whenever possible, it is best to use an input waveform (select an area) that is an 
exact power of two. The waveform is modified by applying the windowing and padding 

options. Window functions diminish the discontinuities that occur at either end of the wave. 

 

Window The FFT algorithm treats the data as an infinitely repeating signal with a period equal to the 
length of the waveform. Therefore, if the endpoint values are unequal, you will get a frequency 

spectrum with larger than expected high frequency components due to the discontinuity. 

Windowing these data minimizes this phenomenon. For example, to apply a window 
transformation to a sine wave whose endpoints do not match up, check the box next to Window 

and choose a type of window from the pop-up menu. Each of the windows has slightly different 

characteristics, although in practice each provides similar results within measurement error.  

 As shown below, the frequency spectra of the windowed and non-windowed data differ 

significantly when the endpoints are unequal. When data are not windowed, the very low and 
very high frequencies are not attenuated to the same extent as when windowed. 
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 Since the offset of the waveform is often an artifact of the way it was generated, the remove 

mean option provides a more accurate indication of the true spectral components. This is 
especially true for applications where low frequency components are of interest. If your data 

has a large DC offset and you plan on windowing the data, you will generally get a more 

meaningful spectrum if you remove the mean prior to windowing (which is the same order the 

FFT uses). 

Linear By default, the FFT output is described in terms of frequency along the horizontal axis and 
dBV on the vertical axis. The Bell scale (from which dB are derived) is logarithmic, and in 

some cases it may be useful to have the output scaled in linear units. To do this, click the button 

next to linear and check OK. The other options in the dialog work as they normally do when the 

dB scaling option is selected. The relationship between log and linear units is: dBVout = 20 log 
VIN. 

Phase The standard FFT produces a plot with frequency on the horizontal axis and either dB/V or 

linear units (usually Volts) on the vertical axis. In some cases, it may be useful to obtain phase 

plots of the waveform (as opposed to the default magnitude plots). Phase plots display 

frequency along the horizontal axis, and the phase of the waveform (scaled in degrees) on the 
vertical axis. This option functions exclusive of the magnitude option
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DWT/SWT  

 

About Wavelet Transformation 

Wavelet transforms are similar to Fourier transforms. Instead of 
projecting a signal in a space of sines and cosines, wavelet transforms 
project a signal into a space comprised of orthogonal functions called 
wavelets. Discontinuities are more obvious in wavelet transforms than in 
sines and cosine analysis, making wavelet transforms a better choice 
for decomposing a signal to its fundamental form. Wavelet transforms 
can be used for noise reduction and filtering, extracting features from 
signals that are not apparent in time or frequency domains, and 
predicting signal qualities from a small number of data points. 

Discrete wavelet transformations (DWT) break a source signal into high-frequency and low-frequency 

components. Use for ECG and EEG analysis. DWT creates a new graph with wavelet coefficients on the 
horizontal axis and the amplitude for each coefficient on the vertical axis, pastes acquisition settings to the 

graph journal, and places an event at each boundary between the high- and low-frequency components 

produced at each iteration.  

 Wavelet type Specify Biorthogonal 4.4, Symlet 4, Coiflet 6, Daubechies 8 or Spline 3. 

 Number of iterations Specify the number of transforms to execute. 

Stationary wavelet transformations (SWT) differ from DWT in that the 
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Find Cycle (Peak Detector)  

 Watch the six-part AcqKnowledge Find Cycle video tutorial for a detailed demonstration fo this feature. 

 

The Find Cycle/Peak Detector setup dialog is accessed by choosing Analysis > Find Cycle, or using the Ctrl+F 
keystroke. 

Overview 

The advanced Cycle/Peak Detector combines with the powerful Event Marking System. Use it to perform 

amplitude, time, or event-based measurements. New output options for measurements, averaging, events, 

clustering (K-means), and 3D surface (cycle data, histogram, FFT, and DWT). 

The Find Cycle detector uses three tabbed settings panels to define and automate cycle/peak detection: 

Cycles/Peaks   Selection Output 

Cycle detector settings are graph-independent, which means that find cycle/peak operations can be performed 

in multiple graphs without needing to re-enter graph-specific settings for each run. By using multiple data 

views, different find cycle/peak operation can be performed on the same set of data without losing settings 

between 
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When the cycle location mode is switched on the 
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The time units for starting the first interval and setting the interval width can be selected in milliseconds, 
seconds, minutes or hours. 

Selection tab 

Use the Selection tab to adjust the range of data that will be analyzed to generate any output. By default, the 
data range is set to be the entire cycle as located by the settings on the Cycle/Peak tab, but it can be adjusted to 

analyze only specific portions of the cycle. 

The controls on the Selection tab vary based on the settings on the Cycle/Peak tab 

Peak When the Cycles/Peaks location method is 
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Output: Averaging—Offline 

 

Use Averaging Output
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Output Events 

 

Toggle the 
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Event Location Table 

Insertion Method Location Process 

Interval, at location Place an event at the left or right boundary of the selected area, as specified. 

Interval +/- percent 

offset 

Given a particular channel, place an event at the specified time within the 

selection when the signal increases or decreases by a specific percentage. 

 

Interval start + Place at the time closest to the left boundary of the 

selection. The percentage is calculated from the value of 
the signal at the left boundary of the selected area. 

 

Interval end - Place at the time closest to the right boundary of the 

selection. The distance between the event and the right 
edge of the selection will have an amplitude difference 

equal to the indicated percentage of the right edge
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algorithm partitions the data set into k groups such that the sum of the differences between the centers of 

each group and its remaining members is minimized. 

A basic algorithm description is: 

A. Given a total of k clusters, choose k potential cluster centers. 

B. Assign each member of the data set to a cluster according to the closest potential cluster center 

using a Euclidean distance function (sum-of-squares). 

C. Adjust the location of the potential center for each cluster to a more optimal value. The most basic 

method is to assign the new center to match the mean value of all of the members of the set. 

D. Determine if the set of clusters and centers is satisfactory. If not, go to step 2 and repeat the 

clustering process. 

There are many different variations on what constitutes satisfactory ending conditions. The most ideal 

stopping criteria are when the cluster assignments no longer change with successive iterations. When there 
is no change in the centers, the solution perfectly minimizes the Euclidean distance sum for each cluster, 

unique up to variations in ordering of the dimensions. In practice, determining the perfect clustering of a 

data set is computationally intensive and may require some time to process. Approximations of perfect 

clustering are quicker to compute and usually produce sufficiently accurate results. 

 A waveform segment is reduced to a single data point by extracting numerical quantities known as 
features. Feature clustering is a very common data reduction method in use by clustering-based spike 

sorting software. Each feature is a single real-valued number extracted from the data. Examples of features 

are: maximum amplitude in waveform segment, minimum, time to maximum, time to minimum, peak to 

peak distance, sum of all values, maximum slope of peak. 

A commonly used clustering analysis starts with two features. The features are then calculated for each 
waveform segment and presented on a scatter plot, allowing the user to visually determine how many 

clusters may be present. A k-means clustering analysis is then run on these data points to determine the 
center of the clusters in feature space. With the center known, each waveform segment is then assigned to a 

cluster depending on the values of its features. 

Clustering Settings 

  

Number of clusters 

After features have been extracted, data points constructed from the feature are split up into a number of 

groups. Enter the number of clusters into which the data is to be partitioned.  
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Remove Outliers 

The clustering analysis allows for optional removal of outliers, or spurious data points. When enabled, each 
cluster is assigned a boundary. After each data point has been assigned to the cluster, the standard deviation 

of the distance of each point from the center of the cluster is computed. When outlier rejection is enabled, 

any data point that is farther away from the center than a specific number of standard deviations will be 

removed from the cluster. Enabling outlier removal retains only the points in a cluster that have the 
strongest association with each other. 

Clustering Criteria 

 

For a particular segment of a waveform, features are 
extracted based upon user-specified criteria. 

Segment Width Peak to Peak 
Value (left edge) Time peak to Peak Delta 
Max Sum 
Min Median 
Time to Max Mean 
Time to Min Measurement Result 

Multiple segments are located using the Find 

Cycle/Peak functionality. After the criteria have been 

computed for each segment, clustering is then 
performed. This allows segments to be partitioned 

based upon their features. For example, 
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The following example details how to detect the positive spike in the QRS complex
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If the Auto threshold detect mode is similarly unavailable, adjust the Noise rejection or add the Remove 

baseline option.  

1) Fixed threshold detect mode: 

Fixed threshold detect mode is the simplest mode of operation for 

the Rate Detector. As shown here, the Threshold Level has been set 

to 0.00 Volts. If the waveform crosses 0 Volts, the Detector will 
begin to look for Positive or Negative peaks (based on the Peak 

detect setting). 

Not available in Fixed mode: 

Noise rejection 

Baseline window width 

Windowing options 

 

 

 

 
 

 

 
2) Auto threshold detect mode:  

Auto threshold detect mode is a more advanced and flexible mode of 
operation for the Rate Detector. In this case, the Rate Detector will 

create a variable threshold defined as: 

 Positive peak search 

  0.75 
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Signal type 

The Signal type menu contains parameters for specific human and 

animal waveform morphologies. All pre-defined and custom signal 

types are common to both calculation channel Rate (online) and 
analysis Rate (offline) dialogs. Signal type modifications affect 

settings in the Signal Parameters tab only, and do not affect the 

Output tab settings. 

Select from six pre-configured signal types or click 
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Additional Find Rate Dialog Settings, Output Tab 

 

Function 

The Rate Detector Function menu lists a variety of calculations, which are discussed below. 

Rate (Hz), Rate (BPM), Interval (sec) 

The most commonly used function is the Rate (BPM) option, which calculates a rate in terms of beats 

per minute or BPM. Rate calculations can also be performed that return a rate value scaled in terms of 

frequency (Hz) or time interval (sec). When rate is reflected in terms of a time interval, the time 
difference (delta T) between the two peaks is returned. This is sometimes referred to as the inter-beat 

interval (IBI). The frequency calculation returns the rate in Hertz (Hz), which is computed by dividing 

1 by delta T. These measurements are perfectly correlated with the BPM calculation, since BPM is 
equal to 60 times the frequency calculation, or 60 divided by delta T. 

Peak time 

Returns the time (in seconds) at which the peak occurred. Like the other Rate functions (e.g., BPM and 

Hz), the value of the last peak time will be plotted until a subsequent peak is detected. The resulting 
plot will resemble a monotonically increasing 



Part C 



346 AcqKnowledge 5 Software Guide 

Visit the online support center at www.biopac.com 

Chapter 17 Specialized Analysis 

 

 

The Specialized Analysis package includes comprehensive 
analysis tools to automate analysis to save hours (or days!) of 

processing time and standardize interpretation of results. 

• AcqKnowledge
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Detect and Classify Heartbeats 
Locate Human ECG Complex Boundaries 
Locate Animal ECG Complex Boundaries 
Gastric Wave Analysis 
Gastric Wave Coupling 
Chaos Analysis 

Detrended Fluctuation Analysis 

Optimal Embedding Dimension 

Optimal Time Delay 

Plot Attractor 
Correlation Coefficient 
Electrodermal Activity 

Derive Phasic EDA from Tonic 

Event-related EDA Analysis 

Locate SCRs 

Preferences: Output Display Format; Phasic EDA 
Construction Method: Smoothing Baseline Removal or 
High Pass Filter 

Electroencephalography 

Compute Approximate Entropy 

Delta Power Analysis 

Derive Alpha-RMS 

Derive EEG Frequency Bands 

EEG Frequency Analysis 

Remove EOG Artifacts  

Seizure Analysis 

Preferences: Output Display Format 

Electromyography 

Derive Average Rectified EMG 

Derive Integrated EMG 

Derive Root Mean Square EMG 

EMG Frequency & Power Analysis 

Locate Muscle Activation 

Preferences: Output Display Format 

Ensemble Average 
Epoch Analysis 
Focus Areas 

Define Between Events 

Define for Appended Segments  

Hemodynamics 

Classifiers: ABP; LVP; MAP  

Arterial Blood Pressure 

Baroreflex Sequence Analysis (licensed feature) 

Baroreflex Slope Analysis (licensed feature)  

ECG Interval Extraction 

Estimate Cardiac Output from ABP  

Left Ventricular Blood Pressure  

Monophasic Action Potential 

Preferences: Output Display Format; LVEDP Location 
Method; dP/dt pk-pk %; MAP Plateau Location Method; 
dP/dt MAP pk-pk % 

HRV and RSA 
Multi-epoch HRV 
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File Compatibility 

§ Mac AcqKnowledge 3.9and above can open and create PC-compatible Graph (*.acq) and Graph Template 
(*.gtl) files. Variable sampling rate information and hardware settings are retained, and Journals can be read 

from and written to PC files. Files must end on a multiple of the lowest channel sampling rate to be fully PC 
compatible. 

Saving files after Specialized Analysis 

 
Saving Files AcqKnowledge 4 

The default file format for the File>Save as command is to save files as an 
AcqKnowledge file. Selecting Graph (MPWS) or .ACQ (MPWSW) from 

the popup menu in the Save As dialog will save a file as an AcqKnowledge 

file, which is designed to be as compact as possible. These files can only 
be opened by AcqKnowledge, but data can be exported to other formats. 

File > Save Selection As allows you to save only a portion of your file. 

When this option is enabled, only the data that has been selected with the 

I-beam tool will be saved. This option saves the selected area to another 

file and does not affect the current file that you are working in. 

File Compatibility  

Windows AcqKnowledge 3.9 and above files can be opened with Mac AcqKnowledge 3.9 and above, but some 

advanced features may not transfer. 

Mac AcqKnowledge 3.9 and above can save as 
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Locate Animal ECG Complex Boundaries 

Locate Animal ECG Complex Boundaries optimizes the ECG 

waveform boundary detection for animal input. Smaller animals 

such as mice often lack a detectable T wave, so in the setup dialog 
the T wave boundaries are disabled by default. If appropriate to the 

experiment, T wave detection can be applied by enabling the 
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Optimizing the time delay in this fashion picks the shortest delay where the signal exhibits the most independence 

with respect to its time-delayed version. 

The fractal dimension and other chaos-related measurements operate on a single channel of data. In the process of 

extracting these measures, a signal is compared with a time-delayed version of itself to examine the patterns in 
dynamics of the data. These measures take a fixed time delay setting. The Optimal Time Delay transformation can 

be used to choose the best value for the parameter. 

 

Plot Attractor  

 

Assists in constructing X/Y plots for the attractors of time 

delayed data. By visually examining the shape of the attractor 
at a given time delay, To develop an intuitive sense for the 

underlying nature of the data and the dynamics of the system. 

Plot Attractor functions on the active channel of the graph. It 

prompts the user for a time delay and then constructs a new 

graph window with an X/Y plot of the attractor of the original 
signal against the time delayed version of the signal. It does 

not perform any additional computation aside from assisting 

in the setup and configuration of the attractor plot. 
 

Correlation Coefficient 

   
The correlation coefficient is a statistical measure related to the degree of variance or covariance between two data 
series. Given two data series x and y of length n, the correlation coefficient r is given by the formula: 

 (see Hhttp://mathworld.wolfram.com/CorrelationCoefficient.htmlH) 

The square of the correlation coefficient can be used to determine the proportion of variance in common between the 

two signals. As the square gets closer to 1, the signals are a better statistical match for each other. 

To derive the correlation coefficient, two channels of data are compared against each other. 

• the channels must have the same length 

• the channels must have the same waveform sampling rate 

• all of the data of the entire graph for the two channels will be used to compute the correlation coefficient. 

Electrodermal Activity 
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Event-related EDA Analysis 

   

The Event-related EDA Analysis transformation routine assists in the extraction of EDA measures that are linked 
to specific stimuli. The stimulus event marks must be included in the file BEFORE using this analysis.  

This analysis routine requires four elements: 

1. Tonic and Phasic waveforms. 

Tonic EDA Channel: A Tonic EDA signal must be present in the graph.  

Phasic EDA: 

Construct new: Given a tonic EDA signal, a phasic EDA will be automatically constructed using 

baseline smoothing or high pass filtering (the method currently set in Preferences).  

Use Channel: If the graph contains a phasic waveform, select the appropriate channel. 

2. Stimulus delivery events.  

Digital events with a common event type must be located BEFORE using this analysis.  

The Event-related EDA Analysis requires that an event be defined in the graph at the location of the 

delivery of each stimulus. This event may be defined using the Event Tool, hotkey insertion during 
acquisition, or any other method of defining events. All of the stimulus delivery locations to be 

extracted must have the same event type (e.g. 
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Event-related EDA Analysis Output Options 

Enhancements provide more options for multiple stimulus event types and unmatched events, including:  

§ Labels and additional measures are available in the specific stimulus and SCR analysis table  

§ Text and Excel tables may be optionally sorted either by time or grouped by stimulus label  

§ A new table has been added listing stimulus events that were not paired with an SCR  
§ The SRR/NS.SSR Rate analysis, which counts frequencies of SCRs in specific time periods, may 

now be driven by time periods defined using pairs of events or a selection in the graph  

§ A table has been added listing amplitude/frequency percentage statistics for all matched and 
unmatched stimuli events (e.g. total stimulus count, percentage of stimuli that were pared with an 

SCR, etc.)  

§ Additional optional Specific-SCR events may be defined on the tonic EDA waveform at the 

positions of specific SCRs with labels matching the stimulus to which they were responses. This 
allows for further peak-detector based runs to perform additional data reduction.  

Event Related EDA Event Types: 

§ Waveform Onset 
§ Waveform End 

§ Skin Conductance Response 

§ Specifc SCR 
Waveform Onset and Waveform End events are also available for other Specialized Analysis operations. 

Amplitude Summary Output Options 

For each specific SCR that is paired with a stimulus delivery event, the following measures are extracted in 

table format and can be sorted by Time or by Event label. If text output is enabled in EDA Preferences, the 
average value of SCL, Latency, SCR Amplitude, and SCR Rise Time will be included as the final row of the 

table. 

Name Abbrev. Description Units 

Stimulus 
Delivery Time 

Stim Time The time within the recording where the stimulus delivery event 
was located. 

seconds 

Skin 
Conductance 
Level 

SCL Amplitude of the tonic EDA signal at the time when the stimulus 
was delivered. 

µmho 

Response 
Latency 

Latency Time separating the stimulus delivery from the onset time of the 
corresponding SCR. 

This latency will always be less than the maximum allowable 
latency specified as a parameter for the analysis. 

seconds 

SCR 
Amplitude 

SCR 
Amplitude 

Height of the corresponding SCR as determined by the change in 
the tonic EDA amplitude from the time of SCR onset to the 
maximum tonic EDA amplitude achieved during the SCR: 

[EDA(tmax) 
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Amplitude/Frequency Percent Summary 
The 
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EDA Measurements 

To perform Event-related EDA analysis, choose Analysis > Electrodermal Activity > Event-related EDA Analysis.  

To take measurements from the skin conductance response analysis, set measurements for event count, event location 

and/or event frequency. Set the source channel as the Tonic EDA channel and select the location (measurement 

channel only, global events only, anywhere) and measurement parameters as desired. This method is useful for 

spontaneously occurring skin conductance response analyses. Take measurements over a manually selected area or 
use Find Cycle analysis to take automatically measurements over a user-defined time interval. 
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Electroencephalography 

 

Compute Approximate Entropy 

 

Approximate entropy is a statistical measure that attempts to quantify the predictability of a data sequence. A 

perfectly predictable data series (such as a pure sine wave) has approximate entropy of zero. Several studies are 
beginning to examine approximate entropy of EEG data and its relationship to external factors such as drugs and 

sleep states. 

The Compute Approximate Entropy script divides an EEG signal into fixed-width epochs and computes the 

approximate entropy for each epoch. Derivation of the approximate entropy is a computationally intensive process 

and may take several minutes or hours to complete. To obtain only the sub-ranges of the EEG data, use the 
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EEG Frequency Analysis 

   

EEG may be characterized in terms of frequency and the power within specific frequency bands. The EEG 

Frequency Analysis script performs various feature extractions from EEG signals using FFT and other techniques 
to examine the power within the EEG signals. This analysis may be performed for multiple EEG leads 

simultaneously, allowing for either analysis of multiple leads or analysis of multiple EEG alpha, beta, theta, or 

delta bands from a single raw lead. 

The EEG Frequency Analysis script divides the EEG signals into fixed-width time epochs. For each individual 

time epoch, AcqKnowledge
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If the EEG Analysis Preferences are set to display 

results as graph channels, two new channels of data will 
be created. The first channel shows a tachogram of the 

number of epileptic spikes identified within the Time 

epoch. The second channel displays a square wave that 

runs from 0 to 1; a 1 indicates that an epoch matches 
the seizure threshold. In the default setting, 20 seizure 

spikes have to be identified within a 10 second epoch 

for the epoch to be classified as containing a seizure. 

 

If the 
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Preferences… 

 

Adjust the EOG ICA Tolerance level and the EOG ICA maximum number of iterations by accessing Transform > 

Specialized Analysis > Electroencephalography > Preferences. EOG ICA Tolerance is used as the termination 
condition of ICA signal separation. The EOG ICA maximum number of iterations is another termination 

condition of ICA signal separation and represents the maximum point at which the search is aborted. For more 

information on these settings, see the documentation for the Independent Component Analysis transformation. 

Because ICA is a statistical technique, any filtered data produced with Remove EOG Artifacts should be carefully 

verified against other information to ensure that the approximations produced via ICA represent information that 
is truly correlated to the expected ECG. 

The spectral edge percentage indicates the cutoff percentage of the total power at which spectral edges will be 

placed. The default value is 90%. 

The frequency bands of alpha, beta, delta, and theta may be modified to match different analysis protocols. The 

default frequency ranges are:  

• Alpha
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Derive Root Mean Square EMG 

 

Root Mean Square EMG (RMS EMG) is defined as the time windowed RMS value of the raw EMG. RMS is one 
of a number of methods used to produce waveforms that are more easily analyzable than the noisy raw EMG. 

To construct the windowed RMS signal, a time window must be specified for the sliding mean. The default time 

window setting is 30 milliseconds, but this value can be adjusted depending on the desired amount of smoothing 
effects in the RMS EMG. It is advisable to closely examine results for time windows larger than 30 milliseconds 

as it is possible for delay to be introduced into the result. 

RMS EMG is computed using the Integrate transformation in a Root Mean Square Average over Samples 

configuration. 

EMG Frequency and Power Analysis 

Several frequency domain techniques may be used for data reduction of EMG signals. The EMG Frequency & 

Power Analysis script extracts several measures derived from the power spectrum of an EMG signal. The EMG 

signal is split up into a fixed number of time periods; within each window, the power spectrum is computed using 
the Power Spectral Density transformation. For each time period, the following measures are extracted: 

Name Abbrev. Description Units 

Median 
Frequency 

MedianF Frequency at which 50% of the total power within the epoch 
is reached. 

Hz 

Mean 
Frequency 

MeanF Frequency at which the average power within the epoch is 
reached. 

Hz 

Peak 
Frequency 

PeakF Frequency at which the maximum power occurs during the 
epoch. 

Hz 

Mean Power MeanP The average power of the power spectrum within the epoch. 
(Units Note: V will be replaced with the voltage units in 
which the EMG was recorded) 

V
2

Hz  

Total Power TotalP The sum of the power at all frequencies of the power 
spectrum within the epoch. 
(Units Note: V will be replaced with the voltage units in 
which the EMG was recorded) 

V
2

Hz  

Locate Muscle Activation 

 

When performing gait analysis, exercise physiology, or other research, identification of periods where the muscle 
is active can allow for correlation of external factors to muscle activity.  
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Ensemble Average 

  

Ensemble Average assists in performing offline averaging. Offline averaging produces an average waveform from 
a number of cycles, also known as an ensemble average. Averages of multiple channels can be extracted 

simultaneously and be consolidated into a single graph window showing the results. Offline averaging is also 
available as a function within the Find Cycle feature. 

This option provides two methods for locating individual members of the ensemble. 

Ü Peaks: Data-driven peak detection with positive or negative peaks in the data. This method automatically 
derives appropriate threshold levels from a user-selected peak and is useful for constructing averages keyed 

to periodic signals with strong spikes, such as ECG. 

Ü Events: Place members of the ensemble surrounding events in the waveform. Events must be previously 

defined by the user, either manually or through another automated process. This method is useful for 

constructing averages keyed to any types of events in a graph. 
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Focus Areas between Events and Segments 

In addition to the standard focus area functionalities discussed on page 87, focus areas can also be used as an analysis 
tool to define areas of interest between certain event types or between appended segments.  

Define Between Events 

The parameters for defining focus areas using this method are highly customizable, and can be based upon specific 

event types or titles as well as various event locations in the graph. The following table explains the various focus area 
start and end event options. 

 

Focus area label basename: 

Use to assign a title for the focus areas. Successive focus areas will use 

the same title with the addition of incrementing numbers. 

Event type: 

Use to select the type of event for defining the focus area. 

Location: 

• Anywhere



Part C 



376 AcqKnowledge 5 Software Guide 

Visit the online support center at www.biopac.com 

Mean blood 
pressure 

MBP Mean blood pressure: 

Pdiastolic +
Psystolic − Pdiastolic

3
 

Minimum dP/dt dP/dt min Minimum amount of change in the pressure during the cycle 

 

QA Interval QA Time interval between ECG Q wave and the diastolic pressure 

Recovery 
interval 

%REC Time required for the pressure signal to decrease by a user specified percentage of 
the pulse height 

Systolic - Maximum pressure occurring during the cycle 

Time to peak 
pressure 

TTPK Time interval between the diastolic and the systolic pressures 

When textual output is used, the average of all of these measures will be output as the last row of the table. 

 

ECG Interval Extraction  

 

Extracts cycle-by-cycle time and voltage measurements for various points and intervals between waveforms in the 

cycle on ECG Lead II signals. This interval extraction is based off of the waveform boundary locations with 

additional logic for defining explicit Q and S wave events. QRS peak events as output for boundary location are 
used as the R peak location. 

§ If the ECG signal was not classified before running the interval extraction analysis, it will be classified 
automatically. 

This analysis extracts the following cycle-by-cycle measures: 

Name Abbrev. Description 

Corrected QT 
interval 

QTC QT time interval divided by the square root of the RR interval 

Heart rate HR RR time interval expressed in BPM 

P height P-H Amplitude at the peak of the P wave in a cycle 

PRQ interval PRQ Time between the onset of the P wave to the Q wave 

QRS width QRS Time between onset of the QRS complex and the end of the QRS complex. Equivalent 
to the time between onset of Q and end of S 

QT interval QT Time between the beginning of the Q wave and the end of the T wave 

R height R-H Amplitude of the R wave in a cycle 

RR interval RR-I Time between consecutive R peaks in the waveform 

ST interval ST Time between the S wave to the end of the T wave 

At the end of the text table output, the average of all of the cycles will be displayed. Additionally, both text and 
Excel output will indicate the number of cycles that did not have all three of the QRS, P, and T waves defined. 

These are cycles where the classifier missed a boundary and are listed as 
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 Watch the AcqKnowledge Cardiac Output from ABP video tutorial for a detailed demonstration of  

this feature. 

Left Ventricular Blood Pressure 

 

Extracts various cycle-by-cycle cardiac measures of left ventricular blood pressure data, optionally in conjunction 
with an ECG Lead II signal. Examines the LVP signal, ECG, and derivative of the LVP signal. 

§ If the LVP and ECG signals have not been classified before this analysis is executed, they will be classified 
automatically. 

§ Derivatives of the LVP signal can be pre-existing or can be constructed automatically. 

§ If an ECG signal is not included, only pressure related measures will be extracted. 

The analysis outputs the following information on a cycle-by-cycle basis and the textual output cites the average 

of all of these cycle-by-cycle measurements: 

Name Abbrev. Description 

Contractility 
index 

CI maximum value of dP/dt during the cycle divided by the pressure at that time 
location 

Developed 
pressure 

DP Amplitude interval between end diastolic pressure and systolic pressure 

dP/dt Max - Maximum change in pressure over the cycle 

dP/dt Min - Minimum change in pressure over the cycle 

End diastolic 
pressure 

LVEDP End diastolic pressure for the cycle. This is not necessarily the minimum pressure 
during the entire cycle. 

LVEDP is located on the LVP signal using the method set in the preferences. 

Minimum 
pressure 

MIN Absolute minimum pressure occurring during the entire cycle. This is not 
necessarily equivalent to the end diastolic pressure 

QA Interval QA Time interval between the Q wave of the ECG and the end diastolic pressure 

Rate - heart rate in BPM as extracted from the time interval between consecutive end 
diastolic pressure locations 

Recovery time %REC Time it takes for dP/dt to increase from the minimum dP/dt location to a user 
specified percentage of that minimum value 

Systolic pressure SYS Maximum pressure occurring during the entire cycle 

Tau - Monoexponential time relaxation constant tau computed on a cycle by cycle basis.  

See 
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Monophasic Action Potential  

  

Performs classification of MAP data acquired from a human or animal subject and extracts various cycle by cycle 

intervals. Locates upstroke, maximum, 100% recovery, and user-specified recovery points on the action potential.  

§ Classification is performed using the action potential with its smoothed derivative; pre-filtering noise with 

low pass filters may improve classification. 

§ If upstroke, maximum, and plateau events are already defined on the MAP signal, the classifier is not invoked 
and only recovery events are defined. 

Plateau position 

To better handle animal subjects and different potential morphologies, there are two methods for locating the 

plateau position in monophasic action potential data; use Preferences to set the method. Each method defines 

recovery percentage time locations depending on the signal between its maximum and the beginning of the 
plateau. The plateau is located by examining the derivative of the MAP immediately following its maximum 

value after an upstroke.  

§ The first method uses an adaptive threshold of zero plus a percentage of the peak to peak change in the 

derivative between the maximum and the first zero crossing after the maximum. If the signal remains above 

the upstroke voltage in this interval, a quick algorithm is used to locate 100% recovery and user-specified 
percentage levels.  

§ The default percentage is 0.1%, which will place the plateau position very close to the second zero crossing. 

This slight window around zero helps place plateau start events better for MAP data that has plateaus that 

continue increasing after their starting position. 

§ Searches for the second zero crossing after the maximum. If the signal drops below the voltage level of the 

upstroke in this interval, a different (slower) algorithm is used to ensure the recovery percentage is relative to 
the upstroke voltage and not the minimum occurring between the maximum and plateau. 

The analysis outputs the following information on a cycle-by-cycle basis and the textual output cites the average 
of all of the cycle-by-cycle values: 

Name Abbrev Description 

100% recovery 
period 

100% 
REC 

Time interval from the upstroke for the signal to recover back to the upstroke voltage 
level 

dV/dt maximum dV Max Maximum change in voltage over the cycle 

dV/dt minimum dV Min Minimum change in voltage over the cycle 

End diastolic 

voltage 

EDV The value of the signal at the beginning of the upstroke 

Max voltage MAX The maximum value of the signal over a single cycle 

Minimum 
voltage 

MIN The minimum value of the signal over a single cycle. This may be less than the 
upstroke voltage depending on the morphology of the action potential 

Plateau voltage 

 

PLAT The value of the signal at the start of the plateau after the completion of the upstroke 

Rate - This is the heart rate in BPM as extracted from the time interval between consecutive 

upstrokes 

Stroke amplitude AMP Voltage interval between the plateau and the upstroke voltage 

User recovery 
period 

%REC Time interval from the upstroke for the signal to recover a specific percentage of the 
interval between the upstroke and the maximum voltage between the upstroke and the 
plateau 
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ABP Location method (Arterial Blood Pressure) 

§ Adaptive template matching 

This arterial blood pressure cycle location method uses adaptive template matching (see page 297). A 

single cycle is selected, systolic to systolic, which sets an example template. Subsequent blood pressure 

cycles are located by correlation to this template with the template adapting to the signal. This may 

function better if there is artifact in the pressure signal, however may not be as suitable for signals that 
have significant changes in heart rate. Location may also improve if a different cycle is chosen as the 

initial template. Adding smoothing or a low pass filter to the signal may improve results for Estimated 

Cardiac Output, ABP Classifier and Arterial Blood Pressure. 

§ Tracking peak pressure level  

The Tracking peak pressure level ABP location method is similar to the cycle detector's peak location 

method. This method sets a detection threshold from a selected systole and adjusts the threshold based on 
a customizable tracking percentage. The default tracking percentage is 60%. If the blood pressure signal 

is highly variable, this tracking percentage may need to be lowered. If the tracking percentage is set too 

high, blood pressure cycles may be missed. 

HRV and RSA Analysis 

AcqKnowledge includes flexible options for extracting a wide range of heart rate variability (HRV) and respiratory 
sinus arrhythmia (RSA) measures. This analysis feature allows you to: 

• Extract HRV measures over user-defined areas of data, such as fixed time trials (
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If Fixed width intervals around events is chosen, the following setup criteria are available: 

• Event type: 
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Single-epoch HRV – Spectral 

Single-epoch HRV 
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When using events, the built-in QRS detector is not used; the exact positioning between the events on the channel 

is used to extract the RR intervals.  

By using events, it is possible to use other QRS detectors within AcqKnowledge for performing HRV analysis. It 

is also possible to apply spectral HRV-style analysis to data in other domains as long as intervals can be reduced 
to events. 

Spline resampling frequency 

For highest accuracy, set to no less than twice the topmost frequency of the very high frequency band. 

Frequency Bands 

 

Enter the start and end of each specified frequency band to adjust the boundaries of the frequency analysis. They 

are preset to the frequency ranges recommended by the European Heart Journal (1996) 17, 354-381. Output of 

derived parameters is presented in a dialog and may also be pasted as text to the Journal. 

§ Very high frequency band, usually used in rat studies, is disabled if the spline resampling frequency is less 

than the upper bound of the very high frequency range. 

PSD Options 

 

PSD Options establish parameters for the power spectral density transformation used to compute the spectrum 

from the interpolated tachogram; the options contained in this tab mirror the controls of the Analysis > Power 
Spectral Density transformation. 

The use of linear detrending in each individual segment of source data prior to the windowed periodogram 
analysis can be enabled or disabled. When disabled, the algorithm may be tuned to correspond to 

implementations that do not apply linear trending, such as MATLAB, which uses windowing only. The same 
PSD options are available via Analysis > Power Spectral Density so users can regenerate the spectrum from 

either the raw or interpolated tachogram output as necessary. 

After the user modifies the parameters for the PSD transformation, those parameters will become the new 
default values each time the dialog is displayed. When the application is relaunched, the default settings will 

be used (user changes are not persistent). 
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Use linear 
detrending for 
each window 

When enabled, linear regression detrending is applied for each individual segment prior to the 
FFT computation. When disabled, windowing only is applied. 

Detrend each 
segment 
independently 

This option is only available when “Use linear detrending” is enabled. When this option is 
enabled, detrending is applied independently for each segment; when disabled, detrending 
from the previous segment will be incorporated into the next segment. 

Transform 
entire wave 

When enabled, the entire waveform is delayed. When unchecked, only the selected area is 
delayed. 

§ If there is no selection in the graph, the checkbox is enabled and dimmed. 

§ As the selection changes in the graph with the selection palette, the state of this checkbox 
is updated. 

Improvements to PSD Options (AcqKnowledge 4.3 and higher) 

l The PSD output is now scaled so power values are scaled by the sampling rate.  That is: PSDnew=
PSDold

f s
 

l Reporting a sum for a frequency range when computing the power in an individual band has been changed.  

Given a frequency range f low , f high
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Impedance Cardiography Analysis 

The Impedance Cardiography analysis package assists in the analysis of cardiac output and other hemodynamic 
parameters using noninvasive bioimpedance monitoring techniques; signals must be sampled at 5 kHz or below to 

be analyzed with this package. This analysis offers a variety of approaches for estimation of cardiac measures. 

 

Body Surface Area  

Determines the body surface area estimation in square meters for a subject of a given height and weight, using the 

formula set in Preferences. It can be used to calculate body surface area independent of any of the other analysis 

routines, which may be useful for validation purposes or other derived calculations. 

Body Surface Area equation 

Use the Preferences option to select an algorithm for estimating body surface area of a subject and deriving stroke 

volumes from impedance data. 

Method Formula 

Boyd BSA = 0.0003207×Height(cm)0.3 ×Weight(g)0.7285−0.0188log(Weight(g ))
 

DuBois and DuBois BSA = 0.20247×Height(m)0.725 ×Weight(kg)0.425
 

Gehan and George BSA = 0.0235 ×Height(cm)0.42246 ×Weight(kg)0.51456
 

Haycock BSA = 0.024265×Height(cm)0.3964 ×Weight(kg)0.5378
 

Mosteller BSA =
Height (cm ) ×Weight (kg )

3600
 

dZ/dt Derive from Raw Z  

This is a convenience utility for working with impedances recorded using the BIOPAC EBI100C amplifier or the 

raw impedance output of the BIOPAC NICO100C module. When computing derivatives from raw impedance 

signals from an EBI100C, this will apply appropriate filtering for a thoracic impedance signal and properly invert 
the derivative to match traditional dZ/dt presentation. 

dZ/dt Classifier  

Places events at common inflection points on a dZ/dt waveform to derive other measures. 
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C-point Location
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§ If both a raw impedance and a dZ/dt signal are present, the baseline impedance will be derived on a cycle-by-

cycle basis to improve the accuracy of the analysis. 

§ If no raw impedance signal was acquired, a default fixed baseline impedance can be used. 

§ If a NICO100C amplifier is used, it is recommended that both the raw impedance and dZ/dt signals be 

acquired to improve analysis accuracy. 

§ To automatically apply motion filtering to the dZ/dt signal, use Preferences to enable Motion Filtering (see 

page X400 X). 

§ ICG Preferences must first be selected in order to generate the main ICG Analysis setup window. 

In addition to the minimal set of signals, it is also possible to use arterial blood pressure, central venous pressure, 

and pulmonary arterial pressure signals to improve the quality of the algorithm results. If any of these signals are 

not present, default fixed estimated values can be substituted for the mean pressures instead of deriving pressures 
on a cycle-by-cycle basis. 

ICG Analysis may potentially perform classification of both the dZ/dt and the ECG Lead II signals. The various 

notes for understanding the limitations of these classifiers apply and should be understood to properly interpret 

failures in the analysis. 

ICG Analysis will produce the following information on a cycle-by-cycle basis: 

At the end of the textual table an average of all of the cycle-by-cycle values will be appended. 

 

Name Abbv. Description Units Formula 

Acceleration index ACI Maximum blood acceleration 1 / sec^2 d2Z

dt
2

max

TFI
 

Cardiac index CI Normalized cardiac output m^2 / min CO

BSA
 

Cardiac output CO Volume of blood pumped each 
minute 

l / min SV ×HR 

Heart rate HR Heart rate in BPM as computed 
from the RR interval. 

BPM 60

RRi

 

Left cardiac work LCW Work exerted by the left ventricle 
each minute 

kg m MAP − PAP( )×CO×0.0144 

Left cardiac work index LCWI Normalized left cardiac work kg m / m^2 MAP −PAP( )×CI × 0.0144 

Left ventricular ejection 
time 

LVET Time interval between B and X. 

Time interval between aortic valve 
open and close. 

sec Not applicable 

Mean blood pressure MBP Mean blood pressure as measured 

on the arterial blood pressure 
signal, or fixed estimate if no ABP 
signal is present. 

mmHg 
Pdiastolic +

Psystolic − Pdiastolic

3
 

Mean central venous 
pressure 

CVP Mean central venous pressure over 
cycle, or default value if no CVP 
signal is present. 

mmHg Not applicable 

Mean pulmonary arterial 
pressure 

PAP Mean value of the pulmonary 
arterial pressure of a cycle, or 

default value if no PAP signal is 
present. 

mmHg Not applicable 
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Name Abbv. Description Units Formula 

Systemic vascular 
resistance index 

SVRI Normalized afterload dynes sec m^2 / 
cm^5 80 ×

MAP −CVP

CI
 

Systolic time ratio STR Ratio between electrical and 
mechanical systole 

none PEP

LVET
 

Thoracic fluid content TFC Electrical conductivity of the chest 
cavity 

1 / Ohms 1

TFI
 

Thoracic fluid index TFI Mean value of the raw impedance 

over the cycle, or fixed baseline 
value if no raw impedance signal is 
present. 

Ohms Not applicable 

Velocity index VI Maximum velocity of blood flow 
in the aorta. 

1 / sec dZ

dt max

TFI
 

Note  may be either 
the absolute maximum 
or the BC delta in 
amplitude, as set in 
Preferences. 

Ideal Body Weight  

Body Weight is derived from a person
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Preferences 

 

Display results as 

§ Textual tables in the journal 

§ Channels of data inserted into the graph. 

C-point location 
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Two large sources of interference in MRI recordings are the current induced by the MRI magnetic field and the 

RF pulses used for triggering molecule alignment. While the overlap of this interference may be difficult to 
separate in the time domain, the MRI interference may have a distinctive signature in the frequency domain. 

Artifact Frequency Removal is a frequency domain adaptation of the ensemble projection removal of the Artifact 
Projection Removal transformation. It attempts to cancel out MRI artifact by removing the frequencies most 

strongly associated with the MRI signal. 

For each channel of data to be denoised, either the MRI trigger signal or event positions are used to locate periods 

of MRI activity for constructing an ensemble average. The FFT of this ensemble average is computed, and the 

magnitude of the average FFT is set as the reference. Cyclic mean removal is applied to each period of artifact to 
compensate for baseline drift or signals with expected DC offset. A second pass is then made through the data. 

For each individual artifact, the FFT of that artifact is computed and the projection of that FFT onto the average 

FFT is removed. After projection removal, negative Fourier components are discarded and a time-domain signal 
is reconstructed using the inverse Fourier transform. This reconstructed, filtered signal is used to replace the MRI 

artifact in the original data. 

Application of projection removal in the frequency domain has similar limitations to applying it in the time 

domain, that is, it assumes that the MRI interference is stationary (which is not necessarily the case). Variations in 

the MRI interference may cause this method to fail. 

IMPORTANT Artifact Frequency Removal requires an MRI triggering signal or artifact onset events to locate 

artifact positions. 
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Signal Blanking 

  

MRI artifact can grossly distort low level physiological signals, and this distortion can be several orders of 

magnitude larger than the signal of interest. A common practice for analyzing the physiological data is to discard 

the MRI artifacts and only examine the portions of the signal in between the MRI artifacts. One approach for this 
is outlined in BIOPAC MRI application note AH223. 

Signal Blanking provides an alternate approach for discarding MRI artifacts from the signal. Using the MRI 
triggering signal or artifact event locations, this analysis option will locate the periods of MRI activity and 
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• On classified signals, the resulting ensemble averages will have multiple channels. 

o The first channel will be the overall average of all of the spike episodes. 

o The remaining channels show the average of the members of each individual spike class. 

• On unclassified signals, a graph will be produced with a single channel showing the average of all of the spike 

episodes. 

Classify Spikes 

  

This analysis option will automatically classify action potentials in microelectrode data and divide them into 
different spike classes. 

If the Locate Spike Episodes option wasn
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1. Obtain mean value of the entire signal. 

2. Obtain standard deviation of the entire signal. 

OR: Obtain an Amplitude/Half Width Discriminator of the entire signal. See Neurophysiology Preferences 

for more information (page 408). 

3. Detect spikes where the signal rises above a fixed threshold determined by adding a multiple of the standard 

deviation to the mean. 

4. Position the episode around the threshold crossings according to the width and offset entered previously. 

A 
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Preference Description Default 
Setting 

Default Episode 
Width 

The first time that any of the spike detection is run on a graph, the time 
width of each fixed width episode must be specified. This preference 

provides the default value that is seeded in the dialog. 

The episode width for an individual graph does not need to match this 

default. 

10 ms 

Default Episode 
Offset 

Each fixed width episode is located around one of the spikes in the signal. 
The offset allows for the episode to begin before (or after) the spike 

threshold crossing so the leading edge of the spike can be captured. 

Negative numbers indicate episodes are to start before the spike threshold 

crossing, positive numbers indicate episodes that start after. 

-2 ms 

Default Number of 
Spike Classes 

The Classify Spikes script requires the user to input the number of classes 
into which the spikes will be partitioned. This preference allows the default 

number to be modified. 

The number of classes that wind up being used does not need to match this 

default. 2 

 

Noldus Format 

Supports import and export of files in Noldus Observer format. Noldus is a popular Human Behavioral analysis 

software package and the AcqKnowledge Noldus feature allows behavioral markers to be imported from Noldus into 
AcqKnowledge and AcqKnowledge marker information to be exported into Noldus. The following options are 

available: 

Export Events to Noldus XT 

 

AcqKnowledge events can be exported to Noldus by 
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Remove Mean 

Remove Mean allows for mean subtraction to be performed for the selected area (or entire wave if no data is 

selected). It will result in the mean value being the new zero value for the waveform. 

 

Remove Trend 

    

Remove Trend helps to remove baseline drift or other linear trends from data. This tool makes it easier to apply 
trend removal to only specific segments of a waveform. Given a selected segment of data, or an entire waveform, 

it computes the trend between the two endpoints (similar to the Slope measurement) and then removes this trend 
from the selected area such that the endpoints of the selection lie at the same voltage. 

Linear Regression 

Use linear regression to estimate the trend to be removed from the waveform. 

Slope between endpoints 

§ Left keeps the starting point of the selection fixed at the same voltage. The software adjusts the data from 
left to right such that the right endpoint is aligned with the initial starting voltage. 

§ Right keeps the ending point of the selection fixed at the same voltage. The software adjusts the data 
from right to left such that the left endpoint is aligned with the initial ending voltage. 

Respiration 

 
IMPORTANT—Respiration analysis assumes a bidirectional airflow signal that records both inhale and 
exhale. Unidirectional respiration signals cannot be analyzed at this time. 

The respiration analysis package helps to analyze respiration- and airflow-related data. Other tools exist for 

respiration related analysis including AcqKnowledge transformations and the Respiratory Sinus Arrhythmia 

analysis in the Hemodynamics analysis package. 

Compliance and Resistance 

Compliance and Resistance analysis can be used to extract pulmonary resistance and pulmonary compliance in 

addition to basic airflow measures. This analysis requires an airflow signal and a pressure signal. The analysis 

will extract all of the measures of the Pulmonary Airflow analysis for the airflow signal. It also will locate apnea 
periods after exhalation using the same user-configurable threshold method as the Pulmonary Airflow analysis. 

IMPORTANT— The flow signal must be recorded correctly for Compliance and Resistance analysis to 
work. Compliance and Resistance analysis assumes positive flow indicates inhalation and negative flow indicates 
exhalation (the flow conventions of the recommended connections for a BIOPAC TSD107 pneumotach or a 
TSD117 airflow transducer). 

• If the flow signal was recorded with exhalation positive instead of inhalation positive,  
multiply the flow signal by -1 to invert the signal. 
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Name Abbrev. Description Units 

Inspiration time IT Time interval between the start of inhale and the start of exhale. seconds 

Exhalation time ET Time interval between the start of exhale and either: 

Ï start of apnea (if apnea present) 

Ï start of subsequent breath (if no apnea present) 

seconds 

Total breath time TT Time interval between the start of inhale and the start of inhale 
of the following breath. This is the sum of the inhalation time, 

exhalation time, and apnea time. 

seconds 

Apnea time AT Time after end of exhalation where the airflow signal remained 
within the apnea threshold defined at the start of the analysis. 

seconds 

Pulmonary 

resistance 

RES Change in pressure divided by change in flow at the isometric 

volume locations: 

 

mmHg/ 

(liters/ 
sec) 

Pulmonary 

compliance 

Cdyn Tidal volume divided by the change in pressure between exhale 

and inhale locations in the breath: 

 

liters/ 

mmHg 

 

If text output is being generated, an additional row will be added containing the average values of the measures. 
Time and count are not output as waveforms in the graph since they can be found in the horizontal axis. 

 

Penh Analysis 

Penh Analysis script assumes standard recording methodology for a full body plethysmograph. Positive flow is 

treated as exhalation and negative flow is treated as inhalation. 

 

Penh Analysis extracts measures from data recorded in a full body plethysmograph. It operates on a single 

channel of data recorded from an airflow transducer connected to the plethysmograph. The analysis takes a single 

parameter: the Rt percentage. This percentage is used to locate the plateau, or 
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Name Abbrev. Description Units 

Enhanced pause Penh Pause scaled to be relative to the strength of the 

inhale and exhale.  This helps take breathing 
variability into account.  Computed using the 

following formula: 

 

 

 

The Penh analysis excludes the following exhale cycles from the analysis: 

• Exhale cycles that do not have a preceding inhale (may occur for partial cycles at the start of the data 

recording). 

• Exhale cycles that do not have a corresponding recovery time (often occurs during apnea). 

• Cycles that fall outside the boundaries of the selected flow threshold and artifact rejection parameters.  

In addition, during periods of apnea, the analysis may produce invalid results, such as zero width recovery times. 

These results may be excluded from the analysis by either using waveform editing to remove apnea periods, 
discarding all events during apnea periods and rerunning the analysis, or deleting the corresponding rows from the 

Excel output. 

Pulmonary Airflow  

 

The Pulmonary Airflow analysis follows the flow conventions of the recommended BIOPAC connections for a 
TSD107 pneumotach or a TSD117 airflow transducer. Positive flow is assumed to indicate inhalation; negative 

flow is assumed to indicate exhalation. 

The Pulmonary Airflow analysis extracts basic parameters from a calibrated airflow signal, such as would be 

recorded using a pneumotach or airflow transducer. In addition to inspiration and expiration, Pulmonary Airflow 

also can be used to examine apnea. Apnea is defined in this analysis as pauses in breathing that occur after an 
exhalation. 

When performing the analysis, an airflow signal ƒ is chosen. An apnea threshold  fa is also entered. Inhalation is 

defined to begin at the point where . Exhalation is defined to begin at the point where . Apnea is 

defined to be the period between exhalation and inhalation where the flow lies within the apnea threshold: 

. At least two consecutive samples must occur within the apnea threshold for a period of apnea to be 

defined. This allows for valid transitions from exhalation to inhalation to occur even if one of the samples in the 
transition happens to fall within the apnea threshold due to sampling. 

The Pulmonary Airflow analysis will generate a tidal volume waveform if it is not present in the graph. It also 

will add Inspire Start and Expire Start events on the airflow signal if they are not present. New Apnea Start events 

will be defined each time the analysis is performed. 

Individual breaths are defined as the period between consecutive Inhale Start events. Airflow units are assumed to 

be the standard liters/sec.  

For each breath period, the analysis will extract the following: 
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Spectral Subtraction 

Spectral subtraction is a denoising technique that operates on data projected into the frequency domain. It is 

frequently used in speech analysis denoising applications. Spectral subtraction examines a reference noise signal and 

performs a Fourier transform to get the noise frequency distribution. To denoise a signal, the Fourier transform of the 

signal is performed. The noise estimate frequency distribution is then subtracted from the source signal. The resulting 
processed spectrum with the noise frequencies removed is then reconstructed into a time domain signal using the 

inverse Fourier transform. 

Spectral subtraction performs noise removal on the entire channel in a single Fourier transformation, which allows for 

denoising where the noise is stationary; there is no provision for sliding window spectral subtraction at this time. 

The spectral subtraction is performed using a formula with two adjustable parameters. Given a frequency spectrum 

Fnoise and a mixed signal Fmix, the denoised frequency spectrum is computed using the following formula: 

 

where 

Alpha is the 
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Digital line decoding can be two byte (using all 16 digital lines) or 
single byte (on either the low eight or high eight digital lines). Big 

endian bit and byte ordering are used, with digital line 0 
representing the least significant bit. 

When the stimulus labels are constructed, all numbers are zero-
prefixed. All stimulus events will have the same number of base-10 

digits with leading zeros, regardless of magnitude. This provides 

each stimulus event type with a unique label that can be used with the Cycle Detector (which uses substring 
matching). 

Some systems that trigger digital lines such as parallel ports may not be able to do so instantaneously; they may 
require a time window before the transition from one state to another is fully complete. A 
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Wavelet Denoising 

 

Sample output  

Wavelet Denoising applied to heart 
sounds data may help clarify S1 and 
S2, as shown: 

 

Wavelet Denoising uses the forward and reverse wavelet analysis operations to project source data into the 

wavelet domain, modify the wavelet coefficients (called 
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OSEA QRS Detector 

Ü OSEA QRS detector and beat classification library 

Since the release of software version 3.9,  AcqKnowledge incorporates the open source OSEA QRS detector 

and beat classification library. 

The OSEA library is a set of routines provided by EP Limited (Hhttp://www.eplimited.comH). This C++ based 
software library provides robust QRS complex detection and rudimentary beat classification. This library is 

well documented and tested. The QRS detector uses a standard Tompkins-based filtering and derivative 

detection algorithm and has been in development since about 1985; the beat classifier development began in 

1997. This algorithm development is sponsored by the NIH. 

This algorithm is fairly robust against arrhythmias, baseline drifts, discontinuities, and other artifacts in the 
ECG signal. It achieves a 90% success rate on identifying QRS complexes on sample arrhythmia databases. 

The algorithm is tuned to human ECGs. 

The QRS detector is optimized for 200 Hz sampled data. If the sampling rate is lower or higher, data will be 

internally resampled to 200 Hz before processing. The sampling rate difference may result in slightly different 

placement of beat events for different sampling rates. 

QRS detection can be performed by selecting the desired channel of ECG data and choosing Transform > 

Specialized Analysis > Detect and classify beats. AcqKnowledge will execute the OSEA beat detector on the 
source data and output a sequence of events on that channel of ECG data. You will only be able to see this 

output if you have events shown. 

Source code for the QRS detector is released under an HLGPL license and can be found on the AcqKnowledge 

CD. 

 
Open Source Licensing 

The ecgpuwave and OSEA algorithms are available as open source, which means that their source code is 
publicly available. The source code can only be used, however, under conditions of their licenses. 

§ ecgpuwave is under the GPL license 

§ OSEA is under the LGPL license 

For the full text of both licenses, visit the Free Software Foundation (Hhttp://www.fsf.orgH). 
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Tile Waveforms 

Tiling is an operation performed on all waveforms to visually separate them on the screen. Tile Waveforms adjusts 

the vertical offset to center waveforms in the display; if there are multiple waveforms displayed in chart mode, the 

waveforms will be centered in their 
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Autoscale Single Waveform 

Use this option to perform the above autoscaling operations on a single selected channel rather than on the entire 
graph. 

Overlap Waveforms 

Overlapping waveforms places all of the waveforms at the same scale and midpoint so that the plotting location of a 

specific voltage on screen is at the same spot for every channel. Overlapping is useful for examining closely 
associated waveforms, such as the calculated diastolic, systolic and mean calculation channels 
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Reset Chart Display 

The Reset Chart Display option redistributes the chart displays evenly after the boundaries have been changed so that 

each channel
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Horizontal Axis 

Horizontal Axis generates the Horizontal Scaling dialog. Set the axis in 

terms of time, frequency, or arbitrary units, and set the horizontal sample 

interval (the amount of time between two sample points) and the first 
sample (sample offset).  

Time domain scaling has two options to store and display data: 

• (ss.sss) 
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Show Option Shortcut Explanation 

Line Plot Right-click 

menu 

Connects each sample point with a line to create the waveform. Waveforms that are 
displayed in line plot mode match a true analog plot (as closely as possible). This is 

the default display mode for most waveforms, except histogram plots, which are 

displayed in Step Plot mode (see X310310 X). The line options can be changed by clicking 
the right mouse button, which will generate a menu displaying several commonly  

used features. 

Line Thickness  Right-click 

menu 

 

Line thickness is enabled when Line or Step plot are 

enabled. Use to specify the plot thickness in pixels.  

 
Sine wave set to thickness of 5 pixels 

Main Toolbar  Controls visibility of Main Toolbar buttons (Grid, Show/Hide, Preferences and 

Customize Toolbar). 

Measurements  Displays the measurement popup menus and windows above the graph window (see 

pages X47 X and X89 X).  

Scaling Toolbar  Controls visibility of Scaling Toolbar shortcut buttons (Autoscale Vertical, 
Autoscale Horizontal, Show All Data, Center Data Vertically, Center Data 

Horizontally). 

Scope 

 

Activates the scope display mode (see page X35 X). 

Selection 

Palette  
 

Many tools within the AcqKnowledge environment are based around the selection. 
The selected range of data in the graph is used as the source for measurements, 

waveform editing, transformations, and other operations. The Selection Palette is a 

floating dialog that can be used to precisely enter the selection. 

• The Selection Palette can be used to adjust the selection at times when it is 

not possible to use the selection tool in the graph window, such as when 

transformation dialogs are being displayed for the graph. 

• The selection palette offers a way to change the selected area without 

having to cancel the transformation setup and lose any parameters typed in 

the dialog. 

To display the Selection Palette, choose Display > Show > Selection Palette. This 

dialog contains two edit fields that display the location of the left and right edges of 
the selection using the measurement units currently displayed in the horizontal axis. 

As the selection is changed, the new selection boundaries are shown. 

The Selection Palette also can be used to manually type in the edges of the 

selection. Double-click the edges and type in the new horizontal position of the edge 

of the selection. Press 
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After Import: 

• Browsing GPS graph data with the I-beam selection tool will relocate 

the red navigation arrow to the map location occupied by the subject at 

that exact point of the experiment. 

• The map view is zoomable, and any of three different map servers can 

be selected in the preferences. 

 

Location palette showing coordinates, zoom and recenter tools 

To log GPS data: 

1. Attach the GPSTRACK device to the subject and turn on the power. 

2. Run the experiment. (For example, subject walks, runs, or bicycles an 

assigned geographical route during an exercise study where data is being 

acquired into AcqKnowledge via a wireless logger.) 

3. At the conclusion of the experiment, turn off the GPSTRACK and remove it 

from the subject. 

To import GPS data into AcqKnowledge: 

1. With the exercise study graph open in AcqKnowledge, launch the Location 

palette (Display > Show > Location Palette). 

2. Connect the GPSTRACK to the computer
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Customize Toolbars 

 

Use the Customize toolbar feature to create custom toolbars for easy access to post-processing Analysis and 
Transform actions. Toolbars are dockable and custom toolbar placeholders can be named independently of toolbar 

actions.  

§ Actions 
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Settings
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Channel Information 

The Display > Channel Info
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448 

 

449 
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450  

 

451 

 

451 

 

Measurements Preferences 

§ Measurement rows
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§ Mark selection with events in graph
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All channel types may be exported (analog, digital, and calculation) channels. AcqKnowledge will continue to 

function normally while data transfer is in progress, displaying the new data in the graph window and performing any 
autoscrolling.  

Respond to auto-discovery
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Scroll options 

The Scroll options help navigate through large data files. Right-click below 
the horizontal scroll track to generate the contextual menu with scroll options. 

 

 

Size window... 

 

The Size Window function is useful for setting exact dimensions 
for the size of the graph window. Use this to create consistently 

sized windows for pasting into documents.The two text box fields 

are used to enter interior screen width and height, both of which are 
scaled in terms of pixels.  

Each operating system may add additional dimensions as necessary to put in window adornments depending on the 

appearance configuration preference of the user (e.g. extra space for title bar of the window, any additional space put 
around the edges of the window frame, etc.). 

When the Reset chart boundaries box is checked, the boundaries between the waveforms will be reset so that each 
channel 
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Chapter 19 Program & OS Menus 
AcqKnowledge menu 

 

Mac OS only
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Chapter 20 Media Menu 

     

Also applicable to multi-camera systems and CAM-HFR-A high-speed camera. For Media Menu setup for CAM-

HFR-A, see page 462. 

Media functionality allows users to capture and playback video and/or audio with a USB web cam or firewire DV 
device and synchronize it with physiological information from an hardware device. The key functionality is a strong 

link between the video and data cursor when graphs are being used in post-acquisition mode; changing the selection in 

the graph window will automatically jump the video to the time corresponding to the cursor position. The reverse tie 
is also in place where scrolling the video will move the data cursor to the corresponding data point in the graph. 

For synchronized playback of media player with AcqKnowledge cursor in data view, BIOPAC recommends that the 

users sample the hardware unit at least as fast as the video frame rate 30Hz. In this case, any measurement errors are 

limited to the basic frame rate error window (1/30 sec). For exact match of Video and Data samples, BIOPAC 
recommends frame rate 25 fps and acquisition rate 25 samples/second (or its derivatives). 

Set Up  Establish Sources, Output and Media parameters. Set device type for audio and or/video. 

Use refresh after connecting a new device to make it a selectable option. Browse using 
standard file open/save functionality to specify media files. If desired, set a Delay between 

file segments. 

Show Capture Viewer Use for video signal directly from a video camera; this option is disabled (grayed) in the 

record mode when both the Capture video and Capture audio options in the Media Setup 
dialog are off. 

 

Show Playback Viewer Use to play back media from the disk (stored media files); this option is disabled (grayed) if 
there is no media assigned to the file. 

 

Sync SMI Video This feature is used specifically for synchronizing video exported from SMI BeGaze eye 
tracking software. The SMI video is synced by using timestamp information extracted from 

the exported BeGaze data file. For more information about SMI Begaze Import/Export, see 

page 255.  

Video Playback and Capture preview include a right-mouse contextual menu item 
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Media > Set Up 
 

Source  

Use this dialog to select media source and select audio and video to record.  Click Refresh to update the list if a 

video or audio device is connected after the dialog was opened. When video/audio for capture is selected, an 
output file must also be selected.  Input file name and click OK; this will close the Media Setup dialog and 

automatically open the media window if the Capture option is ON.   

All video camera, audio (microphone) input parameters can be setup by user with the UI provided by camera 
manufacturer, or use the 
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The Playback viewer uses standard media player controls. 

 

 

Go to previous segment / go to beginning of 

segment 

 
Step backward a frame/sample 

 
Fast backward / reverse rewind 

  
Play/ pause 

 
Fast forward 

 
Step forward a frame/sample 

 
Go to following segment 

 
Mute sound 

 

Media Playback Example 

1. Launch AcqKnowledge. 

2. Open a saved acquisition file.  

 

 
3. Select Media > Show Playback Viewer. 

4. Here you can play with contents: 
§ Select I-beam cursor on graph and push 
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Media Capture Setup with CAM-HFR-A High Speed Camera 

The CAM-HFR-A is a high speed camera capable of capturing more precise video at rates up to 100 frames-per-
second. AcqKnowledge versions 4.3.1 and higher support use of this camera. The Media setup procedure differs from 

that of a standard USB camera, with the AcqKnowledge Stimulator providing a 
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NDT is a basic method for allowing third party applications to tap into the data stream being generated by both the 

MP unit and AcqKnowledge during data acquisitions. NDT provides  

§ networking facilities that allow for integration into a distributed application environment 

§ basic control facilities to allow external applications to query and control the AcqKnowledge application state. 

The NDT system is split into two separate types of connections: data connections and the control connection.  

A. Data connections deliver data from AcqKnowledge to external applications during acquisitions.  

B. Control connections are made from external applications to AcqKnowledge to query application state and 

adjust data connections. 

The server refers to the AcqKnowledge process and the computer on which it is running. The client refers to the 
custom application that is to receive data from AcqKnowledge and the computer on which it is running.  

All connections should be made using standard network protocols, either TCP or UDP. Single system image 

architectures should make connections using the loopback interface. It is assumed that network implementations have 
appropriate IP networks in place with routing between machines that can be identified either by IP address or by 

hostname. Firewalls must be properly configured to allow network communications between the client and server. 

Appropriate network configuration is the user
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XML-RPC 

The XML-RPC transfer type allows clients to explicitly request data from the server. Instead of data being 
automatically pushed to clients, the client must post an XML-RPC function call to the server. This allows the 

client to query the server for the most recently acquired data sample value for a particular channel. Clients 

that do not require continual data streams or interact with only slow moving data may wish to use this method 

communication method. This method returns values only; no information about sample indexes or lengths is 
returned. 

XML-RPC has significant overhead for both client and server, so this transport method cannot handle more 

than a few requests per second. If faster response time is required, the client should implement either the 
single connection or multiple connection streaming methods. 

XML-RPC is not a true data connection as it does not involve the server constructing a streaming connection 

to the client. 

Transport Protocol 

Data connections offer a choice of using either TCP or UDP as the transport protocol for delivering data to the client. 

Choice of protocol depends on application requirements. When a client is receiving data, it is assumed that all data 

connections are using the same transport protocol. 

TCP/IP 

TCP is the preferred transport protocol. As TCP guarantees reliable, ordered delivery, all data is simply transferred 

from the server to the client without any additional information. Data is streamed continuously as it becomes 
available. TCP is recommended for all clients that require a guarantee of receiving all information. It is also 

recommended for any configuration using up to two computers. The port number used for data connections is 

specified by the client using the control connection prior to the start of acquisition. Once a client passes along port 
information, the client should begin listening for connections on that port. 

When using TCP data connections, the start of acquisition is signaled to clients by the establishment of a connection 

on an appropriate port to the client. The end of an acquisition is signaled by the termination of the connection. 

UDP 

UDP is a connectionless protocol that does not guarantee either delivery or properly ordered reception of packets by 

clients. Data connection is allowed to be switched to UDP delivery mode. The primary benefit of using UDP 

datagrams is that a single data stream can be multicast to a number of computers. Multicasting is not offered 
implicitly by the AcqKnowledge data connection protocol but can be achieved implicitly by requesting a data 

connection be bound to a broadcast address. 

UDP delivery used fixed size datagrams. The default size is 512 bytes. Clients can modify this size to any fixed 

number of bytes prior to the start of acquisitions. The UDP packet size is stored in the template and is different for 
each graph. UDP clients that require a specific packet size should set that packet size prior to the start of  

each acquisition. 
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It is only the time between the physical time corresponding to a sample and its delivery to the client application that is 

variable. 

Clients that require strict real time guarantees or more predictable latencies should investigate using the hardware API 

on their local machine. 

Data Formats 

It is assumed that the data transfer feature is used in a mixed host environment, potentially with clients running in 
environments that have restricted data types. The sampled information delivered by a data connection is allowed to be 

controlled to appear in a variety of different formats for the client: 

l 64 bit floating point 
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 <member> 

  <name>index</name> 
  <value><int>2</int></value> 

 </member> 

</struct> 

Querying Acquisition Parameters 

The calls for querying acquisition parameters are intended to allow clients to request information required for them to 

fill out appropriate parameters and to verify that previous control requests have been properly applied. The following 

control calls are recognized: 

getMPUnitType 

Method name: acq.getMPUnitType 

Parameters: None 
Return value: int 

 Retrieves the type of MP unit to which the server is connected. This may be zero (indicating no unit is 

connected, e.g. 
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getTransportType 

Method name: acq.getTransportType 
Parameters: None 

Return value: string 

 Retrieves the transport type that is being used to deliver data from the server to the client. The transport type 

is a string that is one of the following: tcp, udp. Note that the XML-RPC data delivery method may be used in 
addition to this transport type if channels are enabled. 

changeTransportType 

Method name: acq.changeTransportType 
Parameters: string 

Return value: 0 if successful, else fault code 

 Change the transport type that is used to deliver data from the server to the client. The transport type is a 
string that has one of the following values: tcp, udp. XML-RPC last value data delivery may be used in addition to 

this type provided channels are enabled properly. 

getUDPPacketSize 

Method name: acq.getUDPPacketSize 
Parameters: None 

Return value: int 

 Returns the current size in bytes of UDP packets that is delivered to clients. Datagrams are always this fixed 
byte length although each individual datagram may contain varying amounts of data. 

setUDPPacketSize 

Method name: acq.setUDPPacketSize 

Parameters: int 

Return value: 0 on success, fault on error 

 Changes the size in bytes of UDP packets that are delivered to clients. Each individual datagram will always 

be this fixed length although the amount of data sent in specific packets may vary. 

getUDPBroadcastEnabled 

Method name: acq.getUDPBroadcastEnabled 
Parameters: None 

Return value: boolean 

 Determine if UDP packets are sent only to the client or are broadcast to the broadcast IP of the network. 
Broadcasting is supported only when the transport type is UDP. 

changeUDPBroadcastEnabled 

Method name: acq.changeUDPBroadcastEnabled 
Parameters: Boolean 

Return value: 0 if successful, fault code on error 

 Modify whether UDP packets are sent only to the client or are broadcast to the broadcast IP of the network. 

Broadcasting is supported only when the transport type is UDP. 

getSingleConnectionModePort 

Method name: acq.getSingleConnectionModePort 

Parameters: None 
Return value: integer 

 Returns the port number on which the server will connect to the client to deliver data. This port is used only 

when the connection mode is set to 
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 Changes the port on which the individual connection is made by the server to the client to deliver the data for 

the channel specified in the parameters. This style of connection is used only if the data connection method is set to 
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 Toggles data acquisition in the frontmost graph. If data acquisition is in progress, it is halted. If none is in 

progress, data acquisition is started in the graph. 

 Note that this function invocation may block if physical user interaction is required to start the acquisition in 

the graph, such as dismissing an overwrite warning, warnings on incompatibilities between different MP unit types, 

specifying a save location for acquisition to disk, etc. If the implementation of the XML-RPC binding used by the 

client supports timeout capabilities, it is highly recommended to enable timeouts for this function. 

setOutputChannel 

Method name: acq.setOutputChannel 

Parameters: channel index structure, float output value 
Return value: 0 on success, else fault code 

 Changes the voltage on the specified output channel of the MP device. For analog outputs, the value should 

be in the range (-10, 10) for the voltage level. For digital outputs, a value of 0 will turn the specified line off, a non-
zero value will turn it on. The latency of when the output line is changed is variable and non-guaranteed. Additionally, 

the output channel may be modified by other areas of the software including control channels, manual user 

intervention, configured stimulators, etc. 

The valid output channels are dependent on the type of MP device that is connected.  

§ MP160/150 units allow analog 0, 1 and all digital output channels 

§ MP36R units allow no analogs and digital 0-8. 
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Post-Analysis Selection Adjustment 

After the analysis completes, the waveform sampling rate of the selected waveform will be reduced by a factor of 

32. As this reduction occurs, the selected area or cursor will adjust to the nearest sample point in the processed 

VMG channel. 

Data Modification History Name 

This operation will be displayed in data modification logs (Display > Channel Info) as 
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Chapter 23 Licensed Functionality: Scripting 

Scripting functionality is available through an optional license available with AcqKnowledge 5. The Scripting 
license must be authorized to access Script functionality for executing, authoring, and debugging BIOPAC 

Basic scripts. To add a Scripting license to an existing MP System, please contact BIOPAC. 

BIOPAC Basic Scripting is a scripting language development option for AcqKnowledge that allows for viewing 

of runtime variables, creating new script files and editing existing script files, triggering of individual script functions 

for testing and single step functionalities. Only users that have licensed the BIOPAC Basic feature may run user-
generated scripts; if the feature is not available only digitally signed BIOPAC scripts may be executed. Scripting is 

available in any hardware supported in AcqKnowledge but configuration commands may not be available for non-MP 

hardware. 

 

The Scripting license  

§ enables the Script menu 

§ adds the Calculation channel Preset 
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Variables Explorer 

 

Variables Explorer Window 

The Variables Explorer window (Script > Variables Explorer) shows the contents of the scripting language 
variables. 

Single Step Execution mode (Script > Single Step execution) halts execution after each individual line of a 
macro, which allows for stepping through macros line by line for debugging and development purposes.  

Example Scripts 

Several BIOPAC example scripts and macros are available in this menu. When a script file is selected, the 
scripting language for the selected script is displayed in the Script Editor. 

Run Macro Calculation Channel 

 

Run Macro Calculation Channel Setup Dialog 

The 
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Chapter 24 Licensed Functionality: Remote Monitoring 

Remote Monitoring functionality is available through an optional license available with 
AcqKnowledge 5. The license must be authorized to access Remote Monitoring functionality. To add 

a license to an existing MP System, please contact BIOPAC. 

 

  

AcqKnowledge MP devices are generally tethered to specific computers where data acquisition is performed. 

In some laboratories, this computer may not be in the same location as the researcher performing the 
experiment. In MRI situations, for example, the data acquisition computer may be in the MRI control room 

but the researcher may be in a separate area. AcqKnowledge Remote Monitoring offers researchers the 

capability of checking on critical parameters from an alternate location. 

Remote Monitoring is a client/server application capable of locating and connecting to computers running 

AcqKnowledge on the same network. It consists of a simple browser interface, from which acquisitions can be 

started, stopped and remote data viewed during and post-acquisition. Remote Monitoring is supported in 

MP160/150 hardware only. 

About Remote Monitoring 

§ Remote Monitoring is licensed functionality and must be activated by BIOPAC. 

§ Remote Monitoring is for viewing of data only. Transformation and specialized analysis of graph data 

is not supported within the Remote Monitoring interface. 

The Remote Monitoring web interface consists of three primary pages:  

§ A list of open graph windows 

§ Configuration settings for an individual graph 

§ The data monitoring page. 

Remote Monitoring in AcqKnowledge Networking Preferences 

Remote Monitoring is enabled by default in 

AcqKnowledge Networking Preferences (Display > 

Preferences > Networking > Remote Monitoring). The 
Enable remote monitoring checkbox option activates 

the local machine on the network, making it visible to 

other local network machines also running 
AcqKnowledge Remote Monitoring.  

The Webserver TCP port is the numerical port on which AcqKnowledge listens for remote requests. (This 

port is set to 8080 by default.) The Remote monitor URL is a clickable link that opens Remote Monitoring 
in the local machine
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Icon Button Function Explanation 

 Back Moves browser back one page 

 
Forward Advances browser ahead one page 

 
Refresh Reloads the current page 

 
Stop Stops loading of current page 

 

Address bar Displays I.P. address of currently-connected computer 

 Zoom in Master control for enlarging size of browser content 

 
Zoom out Master control for decreasing size of browser content 

 

File, Edit, Help 
menus 

File contains Page Setup and Print controls for 
Remote Monitoring chart displays. Quit exits the 

Remote Monitor. 

Edit contains a Copy option. (Copy function not 

supported in Windows version) 

Help displays 
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Control Description 

Return to Graph List Returns browser to list of currently-open graphs. Serves the same function as the 
browser
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Controls in Visible Range (Change Range) dialog 

Control Description 

Return to Monitor page Clickable link for paging back to the Monitoring screen. 

Show seconds of data Determines visible horizontal time scale in chart display. 

Number of horizontal divisions Sets the number of horizontal divisions in chart. 

Horizontal axis precision Sets number of decimal places following horizontal time values. 

Vertical lower endpoint Determines low end of vertical graph scale. 

Vertical upper endpoint Determines high end of vertical graph scale. 

Number of divisions  Sets the number of vertical divisions in chart. 

NOTE: Remote Monitoring plots are only updated in the data monitoring window while an acquisition is 

in progress. Once a Remote Monitoring acquisition is stopped, the graph will remain visible only as 
long as the browser page is displayed. After navigating away from the page, the plot will not be 

retained or reconstructed. To save a Remote Monitoring plot for future reference, printing a hard 

copy or printing to a PDF file is recommended. 

*For Remote Monitoring technical support, contact BIOPAC Systems, Inc at (805) 685-0066 or 

support@biopac.com 
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AcqKnowledge software is used to view, record and analyze data acquired with the B-Alert unit. 

To launch software with B-Alert hardware: 
1. Connect the B-Alert dongle to a USB port and turn the X10 headset unit
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B-Alert-specific Hardware Menu Options   

 

B-Alert Headset Check Impedance  

This item is found in the B-Alert menu, (which 
replaces the MP menu in B-Alert hardware 
configuration) and is used to initiate an 
impedance check to verify the headset
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B-Alert ESU Configuration 

The B-Alert ESU unit is a multi-channel external 
synchronization unit that serves as a 
communication interface between the B-Alert 
unit and the computer. It allows for 
synchronization of data between the B-Alert 
hardware and other third-party data acqusitition 
devices.  

For more information about the B-Alert ESU 
unit, see the B-Alert with AcqKnowledge Quick 
Guide or the B-Alert Software Manual. 

NOTE: Before configuring the ESU settings, the ESU 
must be paired with the B-Alert unit via a Bluetooth 
connection. 

• B-Alert headsets are shipped paired to either a 
B-Alert Dongle or an ESU. If the pairing is lost, 
the devices must be re-synced using the 
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Output to ABM File Format  

Acquisition setup options are available for controlling data output to a separate B-Alert ABM file format, 

which contains an 
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Linked Acquisitions in B-Alert 

Linked acquisitions are supported in B-Alert. In a Linked Acquisition session, different hardware device types 

can acquire data simultaneously into individual graphs. B-Alert acquisitions can be synchronized with and 

triggered by an MP160/150 unit and the multiple data recordings merged into one graph at the end of the 
session.  

NOTE: In order to use 
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Chapter 26 Licensed Functionality: PV Loop Analysis 

PV (Pressure-Volume) Loop Analysis is available through an optional license available with 
AcqKnowledge 5. The license must be authorized to access this Analysis tool. To add a license to an 

existing MP System, please contact BIOPAC. 

Pressure-volume loops (a.k.a. PV Loops) measure blood pressure and flow from a catheterized system. This 

analysis tool extracts various measures of heart function, including contractility, elasticity and ventricular 

characteristics. Sophisticated algorithms in this advanced analysis feature help circumvent the laborious visual 
process of identifying loop ranges while allowing the inclusion or exclusion of individual loops in the analysis 

output. Extracted measurements can be saved to an Excel spreadsheet, and selectable XY data views clearly 

show a wide range of outputted data. A pressure-volume loop graph template containing the necessary 

analog/calculation channels, data views and custom toolbars is included with the feature. (Q46-Pressure 
Volume Loop.gtl) PV Loop Analysis is supported in MP160/150 hardware only. 

Loop Location 

The two primary time locations for an individual PV loop range from the end systole (ES) point where the 
aortic valve closes, and the end diastole (ED) point where the mitral valve closes. On a PV loop XY plot, the 

end systole point is located at the top left corner of the loop and the end diastole is at the bottom right corner 

of the loop. An individual loop is defined as the extent from one end diastole to next end diastole, the 

equivalent of one heart beat. 

PV Loop Analysis Preferences 

PV Loop Analysis Preferences are accessed via the Analysis > PV Loop menu and offer two methods for 

locating cardiac cycles.  

 
PV Loop Analysis Preferences dialog 

PV Loop Analysis Preference Controls Description 

P/V ratio When selected, ES and ED are located by analyzing 
the ratio of pressure over volume. 

ED relaxation percentage Percentage that P/V ratio must fall from ES in order 
to locate ED. 

% threshold of dP/dt max and min When selected, ES and ED are located using the 
pressure signal derivative only. 

% of max Defines percentage of the positive pressure 
derivative local maximum for ED. 

% of min Defines percentage of the negative pressure 
derivative local minimum for ES. 

Customize Baseline Results 
 

Displays a checkbox dialog for selecting measures to 
be included or excluded from baseline analysis. (See 
next page for complete list of available measures) 

 

 

Baseline Analysis 
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PV Loop Quickstart showing graph data and Pressure vs. Magnitude XY data view 

 

The above figure shows the additional toolbars present in the PV Loop Quickstart template, with toolbar 
functions explained below. 

• Recent Values toolbar (outlined in blue) 

The Recent values toolbar extracts the following measurements in real time from the cardiac calculation 
channels 42-46. (Values are displayed during acquisition.) 

Heart Rate (BPM) 

Maximum Pressure (mmHg) 

Minimum Pressure (mmHg) 

Maximum Volume (mL) 

Minimum Volume (mL) 

• Custom Button toolbar (outlined in red) 

This toolbar provides quick access to the following functions during recording and in post-processing 

Show PV Loop Displays the Pressure Volume Loop in XY view. Plot 
shows most recent 6 seconds of pressure (X) vs. 
volume (Y). Useful for viewing experimental effects or 
determining catheter positioning. 

Analyze Baseline Performs baseline analysis on selected graph data. 
(A shortcut to choosing Analysis > Pressure Volume 
Loop > Baseline Analysis.) 

Show P vs. Magnitude Displays the Pressure vs. Magnitude data in XY view. 
Plot shows most recent 6 seconds of pressure (X) vs. 
Magnitude (Y). Useful when positioning the catheter. 

Show V vs. Phase Displays the Volume vs. Phase data in XY view. Plot 
shows most recent 6 seconds of pressure (X) vs. 
phase (Y). Useful for viewing oscillating muscle 
contributions in the signal. 

Reset Display Sets the display back to the default view. 
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Use the controls  in the upper left of the loop display region to autoscale vertically, 
horizontally, and zoom data. 

Multiple loop measures 

Once a set of loops has been identified, various models are constructed showing ideal boundaries of pressure 

and volume extents for varying cardiac cycles. Additional relationships between per-loop measures are also 

extracted to help assess overall cardiac condition. Multiple loop measures include the following relationships 
and controls: 

ESPVR (End Systolic Pressure Volume 
Relationship) 

Theoretical maximum pressure for any given volume. 

Type Use to select the equation upon which to base the PV 
loop curve fit: Linear or quadratic. 

Ees Index of overall myocardial contractility. 

V0 Theoretical volume of loop at zero pressure. 

EDPVR (End Diastolic Pressure Volume 
Relationship) 

Passive filling properties of ventricle, reciprocal of 
ventricular stiffness. 

PRSW (Preloadable recruitable stroke work) 
Pressing  displays a plot showing linear 
regression between stroke work and diastolic volume 
between loops. 

dpMax vs. EDV 
Pressing  displays a plot showing maximum 
change in pressure vs. end diastolic volume. 

PVA vs. EDV  
Pressing  displays a plot showing pressure 
volume area vs. end diastolic volume. 

PVA vs. ESP 
Pressing  displays a plot showing pressure 
volume area vs. end systolic pressure. 

Other controls 
Pressing  copies the loop-specific measures to 
the clipboard. 

Pressing  saves the loop-specific measures to an 
Excel file. 

Per loop measures 

 

The bottom pane of the analysis window contains a table display of individual loop analysis results. Each loop 

occupies one row. Comparative measures are automatically updated upon any changes to included loops. 
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Measure Abbrev. Formula Units Description 

Cardiac 
output 

CO 

 

ml / minute Amount of blood 
pumped per unit time. 

Ejection 
fraction 

EF 

 

(none) Percent of the end 
diastolic volume 
ejected during each 
contraction. 

Maximum 
power 

MaxPwr  
 

Maximum cardiac 
power within the loop, 
left endpoint 
exclusive right 
endpoint inclusive.  
With appropriate 
factors may be 
converted into Watts. 

Parallel 
power 

PlPwr 

  

 

Stroke work SW 

 

 

where  

mmHg * ml Work performed by 
the ventricle to eject 
the stroke volume.  
Equivalent to the 
area of the PV loop. 

Arterial 
elastance 

Ea 

 

mmHg / ml Measure of arterial 
load for measuring 
coupling between 
heart and arterial 
system. 
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Comparative Measures 

After multiple loop measures are extracted, the following additional measures may be extracted for each loop 
to examine its relationship to the volume-relationship analyses of a set of loops and expected theoretical 

baselines. These measures are based upon various multiple loop measures and should be recomputed any time 

they are changed due to modifications to the set of loops included in the analysis: (See following page.) 

Measure Abbrev. Description Units 

Pressure volume 
area 

PVA Provides a measure of the total mechanical energy 
produced by a ventricular contraction.  From the set of 
loops the ESPVR model provides the theoretical baseline 

volume at zero pressure .  The PVA for a loop is then 
determined from the following formula: 

 

where SW is the stroke work for the loop. 

mmHg * ml 

Potential energy PE Provides a measure of the elastic potential energy built 
during the systole and stored in the ventricular wall at the 
onset of relaxation.  From the set of loops the ESPVR 
model provides the theoretical baseline volume at zero 
pressure V0.  The PE for a loop is then determined from 
the following formula: 

 

That is the total mechanical energy minus the actual work 
used to eject the stroke volume. 

mmHg * ml 

Efficiency Eff Provides the fraction of the total mechanical energy used to 
eject the stroke volume: 

 

(unitless) 

Maximum time 
varying elastance 

Emax The normalized time varying elastance for an individual 
loop is adjusted from the theoretical baseline volume at 
zero pressure V0 and is given by the Suga and Sagawa 
formula: 

 

For a given loop, the maximum value of E(t) will occur 
when pressure is highest and volume is lowest, or at the 
time of ES: 

 

This is also the slope of the line connecting V0 with ESP 

within the XY loop plot1. 

mmHg / ml 

 

 See the AcqKnowledge PV Loop Analysis video tutorial for a detailed demonstration of this feature. 
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Baroreflex Slope Analysis   

The Baroreflex Slope analysis method uses linear regression to determine a measure of Baroreflex sensitivity 
(BRS). The analysis output area displays the current BRS estimate and the slope of the best linear regression 

fit to all of the cardiac cycles included in the analysis. 

First, a source time interval is defined in the cardiac recording, generally located around regions of induced 

change in blood pressure. The pairs of heart rate and systolic pressure within this time interval are extracted.  
A linear regression of these coordinates is computed, with pressure as the x coordinate and heart rate interval 

as the y interval. BRS is defined as the slope of the best fit linear regression, in units of ms/mmHg. 

The slope method is useful when correlating with studies using this method, performing validations, or when 

areas to be measured are very well known. This method can only be used on an area of selected data. If 

attempted on unselected data, a dialog will appear prompting for data selection with the I-beam tool or a 
defined focus area. 

Baroreflex Slope Analysis description references can be found on page 516. 

Slope Analysis Setup Dialog 

Choosing the Baroreflex Slope Analysis option produces the following dialogs: 

 

In the initial dialog, the ECG and blood pressure channels are selected (above). 

  

The subsequent dialogs prompt for the highlighting and selection of a systole in the BP data (above). 

 

Following systole selection, the arterial blood pressure events are scored. This can take some time, depending 

on the width of the selected area (above). 

An interactive plot (see next page) will appear, and displays the best present linear curve fit and the cardiac 

cycles as points on an XY plot of systolic blood pressure versus heart rate.  

Include or exclude points from analysis by checking or unchecking the numbered cardiac cycle boxes, or by 
clicking on individual ponts while holding down the ALT key. When individual points are excluded or 

included, the best linear fit will be automatically recalculated. The cardiac cycle table at the bottom of the 

analysis window provides a tabular spreadsheet view, and includes:  

• Active (checked) or hidden (unchecked) 
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Baroreflex Sequence Method Description 

The Baroreflex Sequence method is described in the following papers: 

Kuusela, Tom; 
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Importing Raw Accelerometer Data 

AcqKnowledge records raw accelerometer data which must be imported and processed into activity counts for 
use in actigraphy analysis.   

To import data from an external accelerometer sleep study file, click the  toolbar button in the Actigraphy 

Analysis window, navigate to the raw data file
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Actigraphy Analysis Settings 

As stated in the previous section, choosing 
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Sleep Derived Measures (Sleep Analysis) 

After the primary sleep period has been located, it will be further subdivided into 
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• Create New Analysis 
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Chapter 30 Stellar Telemetry  

Stellar Telemetry Control interface for existing Stellar Small Animal Telelemtry System & Implants 
is available through optional licensing available with AcqKnowledge 5. The license(s) must be 

authorized to access functionality for the specified number of implants. Please contact BIOPAC to 

discuss licensing options. 

 

 

Stellar Telemetry System 

The Stellar Telemetry System wirelessly acquires and logs physiological data from single or multiple animal 
subjects. The system consists of a small implantable recording device with an antenna and USB base station 

for communicating with the implanted units. AcqKnowledge software is used to configure Stellar experiments 

and analyze blood pressure, ECG, temperature, and accelerometer data imported from the logging sessions. 

Specific data recording parameters, such as the desired signal type, recording schedule, duration/repetition 
interval, and selection of animal subjects are set up beforehand in AcqKnowledge, whereas the import, display 

and analysis of resulting data are performed following the logging session. Stellar Telemetry is a licensed 

feature of AcqKnowledge, and activated with a BIOPAC-provided iLok USB License Key. The number of 
animal units (allowable animal subjects controlled per experiment) is determined by the specific quantity of 

animal units purchased in the software license. 

This chapter describes how AcqKnowledge software is used with the Stellar Telemetry System. For 

information on the Stellar System hardware (setup of implantable devices, antenna and base station), see the 

Stellar Telemetry User Guide. For Access Point hardware driver installation and troubleshooting, see the 
Access Point Configuration Guide. 

Before you begin: It is important to note that the Stellar Telemetry System may lose communication with the 
Access Point if the computer is allowed to go to sleep, resulting in a loss of data. To prevent this from 

occurring, disable the computer
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Graphical Day View supports the following contextual menu items. To 
display the contextual menu, right-click a session bar in the Day View. 

• Delete: Removes the selected session 

• Clone: Shortcut to the 
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• Animal unit may be in use for a recording by another access 
point. 

• Animal unit may be frozen and require a magnetic reset. 

• Animal Unit battery may be dead (in which case the unit must 
be  replaced). 

Automatically download data on 
acquisition completion 

After the final session is completed, data is automatically downloaded 
from active animal units into the output directory. (Currently, this option 
cannot be disabled.) 

Set Output Directory button Chooses directory where AcqKnowledge graphs containing 
downloaded data will be stored. If undefined, the default path is the 
user's Documents directory. 

Stellar-specific Setup Window Menus 

File Menu 

> New Experiment Creates a new experiment window. 

> Open Experiment... Displays a 
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Tools  Menu 

> Stellar Preferences 

 

Set the following important parameters in the Stellar 
Preferences dialog: 

Path to Stellar Setting Folder 
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Real time data preview setup options 

Animal 
Units 

Displays the animal units available for preview. Only one animal unit at a time may be selected. 

Channels Displays the channels available for preview. Multiple channels may be selected. 

Duration Sets the length of preview in seconds. 

Unlimited  Choosing this option allows the preview to run until manually stopped.  

Rate Use this option to select the sample rate for the data display. Sample rates of 100, 200, 500 and 
1000 s/s are supported. 

Save data Use this option to choose a path to save the preview data to a *.txt file format. This option is 
available when the duration is set to seconds. It is not supported for unlimited data previews. 

Time 
range 

Use this option to set a horizontal scale range for the data preview display. (Horizontal 
autoscaling is not supported in the preview graph.) 

Start Toggles between Start/Stop of data preview. When clicking Start/Stop it may take a few 
seconds for the application to respond before starting or stopping the preview. When this 
occurs, a 
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Running a Stellar Experiment 

The example below is a guide to scheduling and conducting a Stellar experiment. These steps assume that the 
Stellar hardware is set up correctly, and successful hardware connection between the Access Point and the 

Animal Unit has been established. For hardware setup instructions, see the 
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Import and Display of Stellar Data in AcqKnowledge 
Following completion of a scheduled experiment, the logged Stellar data is downloaded to an AcqKnowledge 

graph for review and analysis. Stellar-optimized analysis tools enable selective viewing and spreadsheet 

output of recorded data for all selected animal units.  

• Physiological signals extracted from the Stellar experiment are imported into an 

AcqKnowledge graph and displayed as separate channels. 

• Repeated recordings (for example, 15 seconds every 15 minutes for the duration of the 

session), are displayed as appended segments.  

 

Saving Graphs and Settings from Stellar Experiments  
It is important to note that Stellar experiment data files and Stellar experiment settings are stored separately. 

Graphs containing data imported from Stellar experiments are in standard AcqKnowledge *.acq or *.gtl 

format, and like all AcqKnowledge graphs, are opened and saved via the main application window 
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The above option selects the animal units to be 
included in the graph. Unchecking an animal unit 
hides the graph channel containing the deselected 
unit. 

 

Show or hide the various signal type channels 
acquired during the session for a better view of a 

particular signal.  

Preferences > Stellar Analysis: Select measurements to 
extract 

Use this option to select or deselect the 
measurements to be included in the analysis. 
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Chapter 31 Mobita 

 

Mobita is a portable wireless system for acquiring ECG, EMG, EEG, EOG, EGG and accelerometer data via a 

dedicated WiFi network. This hardware system is controlled by a specially-licensed version of 
AcqKnowledge (versions 4.4 and greater only). 

The Mobita package consists of: 

• AcqKnowledge software 

• Battery-powered data acqusition unit  

• USB WiFi dongle 

• Detachable docking station (for charging unit, and connecting to computer via USB interface to 

download logged data and change the recording configuration) 

• Detachable 
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Mobita Analog Channels Setup 

Up to 32 analog channels are available, with the following available presets and default filtering: 

 

In Mobita, (as in other AcqKnowledge hardware types) channel labels, sample rates and setups are 

customizable, and user-defined channel presets can be created and saved. 

 

Note Mobita accelerometer channels are fixed at absolute levels and have no configurable preset options. 

Analog Channel Digital Filters 

The Analog tab
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Mobita Acquisition (Length/Rate) Settings 

 

The following acquisition modes are supported in Mobita hardware: 

Append and Autosave  

Append and Autosave modes are available for WiFi communication only, with no data stored to the Mobita 

hardware. Memory or disk storage options are supported both acquisition modes. 

Save once (WiFi + Logging) 
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3. If the USB adapter connection needs to be re-established, you may see the following  

communication prompt: 

 

 

4. If this prompt appears, highlight the ASUS USB adapter in the 
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Chapter 32 FaceReader 

FaceReader
TM

 with AcqKnowledge is available through optional licensing in AcqKnowledge 5. 
Contact BIOPAC for licensing details. 

FaceReader
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6. Click OK to exit the Application Settings screen. 

Creating a FaceReader Project and Recording in AcqKnowledge 

1. After performing the above configuration steps 1-5, launch the FaceReader software and 
choose 
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If 
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Appendix B - Filter characteristics 
Filter types 

AcqKnowledge employs two types of digital filters:  

(a) Finite Impulse Response (FIR) perform filtering calculations online (during an acquisition) or post-

processing (after an acquisition). 

(b) Infinite Impulse Response (IIR) perform filtering calculations online (during an acquisition) or post-

processing (after an acquisition).  

Although the similarities between the two types of filters outweigh the differences, some important 

distinctions remain. 

1. IIR filters tend to be less accurate than FIR filters. Specifically, IIR filters tend to cause phase 

distortion or 
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Bartlett implements triangular windowing and Rectangle does not window the data. The 
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Appendix D - Customizing Menu Functionality 
AcqKnowledge now includes a powerful customization feature lets you choose the program features to 
display as menu options. If you have a specific procedure, you can limit the menu options to list only those 

functions you need, thereby reducing the chance for confusion or error in your lab. For instance, you might 

choose to remove the 
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Unlocked An MP160/150 automatically 
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Save As option, 264 

Connect endpoints, 291 

Constant (K), Calculate measurement option, 94 

Control channel 

Calculation channel, 146 

Integrate Calculation option, 125 
Convolution, 295 

Copy, 271 

Acquisition Settings, 275 

Graph, 275 

Measurement, 274 

Wave data, 275 

Correlate (measurement), 95 

Correlation, 293, 295 

Correlation Coefficient 

Specialized Analysis, 352 

Correlation dimension measurement, 95 

Cosine, 143 
Count peaks, 344 

Create Data Snapshot, 51 

Cubic spline interpolation, 305 

Customizing menu display, 450, 562 

Cutoff frequency, 283 

Cycles/Peaks detect, 3D Output, 329 

Cycles/Peaks tab, Cycles/Peaks detect, 323 

D 

Data View, 41 

Delay 

Calculation channel option, 145 

Trigger Set Up, 172 

Delta measurements, 95 
Derivative, 299 

detrending, 314, 390 

Difference 

online calculation, 130 

transformation function, 304 

Digital 

Digital channels, 32, 112
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File size, 557, 561 

Filter 

Calculation, 136 

characteristics, 558 

response, 284 

Find, 339 
Find Cycle/Peak, Mac OS X, 322 

Finite impulse response filters. See FIR filter 

FIR filters, 280, 283, 558 

Focus areas, 87 

Font, journal, 449 

Formula 

Area, 93 

BPM, 94 

Correlation, 95 

Delta, 95 

Delta T/F/X, 96 

Freq (Frequency), 97 
Integral, 98 

Lin_reg (Linear regression), 99 

Mean, 99 

Slope, 101 

Stddev (Standard deviation), 102 

Threshold, 135 

Fourier 

FFT Fast Fourier transformation, 315 

Fourier Linear Combiners 

Calculation Channels, 150 

Transformations, 289 
Frequency 

frequency spectrum, 319 

Horizontal scale, 432 

measurement (Freq), 97 

rate calculation (Hz), 344 

Frequency Bands, HRV analysis, 388 

Frequently asked questions, 556 

Friendly Grid Scaling, 79 

Function 

Calculation, 138 

Equation (Expression) commands, 143 

G 

Gain setting, 113 
Gastric Wave Analysis, 350 

Gastric Wave Coupling, 350 

Gauge, 237 

Getting Started, 21 

GLP audit 

include timestamp, 447 

mark selection with Events, 447, 448 

GLP guidelines, customizing menus for, 24 
Graph template files (gtl) 

Open, 249 

Quick Start Files, 122, 249 

Save As, 259 

Graph window, 31 

Gray non-selected waves, 447 
Grid 

Adjust spacing, 430 

GridReset, 430 

H 

Hardware. See note on page 10 

Heart Rate Variability, 27, 386 

Help menu, 454 

Hemodynamic Analysis, 374 

ABP Classifier, 375 

Arterial Blood Pressure, 375 
ECG Interval Extraction, 376 

LVP Classifier, 379 

MAP Classifier, 381 

Measurements App Note, 27 

Monophasic Action Potential, 380 

High pass filter, 281 

Histogram, 310 

Hold button, SIV, 229 

Hold relative position 

Horizontal Scale, 71 

Horizontal 
Axis, 25 
scale, 42 

Scale, 42 
Scroll bar, 71 

Human Subjects, Safety, 210 

Hyperbolic 

Cosine, 143 

Sine, 144 

Tangent, 144 

I 

I/O channels, Manual Control, 230 

I-beam tool 

selection cursor, 56 

IBI Inter-beat Interval, 131, 344 

IFFT. See inverse FFT 

Igor Pro Experiment 
Open (import), 252 

Save As (export), 262 

IIR filters, 280, 285, 558 

Impedance Cardiography Analysis, 392 

Body Surface Area, 392 

Derive dZ/dt from raw Z, 392 

dZ/dt Classifier, 392 

dZ/dt remove motion artifacts, 399 

ICG Analysis, 395 

Ideal Body Weight, 398 

Pre-ejection Period, 398 
Preferences, 400 

VEPT, 399 

Independent Component Analysis, 321 

INF (measurement value), 89 

Infinite impulse response filters. See IIR filters 

Information Dimension measurement, 98 

Initial offset, 71 

Input Values Setup (SIV), 229 

Insert 

Events, 48 
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Waveform, 272 

Installation. See note on page 10 

Integral 

measurement, 98 

Transformation function, 298 

Integrate 
formulas, 301 

Integrate Calculation (online), 124 

inter sample interval, 252, 261 

Interpolate pastings, 448 

Interpolation method, resampling, 305 

Intraventricular Pressure Wave analysis, 27 

Inverse mean square error, 295 

J 

Jewett Sequence, ABR testing for, 27 

Journal, 50 

Copy Measurements, 92 

Paste options, 276 

Preferences, 449 

Show Journal, Mac OS X, 278 
Jump-to tool (correlates data views), 57 

K 

K (Constant), Calculate measurement option, 94 

Kurtosis measurement, 98 

L 

Latency, 160 

Left Ventricular Pressure 

LVP Classifier, 379 

Limit data, Calculation channel Function, 135 

Limit math command, 292 

Lin_reg (linear regression measurement), 99 

line plot, 434 

Linear (FFT option), 318 

Linear interpolation, 305 

Ln natural logarithm, 292 
Locate SCRs, 359 

Location Palette, 435 

Locked MP160/150, 563 

Log, 144, 292 

Low pass filter, 281, 299 

Lung Volume analysis, 27 

LVP Analysis, 27 

Lyapunov measurement, 99 

M 

Macintosh® system requirements, 22 

Magnetic resonance imaging 

Specialized Analysis, 401 

Manual Control (digital I/O), 230 
Manual stimulator controls, 176 

Math 

Calculation, 133
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Math command, 292 

Rejection (auto threshold detect, 342 

None (measurement option), 100 

Nonlinear modeling, 312 

NLM measurement, 100 

Normalized cross correlation, 296 

O 

Off-line Averaging, Cycle/Peak Detector (MAC), 
328 

Online filtering, 136 

Open (file command), 248 

Open for Playback, 254 

Options button, Open Text file, 249 

Options, Input Values, 229 

Organize Channel Presets, 242 

Organize List, Preferences, 202 

Output continuously. Stim. Setup, 175, 198 

Output Control, 184 

CH# to Output, 186 

Preferences, 185 
Pulses, 189 

Stimulator 
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RS-232/RS-422 signal, 556 

S 

Safety Notice, 19 

Sample 

measurement, 101 

Rate, 157
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U 

Undo, 270 

User Support System, 17 

V 

Value (measurement), 102 

Values checkbox, 32, 109 

Show input values, 229 

Variable Sampling Rate, 33, 110, 173 

data processing notes, 141 

Event plotting and, 228 
VEPT, 399 

Vertical axis, 25, 112 
Vertical scale, 44, 72 

Viewing data, 42 

VO2 measurement, 27 

W 

Warning 

Before overwrite data, 242 

Hardware not found, 29 

Waterfall Plot, 421 

WAV files, 253 

Waveform 

Arithmetic dialog, 94 

Color, 431 

Math transformation, 307
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COPYRIGHT  

Information in this document is subject to change without notice and does not represent a commitment on the part of 
BIOPAC Systems, Inc. This manual and the software described in it are copyrighted with all rights reserved. Under 
the copyright laws, this manual or the software may not be copied, in whole or part, without written consent of 
BIOPAC Systems, Inc., except in the normal use of the software or to make a backup copy. 

The same proprietary and copyright notices must be affixed to any permitted copies as were affixed to the original. 
This exception does not allow copies to be made for others, whether or not sold, but all of the material purchased 
(with all backup copies) may be sold, given, or loaned to another person. Under the law, copying includes translating 
into another language or format. This software is intended for use on only one machine at a time. 

 

Open source software for Specialized Analysis: 

§ PCRE 

Regular expression support is provided by the PCRE library package, which is open source software, written by 
Philip Hazel, and copyright by the University of Cambridge, England. 
ftp://ftp.csx.cam.ac.uk/pub/software/programming/pcre/ 

§ The Apache Software License, Version 1.1 

Copyright (c) 1999-2001 The Apache Software Foundation. All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the 
following conditions are met: 

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution. 

3. The end-user documentation included with the redistribution, if any, must include the following 
acknowledgment: "This product includes software developed by the Apache Software Foundation 
(http://www.apache.org/)." Alternately, this acknowledgment may appear in the software itself, if and 
wherever such third-party acknowledgments normally appear. 

4. The names "Xerces" and "Apache Software Foundation" must not be used to endorse or promote 
products derived from this software without prior written permission. For written permission, please 
contact apache@apache.org. 

5. Products derived from this software may not be called "Apache", nor may "Apache" appear in their 
name, without prior written permission of the Apache Software Foundation. 

THIS SOFTWARE IS PROVIDED ''AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE 
FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, 
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT 
OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

=================================================== 

This software consists of voluntary contributions made by many individuals on behalf of the Apache Software 
Foundation and was originally based on software copyright (c) 1999, International Business Machines, Inc., 
http://www.ibm.com. For more information on the Apache Software Foundation, please see 
<http://www.apache.org/>. 
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WARRANTY  

BIOPAC Systems, Inc. warrants its hardware products against defects in materials and workmanship for a period of 
12 months from the date of purchase. If BIOPAC Systems, Inc. receives notice of such defects during the warranty 
period, BIOPAC Systems, Inc. will at its option, either repair or replace the hardware products that prove to be 
defective. This warranty applies only if your BIOPAC Systems, Inc. product fails to function properly under normal use 
and within the manufacturer


